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ABSTRACT 

Twin steel tub girder bridges are an aesthetically pleasing structural option, offering long 

span solutions in tight radii direct connectors. However, these bridges require a routine 

two-year inspection frequency, as well as a thorough hands-on inspection, because of their 

fracture critical designation. The heightened inspection requirements for fracture-critical 

bridges come at a significant cost to the Department of Transportations (DOTs). Recent 

research has shown that tangent, or nearly tangent, twin steel tub girder sections can 

redistribute load to the intact girder after fracture of one of the girder bottom flanges. 

Additional research is required to develop recommendations for practical analysis of 

typical twin steel tub span configurations with the degree of curvature common to twin 

steel tub direct connectors. 

A key objective of this research is to develop more rigorous modeling and analysis 

methods. These analysis and modeling methods shall take into account the capacity of the 

fractured girder, especially at support locations, and realistically model the load 

distribution between the intact girder and the fractured girder. However, the modeling and 

analysis methods need to be sufficiently straightforward to be applied on a large scale to 

the inventory of steel tub bridges. The analysis method developed should meet the 

 Reprinted with permission from “Fracture Critical Steel Twin Tub Girder Bridges Technical Report” 0-

6937-R1 by Hurlebaus S., Mander J., Terzioglu T., Boger N., Fatima A., 2018. Texas A&M Texas 

Transportation Institute, Copyright 2018 by Texas A&M Texas Transportation Institute  
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requirements outlined in the Federal Highway Administration (FHWA) Memorandum 

(FHWA 2012). 
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1. INTRODUCTION

1.1. Background and Motivation 

Twin tub girder bridges have the potential to serve as an engineering solution to the 

problem of long-span, curved bridges with tight radii of curvature. These bridges are 

becoming an alternative in lieu of the curved I-girder bridges. However, the major 

deterrent in the widespread reliance of these bridges is the classification of these bridges 

as fracture critical by the Federal Highway Administration (FHWA). The fracture critical 

designation leads to long term costs associated with hands-on inspections and fabrication 

of the fracture critical members (FCMs) according to the American Welding Society 

(AWS) Fracture Control Plan (FCP). There have been disastrous consequences in cases of 

failure of fracture critical bridges that have elicited the need for rigorous hands-on 

inspections to avoid such terrible losses of life and property in the future. The American 

Association of State Highway and Transportation Officials (AASHTO) Load and 

Resistance Factor Design (LRFD) Bridge Design Specifications (AASHTO 2017) defines 

a FCM as a “component in tension whose failure is expected to result in the collapse of 

the bridge or the inability of the bridge to perform its function.” Therefore, hands-on 

inspections are required to ensure the structure is safeguarded against fracture and fatigue 

failures. The hands-on inspection of these bridges are costing the Department of 

Transportations (DOTs) large sums of funds that could be allocated to address other 

 Part of this chapter is reprinted with permission from “Fracture Critical Steel Twin Tub Girder Bridges 

Technical Report” 0-6937-R1 by Hurlebaus S., Mander J., Terzioglu T., Boger N., Fatima A., 2018. Texas 

A&M Texas Transportation Institute, 1-4, Copyright 2018 by Texas A&M Texas Transportation Institute 
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problems since not all the twin tub girder bridges are truly fracture critical. The current 

definition of FCMs, based on only load path redundancy, is highly conservative, which 

deems all bridges as requiring elaborate and expensive inspections that deplete money and 

time. Instead of an elastic analysis that may be grossly underestimating the reserve 

capacity of the redundant structural members, a more realistic and exact elasto-plastic 

analysis is recommended for this research. It is imperative to initiate an investigation to 

assess the relevance of the current classification of the twin tub girder bridges as fracture 

critical. A thorough analysis is needed to carry out the investigation aimed at reclassifying 

a bridge from its fracture critical status by proving sufficient reserve strength due to the 

structural redundancy of the superstructure. To execute an investigation, it is proposed 

that researchers conduct two independent analyses and compare the results to comprehend 

the behavior of these bridge superstructure systems in detail. The aim of the two methods 

is to find the overstrength of the twin tub girder bridges selected from the bridge inventory. 

The overstrength reflects the amount of reserve capacity the structural members possess 

when applied with factored design loads. The decision regarding the reclassification from 

the fracture critical status may be conclusively drawn if the scope of this research both 

methods converge to a reasonable degree. Once it is identified that the two methods 

consistently predict sufficient reserve capacity, one or more methods may be 

recommended for implementation in the industry depending on the trends, if any, 

emerging from this research project. The two methodologies that are implemented are:  

• An accurate and thorough computational finite element analysis.

• A lower-bound computational grillage method.



3 

The finite element analysis implements the use of advanced elasto-plastic 

nonlinear elements to accurately simulate the material behavior and loading. The results 

generated from this method are considered the most accurate because the program utilizes 

advanced computational accuracy to model the system with high precision. Consequently, 

the procedure requires time and sophisticated computational resources. The plastic method 

is employed to develop a lower-bound (strip method) solution to calculate the reserve 

capacity manually. This gives a range of the overstrength factors to quickly compare with 

the computational methods. The grillage analysis (based on a lower-bound strip method) 

is conducted using nonlinear elasto-plastic material and hinge properties to model the 

behavior of the bridge under design vehicular loading. The computational push-down 

grillage analysis is carried out using the matrix methods of structural analysis in SAP2000. 

The grillage analysis can be considered as a practical blend of the advanced computational 

finite element analysis and the plastic method due to its nonlinear elasto-plastic modeling 

approach and its evolution from the lower-bound strip method.  

The two methods are independently studied via extensive parametric studies and 

the veracity of each method is checked by validating the analytical results with those 

obtained experimentally. The next stage of analyses involve the assessment of the 

overstrength factors of these bridges when analyzed under AASHTO load and resistance 

factor design (LRFD) loading. This research was aimed at equipping professional bridge 

engineers to apply the analytical methods to investigate the inherent reserve strength of 

the twin tub girder bridges so as to eliminate the FCM designation of the steel tub girders 
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and reclassify them as system redundant members (SRMs) as defined by Federal Highway 

Administration (FHWA) memorandum HIBT-10 FHWA (2012). 

1.2. Objectives of Research 

A key objective of this research is to develop more rigorous modeling and analysis 

methods. These analysis and modeling methods shall take into account the capacity of the 

fractured girder, especially at support locations, and realistically model the load 

distribution between the intact girder and the fractured girder. However, the modeling and 

analysis methods need to be sufficiently straightforward to be applied on a large scale to 

the inventory of steel tub bridges. The analysis method developed should meet the 

requirements outlined in the Federal Highway Administration (FHWA) Memorandum 

(FHWA 2012). 

1.3. Structure of Dissertation 

The structure of this dissertation is as follows. Chapter 2 details the background 

knowledge gleaned on the subject matter. Chapter 3 details the parametric selection of 

bridges to be evaluated in this study as well at accompanying Finite Element Analysis 

(FEM) results for the 15 bridges. Chapter 4 contains the Grillage Push-Down Analysis of 

the 15 selected bridges in the parametric study. A comprehensive comparison of the FEM 

and Grillage Analysis results is located in Chapter 5. A detailed Grillage Analysis Design 

Guide is located in Chapter 6. Finally the conclusion of the study and findings going 

forward are located in Chapter 7.  
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2. LITERATURE REVIEW

2.1. Introduction 

Steel twin tub girder bridges have become increasingly popular in Texas because they 

offer a solution for long-span and/or curved highway bridges in addition to providing an 

aesthetic structural option. Steel twin tub girder bridges appear in many different designs 

and they vary in number of spans, span length and degree of horizontal curvature. The 

twin box bridge superstructure has become more common due to construction problems 

with curved I-girders. However the choice of twin steel tub superstructure comes with 

additional maintenance and fabrication cost due to their “fracture critical” designation 

according to the American Association of State Highway and Transportation Officials 

(AASHTO) Guide Specification for Fracture Critical Non-Redundant Steel Bridge 

Members (2012). Fracture critical or non-redundant designation requires strict fatigue 

consideration, substantial testing during fabrication and more periodic maintenance 

compared to non-fracture critical structures because they consist of nonredundant 

structural systems that could collapse or partially collapse due to the loss of a single 

structural member. In particular, rigorous frequent inspection requirement increases the 

life cycle cost of this class of bridge superstructure significantly. 

Steel twin tub girder bridges require hands-on inspection every two years, which 

costs the Texas Department of Transportation (TxDOT) about $2 million every two years 

 Reprinted with permission from “Fracture Critical Steel Twin Tub Girder Bridges Technical Report” 0-

6937-R1 by Hurlebaus S., Mander J., Terzioglu T., Boger N., Fatima A., 2018. Texas A&M Texas 

Transportation Institute, 5-30, Copyright 2018 by Texas A&M Texas Transportation Institute 
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including the traffic control costs. Therefore, removing the fracture critical designation of 

some or all of these bridges may significantly lower the cost of this bridge system, leading 

to more economic inspection requirements. In order to be able to designate a two-girder 

bridge as redundant, it is necessary to show that the bridge has sufficient reserve capacity 

after the fracture of one of the girders. This can be achieved through rigorous analysis 

techniques.  

This chapter documents the state of the art and practice for the analysis of bridges 

and redundancy studies of fracture critical bridges. This opening subsection introduces the 

fracture critical twin tub girder bridges and describes the motivation. In the second 

subsection, different methods of analysis are listed and briefly summarized. The third 

subsection presents the definition of fatigue and fracture, and several bridge failures due 

to fatigue and fracture. The fourth subsection introduces the concept of redundancy and 

the motivation for the initiation of fracture critical protocol. Different definitions provided 

in the design codes and specifications along with different sources of redundancy are also 

discussed in this subsection. In the final subsection relevant research about fracture critical 

bridges and modeling approaches for evaluating the redundancy of steel twin tub bridges 

are presented. 

2.2. Approaches to Analyzing the Behavior of Bridge Structures 

In structural engineering, physical phenomena are simulated using mathematical 

models which can represent the actual behavior of a structural system. Over the previous 

centuries, methods of structural analysis have developed and become more sophisticated 

as the ability to compute solutions has also improved. Indeterminate structural systems 
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require solutions that concurrently deal with both equilibrium and compatibility of 

deformations. In contrast, if the compatibility condition is violated due to inelastic 

behavior but equilibrium maintained, plastic solutions that provide collapse loads may be 

obtained. This subsection first describes historic through to modern methods of elastic 

structural analysis. Second, plastic methods for both frames and slabs are discussed. In the 

third and final part to this subsection, nonlinear methods of analysis are described whereby 

computational solutions can give the entire solution from the initial elastic behavior 

through to the plastic collapse load.  

2.2.1. Elastic Structural Analysis  

Linear analysis simply assumes that the load is proportional to displacement. This 

principle was first introduced by Robert Hooke and remains well-known due to Hooke`s 

law (1678). As force is related to stress and displacement to strains, they are also 

proportional to each other. Linear elastic analysis is based on the original undeformed 

geometry and elastic material properties. Analysis of structures using mechanics of 

materials approach or theory of elasticity are analytical formulations using linear elastic 

behavior and therefore closed-form solutions may be obtained. Although most structural 

systems involve material and geometric nonlinearity, elastic analysis has been widely used 

due to its simplicity. Engineers still use linear elastic methods by some modification to 

consider nonlinearities. When predicting the ultimate strength or in-service deformations, 

the results of linear elastic analysis are adjusted permitting a prescribed amount of moment 

redistribution. While it remains valid to use superposition for linear elastic analysis and 

then apply a measure of moment redistribution, it is not possible to assess the actual 
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collapse load. However, if the provided capacity is greater than the load demands some 

reserve capacity remains. Elastic solutions together with a limited amount of moment 

redistribution are lower bound limit state solutions. 

Linear elastic analysis may be used to estimate the actions and deflections of 

reinforced concrete structures under service loads but care must be taken for reduced 

stiffness due to cracking resulting from loading or restraint to thermal and shrinkage 

effects. These additional reasons of material nonlinearity complicate the design process 

using linear elastic methods. 

2.2.1.1. Beams and Frames 

The simplified approach of using linear elastic behavior defined by Hooke`s law enabled 

scientists to formulate mathematical models for many engineering problems. Bernoulli 

and Euler (1750) formulated differential equations for the deflection calculation of a beam. 

Euler has derived equations to calculate deflection of beams, buckling load of beams and 

his approach could be extended to calculate flexural stresses. Euler-Bernoulli beam theory 

(EBT) for flexural behavior and stiffness was developed and evolved over some 400 years. 

In EBT, it is assumed plain sections transverse to the longitudinal axis of the beam remain 

plane (straightness) and perpendicular to the axis after deformation (normality). In this so-

called straight line theory, the transverse deflection of a beam is governed by a fourth 

order differential equation. Although the derivation of analytical formulas originated back 

in 1700s the results of EBT were not commonly used until the 19th century when the 

wrought iron and later on steel was started to be used in large structures (Timoshenko 

1953). 
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The theory of elasticity developed throughout the second half of 18th and 19th 

century. These developments made it possible to design and build relatively simple 

structures such as bridges. However, finding analytical solutions for mathematical models 

for complicated (indeterminate) structures had led to large numbers of equations, which 

was not easy to manage without modern computational methods. One of the early methods 

for analyzing statically indeterminate elastic structures is the force method or flexibility 

method which was initially developed by James Clerk Maxwell in 1874 and later 

improved by Heinrich Müller-Breslau. A breakthrough was made when Hardy Cross 

(1932) first introduced the iterative “moment distribution” method. 

A significant development which led to computational analysis of structural 

systems was the development of Matrix structural analysis (MSA). MSA was first used in 

aerospace industry in 1930s through the formulation of Duncan and Collar (1934). Turner 

(1959) proposed direct stiffness method (DSM) which created the framework for the finite 

element method. Later Argyris and Kelsey (1960) described contrasting force and 

displacement based matrix methods. These methods became solvable with early digital 

computers and were popularized in the 1960`s and beyond. MSA basically discretize the 

mathematical model and create the matrix formulation for an assembly of bar, beam and/or 

beam-column members, which is then solved by computational tools.  

2.2.1.2. Plates and Shells 

In two-dimensional elasticity the most basic member behavior is membrane which has in-

plane stiffness only. This behavior is analogous to bar element in one-dimension. This 

means membrane cannot resist any bending moment. A plate is defined as a structural 



10 

member which is thin and its thickness is much smaller than its length or width. Similar 

to the beams the transverse loads are carried by the bending actions of the plate. Plate 

behavior models out-of-plane bending stiffness only and the member can resist bending 

moments. There are various plate theories which differ by their simplifying assumptions. 

Most commonly used one is the classical plate theory (Kirchhoff theory of plates), which 

is a generalization of Euler-Bernoulli beam theory. There are three main assumptions; 

sections perpendicular to mid-surface remain straight (straightness), these sections also 

remain perpendicular to the mid-surface (normality), and the thickness does not change 

during deflection (inextensibility). Based on these assumptions the normal stresses in the 

transverse direction vanishes (plane stress), and the transverse shear strains are neglected. 

However, for thick plates there may be significant shear strains that contributes to 

transverse stresses. Mindlin plate theory includes the effect of transverse shear strains by 

removing the normality assumption, which is analogous to the Timoshenko beam theory 

(Timoshenko and Woinowsky-Krieger 1959). Shell behavior considers both in-plane 

stiffness (membrane behavior) and out-of-plane stiffness (plate bending) for modeling a 

two-dimensional structural member. 

It is possible to simulate the behavior of a bridge superstructure as an orthotropic 

plate in order to get analytical solution for the displacements and stresses as well as 

eigenfrequencies (Hurlebaus 2007; Hurlebaus et al. 2001). An orthotropic plate is the 

common name for plates that have uniform but different elastic properties in the two 

orthogonal directions. In this method the bridge superstructure is represented by an 

equivalent orthotropic plate with uniform thickness. Longitudinal stiffnesses are 
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calculated based on the composite beam and slab section. Transverse stiffnesses are 

calculated based on the deck stiffness alone. This geometric simplification requires that 

the beams are equally spaced, which is generally the case in practice (Sanders and Elleby 

1970). Considering these assumptions the orthotropic plate behavior satisfies a fourth 

order partial differential equation (Timoshenko and Woinowsky-Krieger 1959). Although 

this is a way of obtaining the solution, this method requires many approximations to 

reduce the three-dimensional complex bridge superstructure to a two-dimensional 

constant thickness plate. 

2.2.2. Plastic Methods of Analysis (Limit Analysis) 

Traditionally theory of elasticity has been widely used because it is relatively simple due 

to the assumption of proportional stress and strains, however, this approach cannot 

estimate the real behavior or safety at the limit state. Structural materials, especially steel, 

may withstand considerable strains beyond their initial yield strain. As a structural 

member is loaded beyond yield, the material behaves in a plastic fashion. Once a section 

reaches its load capacity it deforms at almost constant load. This ultimate load capacity of 

the section is calculated from the material properties in the plastic range. The first critical 

section reaches the yield moment while other sections of the structure remain elastic. This 

state of the structure results in elastic-plastic deformations that eventually reaches full 

plasticity as the loads are increased. When a full mechanism is achieved the collapse load 

is reached.  

In formulating plastic methods of analysis, there are two main theorems: (1) lower 

bound theorem that commonly uses graphical means or simplifying assumptions; and (2) 
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upper bound theorem where various mechanisms are assumed with the correct mechanism 

having the lowest load (least energy).  

2.2.2.1. Beams and Frames 

In using the LRFD (load and resistance factor design) approach, beams and frames are 

analyzed using elastic methods while the reinforcement for beams and frames is calculated 

by strength methods which considers the inelastic properties at the ultimate load. Limit 

analysis does not have this inconsistency, and accounts for redundancies and redistribution 

allowing more practical reinforcement design. Limit analysis of beams and frames can be 

achieved through lower bound graphical methods. All plastic hinges must have adequate 

rotation capacity. 

The lower-bound analysis implies that the estimated capacity is smaller or equal 

to the true load capacity. The starting point of lower bound graphical methods consists of: 

(i) drawing moment diagrams for a statically determinate structure; (ii) assigning fixing

moments (the redundant actions); (iii) determining the required plastic capacity which is 

the largest moment. Note this may not lead to a complete mechanism hence the solution 

is said to be a lower bound.  

2.2.2.2. Slabs 

Plastic analysis methods for estimating the ultimate capacity of beam and slab bridges 

have been used by many designers and researchers in the past. For example, the use of 

elastic analysis for estimating highly ductile reinforced concrete bridge deck results in 

very conservative ultimate load predictions. The application of plastic analysis for slabs is 
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relatively less tedious compared to beams and frames because slabs are generally under-

reinforced and consequently have large rotational capacity. Several practical techniques 

have been developed for application of plastic method to slabs such as lower bound strip 

methods (Park and Gamble 2000). 

Plastic methods of analysis for analysis and design of bridge decks have long been 

available but rarely used in US. Limit analysis is particularly useful for investigating the 

possible failure modes, behavior beyond yielding, and residual capacity of in-service or 

deficient bridges. By investigating certain collapse mechanism, it is possible to detect 

undesirable collapse mechanisms such as shear failure, which is a sudden brittle failure 

mode, and adjust the design to get a more ductile behavior and get flexure mechanism at 

the ultimate load. 

Strip methods for slabs were first developed by Hillerborg (1956). Strip methods 

provide lower bound solutions which satisfy equilibrium and yield conditions (moments 

are always smaller than or equal to the plastic moment) everywhere in the slab. In contrast 

to yield line analysis, strip methods provide conservative (safe) capacity predictions. The 

strip method is a practical design method where the reinforcement can be designed without 

any iterative process. Wood et al. (1968) later evaluated and improved the method 

regarding continuity conditions. Armer (1968) conducted an experimental study where 

half-scale slab specimens designed using strip method were tested. It was concluded that 

the strip methods consistently produce safe designs. 
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2.2.3. Computational Nonlinear Finite Element Solutions 

Physical systems are generally modeled using differential equations and corresponding 

boundary conditions. For real world problems, such as complex structural shapes 

including material nonlinearity, it is most of the time impossible to get a closed form 

analytical solution. It is a common practice to seek solution using approximate and 

computational methods such as finite difference, finite volume and finite elements. Finite 

element method (FEM) is the most widely used technique due to its generality, versatility 

and applicability to various differential equations. FEM is particularly useful for analyzing 

complex geometries, loadings and material properties, which is generally the case in real 

physical problems. In FEM modeling approach the structure is approximated with set of 

elements having simple geometries such as triangles and rectangles. Each element satisfies 

the differential equation of the problem in hand and has the material properties of structure, 

which forms the element stiffness relation. These elements are connected at their nodes to 

form the global stiffness relation for the whole structure creating set of algebraic relations. 

Although it is not possible to clearly identify the inventor of FEM, (Turner et al. 

1956) generalized the direct stiffness method and created FEM that was used in everyday 

engineering problems starting in aerospace engineering. Later Ed Wilson developed the 

first open source computer program in FOR-TRAN II (1958) using IBM 704. Wilson`s 

work provided the basis for most of the early FEM programs. In 1950s and 1960s the FEM 

technology was transferred from aerospace engineering to wide range of engineering 

applications by J. H. Argyris (1960), R. W. Clough (1956), and H. C. Martin (1956). 



15 

2.3. Fatigue and Fracture in Bridges 

Traffic loads on bridges causes stress cycling. Repeated stress cycling accumulates 

damage that may initiate fatigue cracks. If left unattended the fatigue induced cracks grow 

and lead to unstable growth and eventually fracture the material. Fatigue damage is 

prevalent in metal structures and particularly steel bridges. High cycle fatigue failure is 

common in or near the connection of metal bridge components. Older metal bridges, 

whether they be constructed from wrought iron or steel commonly show signs of distress 

at riveted connections. More modern steel bridge structures have a propensity for fatigue 

failure at or nearby welded connections. This subsection commences by outlining some 

classical fatigue and fracture failures. Then goes on to describing how fatigue problems 

are categorized by design in accordance with AASHTO LRFD Specifications (2014). In 

particular, fracture critical structural systems and how such systems are dealt with, by 

design is discussed. 

2.3.1. Fatigue and Fracture Failures in Bridge Structures 

Scheffey (1971) investigated the failure of the collapse of the Point Pleasant Bridge 

(Figure 2.1) in December 1976 and reported that the collapse was due to failure of a single 

eye-bar connecting the suspension chain. The Point Pleasant Bridge, also known as Silver 

Bridge because of her silvery painted aluminum color, in West Virginia over the Ohio 

River was opened in 1928. The Silver Bridge was “nearly 2,235 ft long, including a main 

span of 700 ft and two side spans of 380 ft each” (Witcher 2017). The bridge design first 

called for conventional wire cables but was later modified to use eye-bar chains since they 

were less expensive. The Silver Bridge was the first eye-bar suspension bridge in the 
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United States and after nearly 40 years in use and a significant change of the vehicle loads, 

the bridge collapsed during the evening rush-hour with the result that 46 people died and 

9 were injured. (Witcher 2017). Although the bridges that were constructed before 1985 

did not have strict fatigue and fracture requirements, there are very few examples of failure 

in US and the Silver Bridge was one of them.  

Figure 2.1: Silver Bridge after the collapse in 1967 (Reprinted from NTSB 1971) 

Barker and Puckett (2013) describes two critical bridge collapses that led to the 

development of more strict code provisions. All the other crashed bridges since 1950 

collapsed because of other unforeseen events such as accidents of vehicles, ships or natural 

disasters. The total collapse of the Silver Bridge had a big influence on the design, 

selecting materials and fabrication on future bridges and the inspection of non-redundant 

bridges in the United States. In 1968, the National Bridge Inspection Standards (NBIS) 
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were inaugurated under the Federal-Aid Highway Act which prescribes, that the time lag 

of an inspection of a bridge should not exceed two years.  

The Mianus River Bridge, seen in Figure 2.2, was the second bridge which 

collapsed (1983) due to fatigue of the material. The Mianus River Bridge was a “pin and 

hanger” design bridge, which was commonly used in the year of construction because of 

the cheaper construction costs and collapsed after 25 years of service. Due to corrosion of 

storm drains which were installed ten years before the collapse, the pin and hanger 

assemblies moved and shifted the weight to the outside hanger which had to carry all the 

weight, resulting a fatigue crack. This fatigue crack caused the hanger to separate from the 

upper pin and subsequent the span of the bridge collapsed and the span fell down into the 

river. The Mianus River Bridge disaster could have been avoided because it had regular, 

but insufficient inspections. After the collapse of the Silver Bridge over the Ohio River, 

the Mianus River Bridge was inspected 12 times with the last inspection only 1 year before 

the collapse, but the inspectors only inspected the bridge visually from the ground with 

binoculars so that they could not identify the lateral displacement of the hangers. They 

noted “heavy rust on the top pins from water leaking through the expansion joints”, but 

this was not relevant enough to foresee the collapse. 
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Figure 2.2: Collapse of the Mianus River Bridge (Reprinted from Fisher 1997) 

After the publication of AASHTO guidelines for fracture critical members (FCM), 

the steel manufacturing industry and structural engineers adopted them successfully. 

Therefore, fatigue and fracture failures are very rare in the last 35 years (Connor et al. 

2005). Note however, that both the Point Pleasant Bridge and the Mianus River Bridge, 

were constructed before the implementation of FCB inspection program. There have been 

several FCBs that have experienced partial or full depth fracture in the last 40 years. They 

were generally identified during periodic inspection but did not result in a collapse or loss 

of life. Apparently secondary elements such as the deck, cross bracing, or diaphragm 

helped to particularly redistribute the load to other members.  

Several total member failures of twin girder bridges indicated that two girder 

bridges offer somewhat of a redundant load path while they are all declared as fracture 

critical because of their composition. In May 1975, one of the main girders of the Lafayette 

Street Bridge over the Mississippi River in St. Paul, Minnesota was discovered by the 

Minnesota Department of Highways inspection personnel (now Minnesota Department of 
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Transportation) to have a full depth fracture (Fisher et al. 1977). The crack was due to a 

fatigue crack and as a result the bridge did sag 6.5 in. (165 mm) but did not collapse 

(Connor et al. 2005).  

In January 1977, a tugboat captain discovered a large crack in a girder of the I-79 

Glenfield Bridge over the back channel of the Ohio River. After spotting the damage, the 

crack was observed to move up the web to the bottom of the flange in about one hour. 

Figure 2.3 shows the full depth fracture of the girder. Obviously, the bridge had a 

redundant member which carried the load of the broken girder.  

Figure 2.3: Cracked girder of the I-79 Glenfield Bridge in 1977 (Reprinted from 

Fisher 1984) 

A similar case was spotted in 2003 by a bird watcher who discovered a crack in a 

girder of one of the six girders of the I-95 Brandywine River Bridge. The last full 

inspection was less than half a year before the crack was discovered and at the time “no 
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evidence of fatigue cracks on the fascia girder was reported” (Chajes 2005). Directly after 

the confirmation of the crack, the Delaware Department of Transportation closed the 

bridge. However, all the three given examples of girder bridges did not result in a collapse 

and provide evidence, that two-girder bridges feature some redundancy in load path even 

though they are classified as fracture critical. 

2.3.2. Addressing Fatigue Problems by Design 

Fatigue is the structural damage of the material due to repeatedly applied loads. The 

damage occurs, when the material is exposed to cyclic loadings and the maximum load 

which initiate such a damage may be much less than the capacity of the material which is 

usually called yield stress limit. The material may experience progressive brittle cracking 

far below its yield stress due to the cyclic loadings. Cyclic loading is the repeated loading 

and unloading of the material and the first microscopic brittle cracks develop where there 

are stress concentrations.  

Much experimental research has been conducted to identify crack initiation 

(fatigue) and fracture propagation (fracture mechanics). However, all research and 

simulations on crack initiation are modeled on a macroscopic scale and the first voids 

become visible at the size of 1 µm (Belak 1998). That indicates that the nucleation of tiny 

voids during the fatigue process is microscopic start before they may be identified. Fatigue 

has a significant influence on the life time of the structure because if the crack reaches a 

critical size, the crack size may increase rapidly and the structure will fracture.  

Fracture is the separation of a structural member into two or more independent 

pieces due to excessive stress or fatigue. The ductile fracture is the extensive permanent 
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plastic deformation ahead of the crack and the deformation is stable during the applied 

stress unless the load is increased. Most metal fractures may exhibit ductile characteristics 

when the applied load is increased continuously. First the metal will deform elastically 

and will return to its original state, when the applied load is removed until the yield point 

is reached. After exceeding the yield point, the curve typically decreases due to dislocation 

(Cottrell and Bilby 1949) and then the material will deform plastically until the ultimate 

strength is attained. The rupture of structural steel occurs after reaching the ultimate 

strength and passing the necking period where the strain concentrates disproportionally in 

a small region of the material. The second type of fracture is the brittle fracture and that is 

how ceramics, cold metals or ice break. Brittle fractures are characterized by possessing 

little or no plastic deformation. The crack appears quickly without an increase of the 

applied load and is unstoppable.  

A fracture initiated via fatigue stress cycling may also mean that brittle failure has 

progressed through to unstable fracture propagation with the maximum (average) stress 

well below the yield stress limit. Therefore, fatigue design specifications for steel bridges 

were developed in 1970s as a result of research studies conducted as part of an NCHRP 

project (Fisher 1970; Fisher et al. 1974). The use of floor beams or diaphragm plates 

connected to the flanges became the requirement in fatigue design specifications by 1985. 

These fatigue design specifications were adopted in AASHTO LRFD Specifications in 

1998 (AASHTO 1998). Modern steel bridges that were built after 1985 possess high level 

of reliability in terms of fatigue due to current design and detailing requirements according 

to fatigue design specifications. Fatigue problems in bridges that were built according to 
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current fatigue design provisions were typically due to design errors or unintended 

behavior.  

AASHTO fracture control plan has two main aspects; (1) strict controls during the 

design and construction to prevent structural flaws and to assure sufficient material 

toughness, (2) detailed inspection requirements to ensure that the defects are detected and 

repaired on time. The requirements for the manufacturing of steel girders and material 

toughness specifications assures high standards for modern bridges. In addition, high 

performance steel offers superior toughness, which could reduce the need for some strict 

provisions for FCMs (Dexter et al. 2004). On the other hand, the second aspect of 

AASHTO fracture control plan for the hands-on inspection highly restrictive provisions 

even for newly built steel bridges. Although this strict inspection protocol may be 

necessary for older bridges that were built before 1985, current fracture control plan does 

not differentiate between the modern bridges and old bridges. A lot of the modern steel 

twin I-girder or twin tub girder bridges fall into a “fracture critical” category. 

2.4. Redundancy 

The structural engineering community has realized the importance of redundancy in steel 

bridges after the total collapse of the Silver Bridge in West Virginia in 1967 due to failure 

of a single eye-bar connecting the suspension chain (Scheffey 1971). Code provisions and 

safety requirements were then modified for bridges susceptible to a fracture critical 

condition, where the failure of one member may lead to total collapse of the bridge. The 

concept of redundancy and definition of fracture critical members (FCM) was first 

introduced into the AASHTO Standard Specifications for Highway Bridges (1979) after 
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the release of AASHTO Guide Specification for Fracture Critical Non-Redundant Steel 

Bridge Members (1978). However, the definition of redundancy and fracture critical 

members was vague and there remains no clear guidance on quantifying the level of 

redundancy. A fracture critical member is defined as a “component in tension whose 

failure is expected to result in the collapse of the bridge or the inability of the bridge to 

perform its function” in the current AASHTO LRFD Bridge Design Specification (2012) 

but there are many other definitions such as “a steel member in tension, or with a tension 

element, whose failure would probably cause a portion of or the entire bridge collapse.” 

in the National Bridge Inspection Standards (NBIS) (Lwin 2012).  

Most of the US and Canadian DOTs use the AASHTO or the NBIS definition for 

redundancy (Connor et al. 2005). In general, slab-on-girder type bridge superstructures 

are considered redundant when they have at least three girders, which is based on a load-

path consideration. This approach is quite conservative and does not take into account 

lateral distribution of loads through secondary elements from a damaged member to an 

undamaged member. In addition, internal redundancy and structural redundancy has not 

been taken into account for redundancy assessment. Early redundancy studies between the 

1970’s and late 90’s were conducted to develop tools for evaluating and measuring the 

redundancy levels in structural systems. The following summarizes several early studies 

conducted following the release of the AASHTO Guide Specifications (1978) in which 

non-redundant bridges were defined as “structures where the failure of one member could 

cause collapse.” However, no objective way of measuring redundancy was introduced to 

define redundancy.  
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Some twin girder bridges are likely to withstand service loads after the fracture of 

one member due to internal redundancy or alternate load paths such as bracings. One of 

the earliest studies about the internal redundancy was carried out by Sweeney (1979). The 

author points out that riveted built-up members may provide internal redundancy; riveted 

members are not as critical as welded members in case of a fracture. Therefore, these 

differences should be identified to better quantify post-fracture redundancy. Sweeney 

(1979) suggested that providing a redundant load path or a component redundant structure, 

such as in the case of riveted built-up structures, may be required to avoid fracture failures. 

Numerous other studies have focused on post-fracture behavior by considering the 

alternative load path provided by bracing. Heins and Hou (1980) and Heins and Kato 

(1982) evaluated two girder steel bridge behavior after the major fracture of a girder. The 

findings suggest lateral bottom bracing and cross bracing effectively transfer load to intact 

members creating additional post-fracture redundancy.  

In the 1980`s researchers tried to develop guidelines and provisions to better define 

the redundancy of a bridge in the event of a full-depth fracture of a member. One of the 

early attempts was the study by Parmelee and Sandberg (1987). Their study suggested a 

more objective criteria and provisions should be developed to define redundant live load 

levels, allowable stress and deflection limits after the fracture of a member in a non-

redundant system. 

Frangopol and Curley (1987) performed an analytical study in an effort to identify 

the effect of redundancy on the reliability of a bridge system. The authors defined 
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redundant factors, or math mode, for intact and damaged structures in order to quantify 

residual capacity. 

𝑅2 =  
𝐿𝑖𝑛𝑡𝑎𝑐𝑡

𝐿𝑑𝑒𝑠𝑖𝑔𝑛
(2.1) 

𝑅3 =  
𝐿𝑑𝑎𝑚𝑎𝑔𝑒𝑑

𝐿𝑖𝑛𝑡𝑎𝑐𝑡
(2.2) 

Ω = 𝑅2𝑅3 =  
𝐿𝑑𝑎𝑚𝑎𝑔𝑒𝑑

𝐿𝑑𝑒𝑠𝑖𝑔𝑛
(2.3) 

Where 𝑅2 = reserve redundant factor; 𝑅3 = residual redundant factor; 𝐿𝑖𝑛𝑡𝑎𝑐𝑡 = 

load carrying capacity of the intact structure; 𝐿𝑑𝑒𝑠𝑖𝑔𝑛 = design load; and 𝐿𝑑𝑎𝑚𝑎𝑔𝑒𝑑 = load 

carrying capacity of the damaged structure. The product of the reserve capacity and the 

residual capacity is a measure of the structure’s reliability. It was suggested that math 

mode-factors may provide a deterministic way of measuring overall system strength. 

Daniels et al. (1989) carried out a detailed analytical study investigating the 

redundancy of simple span and continuous steel twin girder bridges with bracing systems. 

A fracture was assumed emanating from the bottom flange up the entire depth of the webs, 

but not into the compression flange. The post-fracture behavior of twin girder steel bridges 

was evaluated in significant detail, guidelines provided for assessing the redundancy 

through 3D analytical models or finite element method (FEM) analysis of an as-built 

structure with properly modeled bracings. It was concluded that twin girder steel bridges 

with properly designed bracing are capable of providing significant redundancy following 
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a near full-depth failure of one of the girders. Although the bracing may not be designed 

for redundancy, the bracing may provide a secondary load path following the fracture of 

one girder. The authors suggested that a redundancy rating based on 3D analytical models 

or computational FEM analysis may be used to develop a redundancy rating.  

Ghosn and Moses (1998) defined redundancy as “the capability of a bridge 

superstructure to continue to carry loads after the damage or the failure of one of its 

members.”. A bridge system may be declared as safe if it satisfies four criteria. First, the 

system has to provide an appropriate safety level against member failure. Second, the 

system capacity of the bridge may not reach its maximum under extreme loading 

conditions. Third the bridge may not deform largely under expected loading conditions 

and last the bridge has to be able to carry some traffic loads after the failure of one of its 

members.  

Ghosn and Moses (1998) also set objective criteria for estimating the residual 

capacity of bridges and provide guidelines accordingly. Their proposed approach utilizes 

statistical system factors to assess the level of redundancy of a member. Therefore, the 

overall system behavior is considered rather than individual components. Current code 

requirements generally ignore the system effect and considers load-path redundancy 

resulting in a conservative consideration. This research suggested system factors that 

provide sufficient level of redundancy for structural safety under service load conditions 

when the system reserve ratio for damaged condition is greater than 0.5 which means that 

the bridge capacity must be more than 50% of the capacity of the critical member. 
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𝑅𝑑 =  
𝐿𝑓𝑑

𝐿𝐹1
(2.4) 

Where 𝑅𝑑 = system reserve ratio for the damaged condition; 𝐿𝐹1 = the capacity of 

the bridge before failure of any member using elastic analysis; and 𝐿𝑓𝑑 = the capacity of 

the damaged bridge before reaching ultimate load. Although the proposed approach has 

been used by different agencies and bridge designers, it has not been adopted into national 

bridge design specifications. 

Connor et al. (2005) carried out a synthesis study as part of National Cooperative 

Highway Research Program (NCHRP) Report 354, which focused on the inspection and 

maintenance of fracture critical bridges since the manufacturing costs were found to be 

small compared to mandated fracture critical inspection. As of 2005, they noted that 

around 76 percent of all FCBs were built prior to 1978. Eleven percent of all bridges in 

United States have FCM designation and 83% of these bridges are two-girder-bridges or 

two-line-trusses and 43% of the FCM are riveted members (Connor et al. 2005). The 

authors suggest that designers focus on a target reliability level rather than a redundancy 

level. They suggested that it is possible to achieve target reliability for a non-redundant 

bridge by providing about 17% conservatism in the design. One of the major contributions 

of this synthesis study was the compiled field information about the fracture incidents. 

Only two bridges, the Point Pleasant Bridge (constructed in 1928) and Mianus River 

Bridge (constructed in 1957) had a total collapse due to fracture. 

A technical memo with the subject “Clarification of Requirements for Fracture 

Critical Members,” (Lwin 2012) points out the shortcomings of current redundancy 

definitions and recognizes the system level performance as a way of evaluating 
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redundancy. The concept of redundancy is critical for bridges because non-redundant 

bridges are classified as fracture critical. Although the term “redundant” is very intuitive 

for most structural engineers, there is no clear definition for measuring the redundancy 

level of a bridge superstructure. AASHTO LRFD describes redundancy as “the quality of 

a bridge that enables it to perform its design function in a damaged state.”  

Three different types of redundancy are defined (FHWA NBIS 2012): 

a) Load Path Redundancy

b) Structural Redundancy

c) Internal Redundancy

A structure may be classified as redundant if it satisfies one or more of these 

redundancy criteria. Each of these are discussed in the following paragraphs: 

Load-path redundancy is relatively easy to identify because these bridges having 

more than two girders are designated redundant, but some agencies even require four or 

more load carrying girders to be contemplated as load-path-redundant. If one of the girders 

would completely fracture or may not perform its task, the load would be redistributed to 

the neighboring girders and the bridge would be safe from a total collapse. Load-path 

redundancy simply considers parallel primary load carrying members, which may be 

girders or trusses.  

Structural redundancy is a function of static indeterminacy of the entire structure, 

which may be due to continuity of the bridge over interior supports or sometimes due to 

secondary members such as the deck. Continuous multiple span-bridges possess structural 
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redundancy and in case of a failure of one beam member, some load is redistributed from 

one span to another for which reason a total collapse of the bridge may be minimized.  

Internal redundancy may be provided by member detailing to prevent fracture 

propagation through the entire cross-section. Internal redundancy exists in built-up 

members which have multiple parallel plates and other structural components within a 

member. A member is internally redundant if it has three or more similar elements 

connected together. If one of the elements fail, the load may be redistributed to the other 

elements and the member will not fail. Internal redundancy may be abolished when the 

member has to be repaired by welding the elements together. Welded members carry the 

load path from one member to the other and may be considered as one single member. In 

general, redundancy is determined considering alternative load paths for the purpose of 

identifying fracture critical bridges (FCB). However recent experimental and analytical 

research has shown that certain bridges identified as non-redundant may have sufficient 

reserve capacity due to 3D system behavior and transverse load distribution through 

secondary load paths, such as the deck slab and/or cross-frames.  

FCB designation have two main aspects: (1) design/fabrication requirement; and 

(2) inspection protocol. Currently FCM`s require 24-month inspection criteria and stricter

fabrication requirements to meet the American Welding Society (AWS) Bridge Welding 

Code requirements. These requirements are collectively called the Fracture Control Plan 

(FCP). Although FHWA (2012) allows the use of rigorous analysis and consideration of 

system level redundancy for the inspection of in-service bridges, this approach is not 

allowed for fabrication protocols of steel twin tubs. Therefore, for fabrication, redundancy 
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should be decided based on load-path redundancy and non-redundant tension members 

should conform to AASHTO LRFD, FCP and AWS. This new classification is defined as 

a System Redundant Member (SRM): “A member that requires fabrication according to 

the AWS FCP, but need not be considered a FCM for in-service inspection.” 

2.5. Fracture Critical Investigations on Slab-on-Steel Girder Bridges 

Steel twin I-girder bridges are a popular system of construction used for both straight and 

curved bridges; this bridge system is designated as fracture critical due to lack of load path 

redundancy (having less than three girder lines). Fasl et al. (2016) investigated the fatigue 

response of a fracture critical steel twin I-girder bridge, which was built in 1935 over 

Medina river on IH-35. The bridge has been featuring fatigue cracks along the weld at the 

top flange and lateral beam connections. The bridge was instrumented using strain gage 

and crack propagation gauges along the existing fatigue cracks. The behavior and crack 

propagation was monitored during rush hours. Due to extent of the fatigue cracks the 

girders were strengthened by installing bolted cover plates at critical locations. The 

behavior was also monitored after the installation of bolted cover plates. The authors 

monitored the bridge for more than two months before strengthening and estimated the 

residual fatigue life of the structure. The bridge was also monitored during and after the 

strengthening. The authors reported that the built-up sections provide some level of 

internal redundancy because the fatigue cracks did not propagate into the webs. They also 

concluded that the strengthening method reduced the fatigue damage by providing 

composite action with the deck and this may be a potential rehabilitation for old bridges 

that exceed their original design life expectancy. 
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2.6. Fracture Critical Steel Twin Tub Girder Bridges 

Figure 2.4 presents a typical steel twin tub girder bridge of the type that has become 

popular in Texas because they offer a solution for long-span and/or curved highway 

bridges in addition to providing an aesthetic structural option. Steel twin tub girder bridges 

consist of two steel girders which are the primary members for transmitting the dead load 

and live load to the substructure. On the other hand concrete deck and stringers are 

secondary members that create a load path between girders (Daniels et al. 1989). Because 

of their fracture critical designation, steel twin tub girder bridges require a hands-on 

inspection every 2-years. This rigorous inspection may include the testing of welds, 

nondestructive evaluation and visual assessment. Procedures of nondestructive evaluation 

of steel members may “include dye penetrant, magnetic particle, or ultrasonic techniques” 

(TxDOT 2013). 

Most bridges in the Texas FCB inventory are steel twin tub girders, which 

automatically fall into the fracture critical category because of two girder lines. Field 

testing of in-service bridges and experimental testing of full-scale bridges under controlled 

loading help to build up experimental data in order to assess the reliability level after the 

fracture of a load carrying member. Furthermore, this data enables researchers to verify 

different modeling approaches and develop modeling standards for evaluating redundancy 

levels due to internal redundancy, structural redundancy or alternative load distributions 

through secondary members. 

Coletti et al. (2005) provided guidelines and preliminary design suggestions for 

the design of steel tub girder bridges including preliminary sizing and spacing 
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considerations. They also discussed possible design issues, available analysis tools and 

detailing of tub girders. The authors stated that steel twin tub girders are economical 

between a span range of 150 to 500 ft, permitting also tight radius of curvature solutions 

and good aesthetics owing to the simple clean lines.  

Figure 2.4 Steel Twin Tub Girder Bridge I 35/US 290 Interchange, Austin, Texas 

(Reprinted from Coletti 2005) 

Hunley and Harik (2012) investigated the effect of various secondary structural 

components for developing load transfer paths for one member of a twin steel tub bridge 

fails using a parametric non-linear finite element analysis. The variables that were studied 

in this investigation included location of damage, continuity, and span length. A load 

transfer mechanism from a fractured girder to the intact girder should develop in order to 

have a measure of redundancy. Figure 2.5 shows that for steel twin tub superstructures, it 
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is only possible through concrete deck and/or external cross-frames. If the deck fails 

progressively following the failure of a girder, one should not rely only on the deck for 

lateral load transfer.  

Hunley and Harik (2012) analyzed 33 bridge configurations to investigate reserve 

load capacities following fracture of one member. The fracture of one of the girders was 

modeled by reducing the stiffness of bottom flange line element and the web shell element. 

The damaged condition of the deck was modeled by reducing the stiffness of individual 

finite element when they reach crushing strain. Redundancy levels of the analyzed bridges 

were calculated using the damaged condition capacity,  𝑅𝑑, as defined in NCHRP Report 

406. The authors determined the capacity of the damaged bridge should be at least 50%

of the capacity of the undamaged bridge to be classified as “redundant.” Based on the 

assessment of redundancy levels of all analyzed bridge geometries, the authors concluded 

that a progressive failure of a bridge deck results in insufficient load capacity to meet the 

minimum redundancy level. It was also noted that girder continuity increases redundancy. 

The authors also concluded that the external bracing is the key parameter for providing 

sufficient redundancy as seen in Figure 2.5.  
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Figure 2.5. External bracing types: (a) K-type cross-frames; (b) solid diaphragms 

(Reprinted from Hunley and Harik 2012). 

Barnard et al. (2010) recently investigated steel twin tub girders performance as 

part of TxDOT Project 9-5498. The study included extensive laboratory testing, with the 

experimental investigation of a full-scale box-girder bridge together with comprehensive 

computational modeling. The major objective of the research was to evaluate the behavior 

of twin box girder bridges after the fracture of one girder and provide guidelines for 

modeling the post-fracture response. The tested bridge was simply supported; therefore, it 

did not have the structural redundancy that often exists for continuous multiple span 

(indeterminate) bridges. External braces that could contribute to load distribution in the 

damaged bridge were removed based on TxDOT practices. The authors conducted three 

tests at different damage states using different loading conditions. During the first test a 

sudden fracture was created at the mid-span of bottom flange of the exterior girder using 

charge explosives while an equivalent HS20 load was placed directly above the fractured 

girder. The bridge deflected less than one-inch. The second test was conducted under 

similar loading but this time a sudden full-depth fracture was created on the external 
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girder. The fractured external girder deflected 7 in. but could still support the service load. 

The third test was the ultimate load test while the exterior girder had full-depth fracture. 

The bridge could still carry more than five times the legal truck load. It was concluded 

that the prominent failure mode was initiated by pull-out of shear studs in the deck 

followed by crushing of the reinforced concrete deck.  

The effect of different parameters including radius of curvature, railing and 

continuity were also considered in the tests and analysis. The effect of the railing 

significantly reduced the deflection while increasing the tensile forces on the stud 

connections. Therefore, ignoring the railing is not necessarily conservative in a 

redundancy analysis. The results also showed that the decrease in the radius of curvature 

resulted in an increase in the vertical deflection of the damaged girder. Based on 

experimental testing it was observed that the damaged bridge performed with sufficient 

redundancy to redistribute and continue to carry the very high applied loads.  

Samaras et al. (2012) proposed a simplified method for evaluating the redundancy 

of twin steel box-girder bridges based on the work conducted as part of TxDOT Project 9-

5498. The suggested method proposes initial strength check and yield line analysis for 

evaluating the remaining strength of the damaged bridge. A three level redundancy check 

was recommended: 

(i) The initial strength check (ISC) of the bridge with intact girder is conducted. If

the moment and shear strength is adequate and the deck has adequate shear capacity, the 

bridge can be called redundant. 
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(ii) If the initial strength check is not satisfied, a yield line analysis (YLA) can be

performed. ISC cannot be used if the shear studs pull out from the deck concrete. Figure 

2.6 depicts the surveyed deck deflections and assumed elastic plate displacements based 

on the actual failure shape. A yield line pattern was developed based on the observed 

failure shape. It was concluded that the assumed yield line could be used for fractured 

steel twin box girder bridges for estimating the ultimate load if shear studs pull out. Both 

ISC and YLA are conservative and convenient methods to quickly evaluate the 

redundancy level of fracture critical bridges. It was concluded this method can provide 

information about the mode of failure that can help identifying the remaining capacity of 

the bridge with a fractured girder. 

(iii) If YLA also shows inadequate capacity then more sophisticated nonlinear

computational methods such as finite element must be used. 

Figure 2.6. FSEL Bridge test: (a) Surveyed deflections and assumed yield line; (b) 

Damaged deck after test (Reprinted from Samaras et al. 2012). 
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Kim and Williamson (2014) developed finite-element modeling guidelines for 

evaluating the redundancy level of steel-twin tub bridges. This study was also conducted 

as part of TxDOT Project 9-5498. Their proposed modeling approach considers 

nonlinearity due to concrete cracking and crushing, as well as steel yielding. In addition, 

shear stud connection failure mechanism was also considered in the FEM model as stud 

connection failure may significantly affect redundancy. The pullout behavior of the 

embedded shear studs was evaluated through laboratory tests (Mouras et al. 2008; Sutton 

et al. 2014). A shear stud failure mode was observed during the second test where the 

girder had full depth fracture. The FEM models successfully estimated the bridge 

component failures. Both the test and FEM analysis suggested that the bridge had greater 

redundancy than defined by current code provisions.  

After verifying the modeling approach, Kim and Williamson (2014) analyzed 

several other bridge configurations using the same modeling approach to investigate the 

remaining load capacity following a full-depth failure of one member. They concluded 

that the shear stud connection behavior is one of the important parameters for capturing 

the failure mode correctly and evaluating the redundancy level. 

2.7. Research Questions Arising 

In light of the foregoing survey of the state-of-the-art and state-of-the practice for fracture 

critical bridges in general and steel twin tub girder bridges in particular, certain lingering 

questions remain that will be addressed in this research as follows: 

1. Is it possible to identify redundancy levels of existing and future steel twin tub

girder bridges in order to classify them as non-fracture critical?
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2. Do existing steel twin tub girder bridges have adequate capacity following the

fracture of one box member?

3. Is it possible to develop reliable and easy to implement analysis criteria using

grillage analysis?

4. It is possible to develop reliable an easy to implement analysis criteria using

grillage analysis?
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3. PARAMETRIC STUDY FOR STEEL TWIN TUB GIRDER BRIDGES USING

NONLINEAR FINITE ELEMENT ANALYSIS 

3.1. Introduction 

The chapter deals with a parametric study that includes the selection of 15 typical steel 

twin tub girder (STTG) bridges from the Texas bridge inventory, validating a FEM model 

to results obtained in TxDOT project 9-5498 (Barnard et al. 2010), and computational 

modeling of selected bridges using finite element method (FEM).  

The current study investigates the performance of existing fracture critical steel 

twin tub girder bridges in the case of a full depth fracture of one of the girders. Therefore, 

a total of 15 steel twin tub girder bridges were selected by considering different span 

lengths, different degrees of curvature, and the effect of continuity. These parameters are 

considered to be critical geometric parameters for evaluating the bridges’ response in 

terms of load distribution between girders. 

The subsequent section presents the Texas steel twin tub girder bridge inventory 

and shows distribution of span lengths and curvatures for all STTG bridges.  

3.2. Evaluation of TxDOT Steel Twin Tub Bridge Inventory 

3.2.1. General 

It is important to select the bridges that are representative of existing STTG bridge 

inventory. This selection is done using range of critical parameters that represent current 

 Part of this chapter is reprinted with permission from “Fracture Critical Steel Twin Tub Girder Bridges 

Technical Report” 0-6937-R1 by Hurlebaus S., Mander J., Terzioglu T., Boger N., Fatima A., 2018. Texas 

A&M Texas Transportation Institute, 33-142, Copyright 2018 by Texas A&M Texas Transportation 

Institute  
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STTG bridges in Texas. The critical parameters were identified as span length, radius of 

curvature and continuity based on literature and input from TxDOT. The distribution of 

these three key parameters were investigated while selecting the 15 bridges for the 

parametric study. 

3.2.2. Distribution of Texas STTG Bridges 

The span length is one of the key parameters that can affect post-fracture behavior, overall 

flexural demand, and load distribution. The relatively high flexural strength of steel tub 

girders offers long span ranges up to 500 ft. An efficient lower span length is limited to 

150 ft due to the 5 ft minimum web depth suggestion, which is for providing accessibility 

during inspection. Although very long spans have been achieved, most of the steel twin 

tub bridges are typically between 150 – 300 ft in length. Figure 3.1 presents the histogram 

of maximum span lengths for Texas STTG bridges. Majority of STTG bridges have 

between 150-300 ft span lengths with a median value of 210 ft.  

Figure 3.1. Distribution of Texas STTG Bridges by Maximum Span Length 
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Another important parameter is the horizontal curvature. Although steel tub girders 

can be used for straight bridges, they offer a great advantage for curved bridges due to 

their superior torsional stiffness. They can achieve extremely tight curvatures, up to 

0.0067. The range of horizontal curvature may be considered from tangential to 150 ft 

radius. The flexural bending load demand on the outside girder increases as the curvature 

increases. Therefore, curvatures of STTG bridges were considered as one of the key 

parameters for the bridge selection process. Figure 3.2 shows the distribution of Texas 

STTG bridges by curvature. Most STTG bridges in Texas have curvature values between 

0.0007 and 0.0016 with a mean curvature of 0.00123.  

Figure 3.2. Distribution of Texas STTG Bridges by Curvature 
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The third parameter of importance is continuity, which generally improves residual 

capacity due to structural redundancy inherent to continuous bridges. Most STTG bridges 

are classified as fracture critical based on load-path redundancy which only considers 

lateral load distribution hence, categorizing bridges with less than three girders as fracture 

critical. However, structural redundancy due to continuity can contribute significantly to 

longitudinal distribution of the load hence, improving the flexural capacity. Therefore, 

different numbers of continuous spans including simply supported, two span continuous, 

and three span continuous bridges were considered in order to assess the effect of 

continuity on the level of redundancy. Figure 3.3 provides a histogram for the distribution 

of STTG bridges in terms of number of continuous spans. Most STTG bridges have three 

continuous spans followed by two span continuous bridges.  

Figure 3.3. Distribution of Texas STTG Bridges by Number of Continuous Spans 
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The above listed three key parameters were evaluated to come up with a range of 

radii of curvatures, span lengths, and number of continuous spans that represent most 

Texas STTG bridges. Table 3.1 lists the range of selected parameters that are considered 

for the FEM models for the parametric study.  

Table 3.1 Range of Parameters Considered for the Bridge Selection 

Parameter Range 

Span Length, L 100 – 300 ft 

Curvature, R 0 – 0.006 

Continuity Simple, Two and Three Spans 

3.2.3. Selection of Fifteen Representative Steel Twin Tub Girder Bridges 

The investigation of the histogram for number of continuous spans suggests that majority 

of selected bridges should be three-span continuous followed by two-span continuous and 

simple span bridges. These three groups represent all that is necessary to evaluate the 

structural behavior as they cover simple span, exterior and interior spans of continuous 

bridges. A total of 7 three-span continuous, 5 two-span continuous, and 3 simple span 

bridges were selected based on the distribution of Texas STTG bridges by number of 

spans. 

Span length versus curvature scatter plots were created for simple, two-span, and 

three-span bridges (Figure 3.4, Figure 3.5 and Figure 3.6). The scatter plots were then 

grouped using k-means clustering which groups data points using the squared Euclidean 

distance measured. Clustering scattered data points helps to identify different data groups 
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with multi parameters. The solid red line shows where the span length to radius ratio is 

equal to 0.3 ft. For closed box and tub girders the effect of curvature may be ignored in 

the analysis for determination of the major-axis bending moments and bending shears if 

for all spans the arc span divided by radius is less than 0.3 radians, girders are concentric 

and bearings are not skewed (AASHTO 2014). The black circled points are the selected 

bridges for that specific category. The selection procedure followed two main criteria; (1) 

bridges from different clusters having similar curvature values but different span lengths, 

(2) bridges from same cluster having similar span length but different curvature.

Figure 3.4. Span vs Curvature Scatter of Simple Span STTG Bridges in Texas 
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Figure 3.5. Span vs Curvature Scatter of Two-Span STTG Bridges in Texas 

Figure 3.6. Span vs Curvature Scatter of Three-Span STTG Bridges in Texas 

Figure 3.4 shows the scatter plot with selected bridges for simple span STTG 

bridges. Three simple span bridges were selected for parametric study; one bridge with 

small curvature from the short span cluster, another two bridges with small and large 

curvatures from the long span cluster. Similarly, Figure 3.5 presents the scattered 
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distribution of span length-curvature data and selected bridges for two span STTG bridges. 

A total of five two span bridges were selected for the parametric study; from different span 

length groups having various curvature values. Figure 3.6 presents clustered scatter of 

span-curvature data and selected bridges for three span STTG bridges. Four bridges from 

different span clusters ranging from short to long spans, and another three bridges from 

the medium span cluster having small medium and large curvatures were selected. 

Table 3.2 lists the selected Texas STTG bridges with their span length radius of curvature 

and continuity information. Full plans for all 15 bridges are locates in Appendix A.  

Table 3.2 Main Geometric Properties of Selected Texas STTG Bridges 
Bridge 

No. 
Bridge ID Span 1 (ft) 

Span 2 

(ft) 
Span 3 (ft) 

Radius of 

Curvature (ft) 

1 12-102-3256-01-403 220.5 - - 573.0 

2 12-102-0271-17-530 115.0 - - 1909.9 

3 12-102-3256-01-403 230.0 - - 2207.3 

4 12-102-0271-07-637 132.0 128.2 - 195.0 

5 14-227-0-0015-13-452 140.0 139.6 - 450.0 

6 12-102-0271-07-575 140.0 140.0 - 818.5 

7 12-102-0177-07-394 218.9 189.7 - 763.9 

8 12-102-0271-06-661 265.0 295.0 - 881.5 

9 12-102-0177-07-394 139.5 151.4 125.6 763.9 

10 14-227-0-0015-13-450 148.0 265.0 189.6 716.2 

11 12-102-0271-07-593 223.0 366.0 235.0 818.5 

12 12-102-0271-07-639 140.0 180.0 145.0 225.0 

13 14-227-0-0015-13-452 151.5 190.0 151.5 450.0 

14 18-057-0-0009-11-460 150.0 190.0 150.0 1010.0 

15 12-102-0271-06-689 200.0 295.0 200.0 809.0 
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3.3. Nonlinear Finite Element Model of a Steel Twin Tub Girder Bridges 

3.3.1. Validation of Finite Element Model  

In conjunction with the grillage analysis of the bridges selected from the parametric study, 

an accompanying FEM analysis was conducted by Dr. Tevfik Terzioglu as part of the 

work completed in TxDOT project 0-6937 (Hurlebaus et al. 2018).  

Terzioglu used Abacus to generate a FEM model of the FSEL test bridge in 

TxDOT project 9-5498 (Barnard et al. 2010). The FSEL test bridge was 120 foot long 

twin tub girder bridge, with a deck width of 23 feet 4 inches and a radius of curvature of 

1365 feet. Four different loading conditions were applied to the test bridge. The fist load 

case was a HS-20 truck load with a fully intact tension flange and web. The second load 

was was a HS-20 truck load with a fractured tension flange but intact web. The third load 

case was an HS-20 truck load with fractured tension flange and web. The final load case 

was at ultimate loading conditions. Loads were simulated using concrete girders for load 

cases 1 thru 3 and sand was additionally used in load case 4.  

Elasto-plastic material models were chosen for the for FEM model as to capture 

full material nonlinearity of concrete crushing and steel yielding. Appropriate shear stud 

and haunch constitutive mechanical models were used to accurately model the behavior. 

Compatible finite elements were used to model the various components of the bridge. The 

concrete deck and railing was modeled by three dimensional 8-node linear continuum 

elements (C3D8). Reinforcing bars were modeled using 2-node truss elements (T3D2). 

Steel tub members and intermediate diaphragms were modeled using 8-node quadrilateral 

shell elements (S8R). Internal bracing was modeled using first order three dimensional 
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beam elements (B31). The boundary conditions were simply supported elastomeric 

bearing pads.  

The FEM was validated for load cases 2 thru 4. The results for load case 3 can be 

seen in Figure 3.7. It should be noted that there is close agreement with the FEM model 

and the deflection profile of both the fractured outside girder as well at the intact interior 

girder. In TxDOT report 0-6937 it was concluded that the FEM accurately represented 

the bridge behavior.    
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(a)Fractured East Girder

(b)Intact West Girder

Figure 3.7 Comparison of FEM deflection profile with test results after web 

fracture (Reprinted from Hurlebaus, 2018) 

3.3.2. FEM Parametric Study of Fifteen Bridges 

Terzlioglu generated an FEM model for each of the 15 preselected bridged from 

the TxDOT inventory and obtained the results for the both the intact and complete exterior 

girder failure cases. From the results of the bridge models a redundancy level or 

overstrenght factor was determined for each bridge and is defined as  
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Ω = 𝑅𝑑/𝑄𝑢 (3.1) 

where 𝑅𝑑 = capacity of the damaged bridge, and 𝑄𝑢= factored load demand. The bridge 

can be considered redundant with sufficient reserve capacity when Ω > 1.0. 

HL-93 loading conditions were applied to bridges which consist of 

1.25DL+1.75(HS20+IM)+1.75LL as per AASHTO LRFD Bridge Design Specifications 

(2014) where DL, LL and IM represent dead load, lane load, and impact factor, 

respectively. Failure is defined by two limit states: ultimate limit state and deflection limit 

state. Ultimate limit state is defined by a load at which the fractured bridge drops below 5 

percent of the initial stiffness of the intact bridge. The deflection limit state is defined by 

two different criteria: (1) a cord rotation of 2 degrees for simply supported and interior 

spans; and 3 degrees for exterior spans in the longitudinal direction; and (2) a transverse 

deck rotation of 5 degrees. The lowest of the three failure modes controls. The 

overstrength factors, as determined by FEM, for all the single span, interior spans, and 

exterior spans are located in Table 3.3, Table 3.4, and Table 3.5 respectively.   

Table 3.3 FEM Overstrength Factors for Single Span STTG Bridges (Reprinted 

Hurlebaus et al. 2018) 

ID Span 
R 

(ft) 

L 

(ft) 

B 

(ft) 

S 

(ft) 

5% 

SF 

5° 

Trans. 

2° 

Long. 

0 1 1300 120 23 6.0 0.86 - 0.91 

1 1 573 220 32 9.5 0.88 0.82 0.82 

2 1 1910 115 26 6.1 1.75 1.70 1.65 

3 1 2207 230 39 12.6 0.88 0.85 0.87 

Note: L= length, B=breadth, R=radius of curvature, S=spacing between interior top flanges 
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Table 3.4 FEM Overstrength Factors for Interior Spans of STTG Bridges 

(Reprinted from Hurlebaus et al. 2018) 

ID Span 
R 

(ft) 

L 

(ft) 

B 

(ft) 

S 

(ft) 

5% 

SF 

5° 

Trans. 

2° 

Long. 

9 2 764 151 28 7.0 2.45 2.55 2.50 

10 2 716 265 30 7.7 2.05 1.60 1.45 

11 2 819 366 28 7.0 2.45 1.20 1.55 

12 2 225 180 28 7.6 2.10 2.05 1.80 

13 2 450 190 30 9.3 1.75 - 1.40 

14 2 1010 190 28 6.5 2.00 - 1.80 

15 2 809 295 28 8.0 1.40 1.70 1.50 

Note: L= length, B=breadth, R=radius of curvature, S=spacing between interior top flanges 
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Table 3.5 FEM Overstrength Factor for Exterior Spans of STTG Bridges 

(Reprinted from Hurlebaus et al. 2018) 

ID Span 
R 

(ft) 

L 

(ft) 

B 

(ft) 

S 

(ft) 

5% 

SF 

5° 

Trans. 

2° 

Long. 

4 1 195 132 28 7.6 2.00 2.30 1.65 

4 2 195 128 28 7.6 2.03 - 1.73 

5 1 450 140 30 9.7 1.50 - 1.20 

5 2 450 140 30 9.7 1.50 - 1.20 

6 1 819 140 38 9.8 1.90 2.10 1.80 

6 2 819 140 38 9.8 1.90 2.10 1.80 

7 1 764 219 28 7.4 1.40 1.20 1.20 

7 2 764 190 28 7.4 1.75 - 1.45 

8 1 882 265 28 8.4 0.99 - - 

8 2 882 295 28 8.4 0.88 - 0.91 

9 1 764 140 28 7.4 1.80 2.00 1.70 

9 3 764 126 28 7.4 1.90 2.15 1.80 

10 1 716 148 30 7.7 1.70 - 1.70 

10 3 716 190 30 7.7 1.60 - 1.45 

11 1 819 223 28 7.0 1.60 - 1.70 

11 3 819 235 28 7.0 1.60 1.65 

12 1 225 140 28 7.6 1.90 1.95 1.60 

12 3 225 145 28 7.6 1.90 1.90 1.60 

13 1 450 152 30 9.3 1.50 - 1.00 

13 3 450 152 30 9.3 1.50 - 1.00 

14 1 1010 150 28 6.5 1.80 - 1.65 

14 3 1010 150 28 6.5 1.80 - 1.65 

15 1 809 200 28 8.0 1.80 - 1.70 

15 3 809 200 28 8.0 1.80 - 1.70 

Note: L= length, B=breadth, R=radius of curvature, S=spacing between interior top flanges 
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4. PARAMETRIC STUDY FOR STEEL TWIN TUB GIRDER BRIDGES USING

GRILLAGE METHOD PUSH-DOWN ANALYSIS 

4.1. Introduction 

The task at hand consist of a parametric study involving a selection of 15 preselected 

typical steel twin tub girders (STTG) bridges from the Texas bridge inventory utilizing a 

Grillage Method Push-down Analysis. These 15 bridges are the same bridges evaluated 

using the Finite Element Method (FEM) in Chapter 3. The Grillage method employed was 

verified using the static ultimate load test results of the STTG bridge tested in Texas 

Department of Transportation (TxDOT) research project (Barnard et al. 2010). The 

TxDOT project 9-5498 consisted of testing a full scale fracture critical steel box girder 

bridge under simulated HS-20 truck loading and at ultimate loading with a full depth 

fracture on the exterior girder. 

This task evaluates the performance of existing fracture critical steel twin tub 

girder bridges in the event of a full depth web fracture of one of the girders. The 15 bridges 

that are under evaluation vary with respect to span lengths, degree of curvature, and 

continuity. These variables are considered to be the most critical geometric properties for 

determining the response of a bridge in reference to load distribution between girders. 

Grillage models have been created using the commercial software package 

SAP2000 which is a structural analysis program that utilizes the matrix structural analysis 

 Part of this chapter is reprinted with permission from “Fracture Critical Steel Twin Tub Girder Bridges 

Technical Report” 0-6937-R1 by Hurlebaus S., Mander J., Terzioglu T., Boger N., Fatima A., 2018. Texas 

A&M Texas Transportation Institute, 195-259, Copyright 2018 by Texas A&M Texas Transportation 

Institute 
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approach to solve and evaluate structural engineering problems. All of the Grillage bridge 

models have used nonlinear elasto-plastic material and hinge properties due to the 

nonlinear behavior of the reinforcing bars, steel plate, and concrete during concrete 

crushing and steel yielding under ultimate loading conditions. The Grillage models were 

analyzed under the factored HL93 live loading model. This loading pattern consists of 

HS20 truck loading as well as a uniformly distributed lane load. Per AASHTO LRFD 

Bridge Design Specifications (AASHTO 2017), the load demands were 

1.25DL+1.75(LL+IM), where DL, LL, and IM represent respectively dead load, live load, 

and impact factor. 

The bridges evaluated utilizing the Grillage method were analyzed twice: (1) 

analysis of the bridge with the intact girder condition, (2) analysis of the bridge with full 

depth girder fracture for one of the tub girders. The intact bridge analysis provides 

information about the initial stiffness of the intact bridge as well as the overstrength factor 

for the nonfractured case. The second analysis is for simulating the ultimate load behavior 

when one of the girders are fractured. A predefined overstrength factor was determined 

for both the fully intact case and one fractured girder case to assess the load carrying 

capacity of both cases under critical loading. The Grillage method allows for load 

redistribution from the fractured girder through the lateral deck slab members. 

The following section describes the Grillage method and material models used for 

all evaluated bridges. The third section gives the load displacement results of the Grillage 

models as well as their respective overstrength factor results.  
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4.2. Grillage Method Push-Down Analysis 

4.2.1. Introduction 

The grillage method is a computational variation of the strip method, both of which are 

conservative lower bound solutions. The strip method has been employed by designers 

due to its ability to quickly generate solutions by hand. Like the strip method the grillage 

method models the bridge deck and beam elements as a “grillage” of beams. The 

longitudinal grillage members consists of the steel tub girders, the concrete deck with 

longitudinal reinforcement, and the guardrail. The transverse grillage members are bridge 

deck components with transverse reinforcement. 

The grillage method was originally developed in the 1950’s by Lightfoot and 

Sawko (1959). Created in the primitive days of matrix structural analysis, the grillage 

method was utilized to divide a bridge deck into equivalent longitudinal and transverse 

beam members which resembled a grillage. Due to the increase in technological abilities, 

through programs such as SAP2000, this method has increased in accuracy. Surana and 

Agrawal (1998) studied the grillage method of analysis as it applies to various bridge 

types. It was discovered that, when compared with other method of analysis, including 

FEM, that the grillage method of analysis was an accurate and valid modeling technique. 

Grillage models of the preselected 15 bridges were created and analyzed using the 

structural analysis software SAP2000 version 19 (Computers and Structures 2017). The 

grillage models should capture the constitutive material behavior and boundary condition 

to be able to accurately predict load displacement behavior and the ultimate load capacity 

of the analyzed bridge. For all 15 bridges, the support conditions were modeled using 
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springs with a lateral stiffness of 6 kip/in. and a vertical stiffness of 3050 kip/in. These 

values are conducive with the stiffness values used in the elastomeric bearing pads at the 

support locations in the bridge. Appropriate steel and concrete nonlinear material models 

were used to ensure appropriate modeling of the bridge behavior under the ultimate 

loading conditions.  

4.2.2. Material Models  

Grillage models generated for the 15 bridges in the parametric study were created using 

similar material models utilized in FEM modeling approach. Nonlinear material models 

were used for the Grillage analysis of the bridges due to the concrete crushing and yielding 

of the steel plates and reinforcing bars. The steel model used for both reinforcing bars and 

steel plates assume nonlinear elastic-plastic behavior with strain hardening. The 

mechanical constitutive model of concrete considers nonlinear inelastic behavior up to 

peak stress level without damage mechanics. Therefore it assumes perfectly plastic 

behavior beyond peak compressive and tensile stress.  

4.2.2.1. Steel Material Model  

The built-up plate components of the STTG bridges are comprised of grade 50 structural 

steel. The constitutive behavior of both the steel members and reinforcing bars use the 

classical metal plasticity models with strain hardening. The nonlinear steel models assume 

a perfectly plastic behavior once the yield stress is reached. The reinforcing bar in both 

the longitudinal and transverse directions as well as railings consist of grade 60 ASTM 

A615 steel.  
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a) Reinforcing Bar b) Steel Plate

Figure 4.1 Constitutive Model for Steel Members (from SAP2000) 

Figure 4.1 shows the stress-strain relationship of both the plate steel and 

reinforcing bars. Both steel plate and rebar constitutive behavior were obtained from 

material test conducted on actual coupons as part of  TxDOT project 9-5498 (Barnard et 

al. 2010).  

4.2.2.2. Concrete Material Model 

The constitutive concrete behavior was defined using the Kent and Park (1971) model, the 

same model used in the FEM analysis with a design strength of 4000 psi. After reaching 

ultimate compressive and tensile forces the concrete behavior is assumed to be perfectly 

plastic.  

Figure 4.2 shows the stress-strain behavior of the concrete used for the grillage 

models. The tensile strength of the concrete was calculated using the empirical equation 

in AASHTO (2017) Article 5.4.2.6 as: 

𝑓𝑟 = 0.2√𝑓′𝑐 (4.1)
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where, 𝑓𝑟 = the modulus of rupture (ksi) and 𝑓′𝑐  = compressive strength of concrete (ksi). 

The modulus of elasticity of concrete for different was calculated using an empirical 

equation from AASHTO (2017) Article 5.4.2.4 as: 

𝐸𝑐 = 33000𝐾1𝑤𝑐
1.5√𝑓′𝑐 (4.2)

where, 𝐾1 =correction factor for aggregate source and assumed to be 1.0 unless 

determined by physical test; 𝑤𝑐 =unit weight of concrete (kcf), 0.145 is assumed for 

normal weight concrete; 𝑓′𝑐 =compressive strength of concrete (ksi).  

Figure 4.2 Constitutive Model of Concrete (from SAP2000) 

The constitutive model from SAP2000 indicates that beyond compressive crushing 

and tensile rupturing the strength is maintained. This behavior was utilized to be consistent 

with the FEM modeling approach and to avoid convergence issues in SAP2000. 
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4.2.3. Grillage Beam Elements 

Hambly and Pennells (1975) and Barker and Puckett (2007) have established guidelines 

for the construction and location placement of beam elements. It is recommended that for 

each grillage member to take on the same bending and torsional properties of their 

representative bridge sections. For the case of slab-on-girder bridges, the longitudinal 

beam element should be placed along the centerline of the girder. Since the twin tub 

girders are so wide, in this grillage analysis they were divided in half and the centerline of 

the top flange was used as the centerline for the placement of grillage elements.  This 

maintains the stiffness at the appropriate location within the bridge structure, and 

appropriate load distribution. Lateral beam members should be placed at appropriate 

locations. Grillage members should be positioned in locations of high stress and forces. 

High force and stress locations could include interior and exterior supports and point load 

locations. In order to assure accurate load distribution it is important that the longitudinal 

and transverse members are equally gaged in both directions. 

 The exterior longitudinal members (Figure 4.3a) consist of the guardrail, the deck 

from the outside edge to the center of the tub girder including corresponding reinforcing 

bars, and half of the tub girder. The interior longitudinal members (Figure 4.3b) consists 

of the deck from the center of the tub girder to the centerline of the bridge with 

corresponding reinforcing bars and half of the tub girder. The transverse members (Figure 

4.4a-b) consist of deck slab and transverse reinforcing bars. The longitudinal members are 

placed along the centerline of each of the four top flange members of the tub girders. The 
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transverse members are placed at 7 ft increments along the interior with varying spacing 

at the end supports. Figure 4.5 is a representative grillage schematic of a grillage model.  

a) Exterior Longitudinal Member b) Interior Longitudinal Member

Figure 4.3 Representative Longitudinal Grillage Members 
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a) Exterior Transverse Member b) Interior Transverse Member

Figure 4.4 Representative Transverse Grillage Members 

Figure 4.5 Representative Grillage Schematic 



62 

4.2.4. Grillage Plastic Hinges 

In order to capture the nonlinear behavior of the bridge at ultimate loading conditions the 

nonlinear static analysis approach, which is also known as “push down analysis”, was 

used. Incorporating this approach reduces the uncertainty and conservatism inherently 

existing in elastic analysis. Since the bridge superstructure is modeled as grillage of beam 

elements the inelastic behavior is achieved by using plastic hinges at the anticipated hinge 

locations. The hinges used are moment controlled (M3) in the global Z (or gravitational) 

direction. Longitudinal and transverse hinges were developed using the moment curvature 

responses of the individual cross-sections. The individual cross-sections were generated 

using the section designer tool in SAP2000 which allows the user to combine the concrete, 

reinforcing bars, and steel plates into one composite grillage member. Once the member 

is created, SAP2000 has a moment curvature feature within the section designer which 

generates the moment curvature response of the composite section. In the case of the 

fractured longitudinal plastic hinge the bottom flange and web were removed prior to 

generating the moment curvature diagram.  

The length of the plastic hinge was taken to be half of the depth of the member 

both in the transverse and longitudinal directions. Two of the most prominent hinge length 

expressions for reinforced concrete beam elements in flexure were developed by Corley 

(1966) and Mattock (1967) represented as: 

𝑙𝑝 = 0.5𝑑 + 0.5√𝑑(𝑧/𝑑) (4.3) 

𝑙𝑝 = 0.5𝑑 + 0.05(𝑧) (4.4) 
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where, 𝑙𝑝 = plastic hinge length, 𝑑 = member depth, and 𝑧 = distance from hinge to node 

location. For the purposes of this section the hinge is located at the point of contra flexure 

therefore driving the value of 𝑧 to 0. The remaining portions of both expressions reduces 

to half the member depth value.  

A representative external longitudinal intact plastic hinge is shown in Figure 4.6. 

For convergence requirements, once the maximum moment value was reached, a perfectly 

plastic assumption was made and the maximum moment was maintained for all further 

rotation. Perfectly plastic assumption is acceptable as the aim was to identify the ultimate 

load, not the post peak load degradation of the structure. 

Figure 4.6 Representative Plastic Hinge Property (SAP2000) 
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For the longitudinal members the hinges were placed at both ends of the 

longitudinal beam elements. For the transverse members the hinges were placed at the 

edge of the top flanges or a distance of half a flange length from each node. All plastic 

hinge properties are located in Appendix B. 

4.2.5. Simulating HL93 Loading  

In simulating the HL93 loading it was critical to place the HS20 truck load and the uniform 

lane load at the appropriate critical locations shown in Figure 4.7. The interior transverse 

grillage beams were placed at 7 ft increments to have a grillage member at locations 

corresponding to the axles of HS20 truck that has axle spacing of 14 ft. The center axle of 

the truck load was placed at the midspan. HS20 truck consists of 32 kips middle and rear 

axles and 8 kips front axle for a total of 72 kips. The distance between wheel lines of the 

truck is 6 ft.  

When analyzing two lane bridges the first lane, which is 12 ft wide, was defined 

as close as possible to the outside edge of the curved bridge to create most adverse loading 

condition when outside girder has full depth web fracture. AASHTO LRFD (2017) 

requires that a design lane should be at least 2 ft away from the nominal rail face which is 

generally one foot away from the edge of the deck. To create most adverse loading 

conditions both the HS20 truck and the uniform lane load was placed starting at the outside 

edge of the design lane. For the first lane loading, the first wheel line of the truck was 

placed at 3 ft from the edge of the deck (at the outside edge of the first lane) and per the 

HS20 definition the second wheel line is located 6 ft from the first wheel line. The standard 

uniform lane load is distributed to 10 ft width and starts at 3 ft from the outside edge of 
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the deck and ends at 13 ft form the deck edge. Therefore the uniform lane load for the first 

lane was modeled by a line load of 0.64 kip/ft along the longitudinal members located at 

8 ft from the outer edge of the bridge. Since the line load generally occurred between two 

grillage members, an equivalent load was distributed appropriately to each of the grillage 

members. The second lane loading is the same as the first one, however, it begins at the 

edge of the second lane, which is 15 ft away from the outer edge of the deck.  

Figure 4.7 HL93 Loading Diagram for Two-Lane Loaded Case 

Each bridge was first analyzed in its intact condition with no fractures. 

Subsequently, the fractured model for each bridge was analyzed. Load steps were 

generated for two lanes loaded case as follow: 1.25DL+1.75LL+1.75(HS20+IM) where, 

DL is dead load, LL is lane load, IM = 33% impact load, and HS20 is the HS20 truck load. 

The intact bridge was analyzed first. The grillage members were generated in 

SAP2000’s section designer. Using the moment curvature feature within the section 

designer moment curvature output was produced for each of the transverse and 
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longitudinal members in the bridge. Plastic hinges were developed for each of the intact 

members based on the moment curvature criteria produced from the section designer. The 

longitudinal and transverse grillage members were then arranged in a grillage array that 

adequately represented the geometry for the bridge. End spring supports were then added 

to represent the elastomeric bearing pads. Appropriate section hinges were added to each 

node, or crossing of longitudinal and transverse members. HS20 truck loads and lane loads 

were appropriately defined and assigned to the correct grillage elements. The standard 

load case was then defined as 1.25DeadLoad+1.75LaneLoad+2.33HS20Load. The first 

loading step began at zero stress state, each additional load case began at the final loading 

and displacement of the preceding load case. Each load step was applied to the bridge in 

20 increments. Load steps were continually applied to the bridge until the stiffness reduces 

to 5% of the initial stiffness of the intact bridge. 

After the analysis of the intact bridge, the bridge in its fractured state was 

evaluated. Once the analysis of the intact bridge was complete, a copy of both the exterior 

and interior longitudinal sections at midspan were created. The bottom flanges and webs 

were removed in both sections to mimic a full web fracture. Using section designer, 

moment curvature plots were generated for each of the sections as well as compatible 

hinges. At midspan of the intact bridge, the exterior and interior longitudinal hinges were 

then replaced, on the heavily loaded side of the bridge, with the representative fractured 

hinges. The bridge was then analyzed under the same loading sequence as the intact bridge 

starting from a state of zero stress with continuous additions of the standard load case in 

20th increments until the stiffness was reduced to 5% of the stiffness of the intact bridge, 
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the transverse rotation was greater than 5°, or the longitudinal rotation for the exterior 

spans was greater than 3° and interior spans is greater than 2°. 

SAP2000 has a load case feature called staged loading which allow certain loads 

to be applied to certain members during various stages of construction. An example of this 

would be applying the dead load of the tub girder and the weight of the concrete slab to 

only the tub girder of the composite member, while applying the live loads and impact 

loads to the composite deck and tub girder member. Staged loading would have allowed 

for a more accurate representation as to the true load displacement nature of both the intact 

and fractured bridge spans. However, this could not be utilized in the fractured bridge case 

due to the fact that staged loading does not allow for frame section or plastic hinge 

substitutions during mid loading. For comparative purposes of the intact and fractured 

bridges were loaded from a zero stress state in complete composite action.

4.3. Grillage Analysis of selected STTG Bridges 

In order to successfully gage the redundancy of the 15 STTG bridges it was important to 

establish a quantitative measurement of the remaining strength in the bridge beyond the 

factored design load demand. An overstrength factor was established to measure the 

residual strength and is defined as: 

𝜴 = 𝑹𝒅/𝑸𝒖 (4.5) 

where, 𝑅𝑑 =capacity of the damaged bridge, and 𝑄𝑢 =factored load demand. Bridges 

where, 𝛺 > 1.0, are considered redundant and have enough reserve capacity post fracture. 

In this section, redundancy levels are established via the Grillage results using design 

material properties. The loading condition, as per AASHTO LRFD Bridge Design 
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Specifications (AASHTO 2017), used was 1.25DL+1.75(HS20+IM)+1.75LL, where DL, 

LL, and IM are dead load, uniform lane load, and impact factor, respectively.  

4.3.1. Grillage Analysis of Bridge 0- FSEL: TxDOT Project # 0-6937 

FSEL Tests Bridge, included in TxDOT project number 0-6937, is a simple span straight 

bridge used for research purposes and for method verification earlier on this project. The 

FSEL test bridge has span length of 120 ft, a bridge width of 23 ft 4 in, and an 8 inch deck. 

Full bridge details are located in Table 4.1 and Table 4.2. The FSEL test bridge was 

evaluated using the established grillage method. It should be noted that, due to the narrow 

road width, only one lane of HL93 loading was use to evaluate the post fracture 

redundancy.   

Table 4.1 Geometric Details of Steel Tub Girders for Bridge FSEL (0) 

Location ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-120 12 0.625 57 0.5 47 0.75 



69 

Table 4.2 General Geometric Properties of Bridge FSEL (0) 

Location Parameter Description/Value 

Bridge 

Length, ft 120 

Spans, ft 120 

Radius of Curvature, ft - 

Width, ft 23.333 

Deck 

Thickness, in. 8 

Haunch, in. 4 

Rail Type T501 

Rebar 

# of Bar Longitudinal Top Row (#4) 32 

# of Bar Longitudinal Bottom Row 

(#5) 
30 

Transverse Spacing Top Row (#5) 6 

Transverse Spacing Bottom Row (#5) 6 

Figure 4.8 depicts the displacement profile with activated hinges of Bridge FSEL 

(0).  Figure 4.9 shows the grillage analysis results of the FSEL Bridge. The solid lines 

indicate the behavior of the outside girder and the dashed lines indicate the behavior of 

the inside girder. The blue color represents the load displacement results for fractured 

model and the color green represents the load-displacement results of the intact model. 

The ultimate load capacity of the fracture bridge model is indicated by a blue diamond 

symbol. The ultimate load capacity of the bridge is defined as the lowest of the following: 

when the stiffness of the bridge falls below 5% of the initial stiffness of the intact outside 

girder, or the transverse rotation is greater than 5°, or the longitudinal rotation is greater 

than 2°.  

The fractured FSEL Bridge fails under HL93 loading at an overstrength factor of 

1.07 via longitudinal rotation. While the intact bridge fails under stiffness control at an 

overstrength value of 2.55.  
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.8 Grillage Deflection Profile of Bridge FSEL (0) with Activated Hinges 

(a) Load-displacement (b) Deck rotations
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.9 Grillage Analysis Results of Bridge FSEL (0) 
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4.3.2. Grillage Analysis of Bridge 1-NBI #12-102-3256-01-403  

Simple span, 220.5 ft long, 32 ft 5 in. wide Bridge 1 is primarily supported by two steel 

tub girders, built along the IH 10 connector in 2007, located in Houston, TX, and has 8 

in. thick deck. Table 4.3 and Table 4.4 contain the necessary geometric information for 

generating an adequate Grillage model. 

Table 4.3 Geometric Details of Steel Tub Girders for Bridge 1 

Location 

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-52 18 1.50 84 0.625 72 1.00 

52-167 18 2.25 84 0.625 72 1.50 

167-220 18 1.50 84 0.625 72 1.00 

Table 4.4 General Geometric Properties of Bridge 1 

Location Parameter Description/Value 

Bridge 

Location Harris County, I610 

Year Designed/Year Built 2004/2007 

Design Load HS20 

Length, ft 220.46 

Spans, ft 220.46 

Radius of Curvature, ft 572.96 

Deck 

Width, ft 32.417 

Thickness, in. 8 

Haunch, in. 5 

Rail Type SSTR 

Rebar 

# of Bar Longitudinal Top Row (#5) 38 

# of Bar Longitudinal Bottom Row (#5) 44 

Transverse Spacing Top Row (#5) in. 5 

Transverse Spacing Bottom Row (#5) in. 5 
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Figure 4.10 shows the grillage deflection profile of Bridge 1 with activated plastic 

hinges at the ultimate loading condition. Figure 4.11 depicts the load displacement plot at 

of the bridge at the center of both the interior and exterior girders.  

The intact bridge has an overstrength factor of 1.00 and the fractured bridge has 

an overstrength factor of 0.21, controlled by longitudinal rotation. Under the fractured 

condition, Bridge 1 is not considered redundant due to its overstrength factor being less 

than 1.  

Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.10 Grillage Deflection Profile of Bridge 1 with Activated Hinges 
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(a) Load-displacement (b) Deck rotations
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.11 Grillage Analysis Results of Bridge 1 

4.3.3. Grillage Analysis of Bridge 2-NBI #12-102-0271-17-530 

Bridge 2 is a simple span bridge 115 ft in length, with a deck width of 26.6 ft and thickness 

of 8 in. built on the I160 connector in 2004 located in Harris County. The nonlinear model 

for Bridge 2 was developed using a similar process as Bridge 1. Table 4.5 and Table 4.6 

contain the relative geometry information for Bride 2 necessary to create a grillage model. 

Table 4.5 Geometric Details of Steel Tub Girders for Bridge 2 

Location 

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-115 18 1.00 79 0.625 50 1.00 
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Table 4.6 General Geometric Properties of Bridge 2 

Location Parameter Description/Value 

Bridge 

Location Harris County, I610 

Year Designed/Year Built 2002/2004 

Design Load HS25 

Length, ft 115 

Spans, ft 115 

Radius of Curvature, ft 1909.86 

Deck 

Width, ft 26.625 

Thickness, in. 8 

Haunch, in. 4 

Rail Type SSTR 

Rebar 

# of Bar Longitudinal Top Row (#5) 40 

# of Bar Longitudinal Bottom Row (#5) 32 

Transverse Spacing Top Row (#5) in. 5 

Transverse Spacing Bottom Row (#5) in. 5 

Figure 4.12 depicts the deflection profile of Bridge 2 at the ultimate loading 

condition with activated hinges. Figure 4.13 illustrates the load displacement along the 

centerline of the girders.  

The fractured grillage model of Bridge 2 was ran with a full web fracture at 

midspan of the bridge. Under HL93 loading, Bridge 2 has an intact overstrength factor of 

3.42 and a fractured overstrength factor of 1.11, controlled by stiffness reduction. Since 

the overstrength value is greater than 1, Bridge 2 is considered to be redundant however, 

there is a significant strength reduction caused by the fracture of the outside girder.    
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 
Figure 4.12 Grillage Deflection Profile of Bride 2 with Activated Hinges 

(a) Load-displacement (b) Deck rotations
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.13 Grillage Analysis Results of Bridge 2 
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4.3.4. Grillage Analysis of Bridge 3-NBI #12-102-0508-01-294 

Bridge 3 has a span length of 230 ft with a roadway width of 38.8 ft and a 9 in. deck slab 

thickness and was built in 2002 in Harris County. Table 4.7 and Table 4.8 both contain 

geometric information of Bridge 3 which is necessary to create an accurate grillage 

model. The processes by which the grillage model was created is same by which 

preceding bridges were built.  

Table 4.7 Geometric Details of Steel Tub Girders for Bridge 3 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-21 24 1.5 102 0.75 63.5 1.25 

21-42 24 2.5 102 0.75 63.5 1.75 

42-185 24 3 102 0.75 63.5 2.75 

185-207 24 2.5 102 0.75 63.5 1.75 

207-230 24 1.5 102 0.75 63.5 1.25 



77 

Table 4.8 General Geometric Properties of Bridge 3 

Location Parameter Description/Value 

Bridge 

Location Harris County, FWY 

Year Designed/Year Built 1997/2002 

Design Load HS20 

Length, ft 230 

Spans, ft 230 

Radius of Curvature, ft 2207.3 

Deck 

Width, ft 38.833 

Thickness, in. 9 

Haunch, in. 4 

Rail Type T-501 

Rebar 

# of Bar Longitudinal Top Row (#5) 46 

# of Bar Longitudinal Bottom Row (#5) 64 

Transverse Spacing Top Row (#5), in. 5 

Transverse Spacing Bottom Row (#5), in. 5 

Figure 4.14 shows the deflection profile of Bridge 3 along with the activated plastic 

hinges. The load displacement results from Bridge 3 are located in Figure 4.15. Post 

fracture, the bridge has an overstrength factor of 0.16 controlled by transverse rotation, 

and varies significantly from the intact overstrength factor of 2.00. In its fractured sate, 

Bridge 3 has an overstrength less than 1 therefore not a redundant structure.    
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.14 Grillage Deflection Profile for Bridge 3 with Activated Hinges 

(a) Load-displacement (b) Deck rotations
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.15 Grillage Analysis Results of Bridge 3 
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4.3.5. Grillage Analysis of Bridge 4-NBI #12-102-0271-07-637 

Bridge 4 is a two span continuous STTG bridge built in 2007 in Harris County. Span 1 of 

Bridge 4 is 132 ft long and Span 2 is 128 ft long. Bridge 4 has a deck width of 28.4 ft and 

a thickness of 8.5 in. Table 4.9 and Table 4.10 give the geometric properties for Bridge 4. 

It should be noted that although the top and bottom flanges do not vary in width they do 

vary in thickness. It should also be noted that over the intermediate support and negative 

moment region there is additional top reinforcing bar.  

Table 4.9 Geometric Details of Steel Tub Girders for Bridge 4 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-82 20 1.00 54 0.5 72 0.875 

82-110 20 .50 54 0.5 72 1.750 

110-130 20 2.75 54 0.5 72 1.750 

130-150 20 2.75 54 0.5 72 1.750 

150-177 20 1.50 54 0.5 72 1.750 

177-260 20 1.00 54 0.5 72 0.875 

Figure 4.16 shows the deflection profile of Bridge 4 with fracture at 0.4*L of Span 

2. Figure 4.17 and Figure 4.18 shows the load vs. displacement diagram for Spans 1 and

2 respectively of Bridge 4. Following a 0.4*L fracture the overstrength factors are 1.30 

for Span 1 and 1.32 for Span 2. Prior to fracture Span 1 has an overstrength factor of 2.60 

and Span 2 has an overstrength factor of 2.88. Under HL93 loading both spans are 

redundant under the fractured condition and are controlled by longitudinal rotation. 
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Table 4.10 General Geometric Properties of Bridge 4 

Location Parameter Description/Value 

Bridge 

Location Harris County, FWY 

Year Designed/Year Built 2004/2007 

Design Load HS25 

Length, ft 260.27 

Spans, ft 132.03, 128.24 

Radius of Curvature, ft 195 

Deck 

Width, ft 28.417 

Thickness, in. 8.5 

Haunch, in. 3.5 

Rail Type SSTR 

Rebar 

# of Bar Longitudinal Top Row (#5) 38 

# of Bar Longitudinal Bottom Row (#5) 30 

# of Bar Longitudinal Top Row (#5) @support 78 

# of Bar Longitudinal Bottom Row (#5) @support 30 

Transverse Spacing Top Row (#5), in. 5 

Transverse Spacing Bottom Row (#5), in. 5 
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.16 Grillage Deflection Profile for Span 2 of Bridge 4 with Activated 

Hinges 

(a) Load-displacement (b) Deck rotations
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.17 Grillage Analysis Results of Bridge 4-Span 1 
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(a) Load-displacement (b) Deck rotations
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.18 Grillage Analysis Results of Bridge 4-Span 2 

4.3.6. Grillage Analysis of Bridge 5-NBI #14-227-0-0015-13-452 

Bridge 5 was built in 2002 in Travis County along I-35. It is a continuous two-span twin 

tub girder bridge. The first span of Bridge 5 has a span length of 140 ft with the second 

span length of 139.6 ft. The bridge deck is 30 ft wide with a thickness of 8 in. Table 4.11 

and Table 4.12 contain the geometric properties of Bridge 5 needed to construct an 

appropriate grillage model. Note that top flange, web and bottom flange thickness as well 

as the rebar configuration change along the length.  
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Table 4.11 Geometric Details of Steel Tub Girders of Bridge 5 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-105 18 1.00 54 0.5 56 0.75 

105-122 18 1.00 54 0.5625 56 1.250 

122-140 18 1.75 54 0.5625 56 1.250 

140-157 18 1.75 54 0.5625 56 1.250 

157-174 18 1.57 54 0.5625 56 1.250 

174-192 18 1.00 54 0.5625 56 0.75 

192-280 18 1.00 54 0.5 56 0.75 

Figure 4.19 shows the deflection profile of Span 1 of Bridge 5. Figure 4.20 depicts 

the load-displacement results for Spans 1 and 2 of Bridge 5. Prior to fracture, Bridge 5 has 

an overstrength factor of 2.15. With a controlling fractured overstrength value of 1.10, 

Bridge 5 is considered redundant. Since the bridge contained spans of almost equal 

lengths, there was no need to run a second analysis on Span 2. The fracture failure of 

Bridge 5 is controlled by longitudinal rotation.  



84 

Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.19 Grillage Deflection Profile for Span 1 of Bridge 5 with Activated 

Hinge 

Table 4.12 General Geometric Properties of Bridge 5 

Location Parameter Description/Value 

Bridge 

Location Travis County, I35 

Year Designed/Year Built 1998/2002 

Design Load HS20 

Length, ft 279.58 

Spans, ft 140, 139.58 

Radius of Curvature, ft 450 

Deck 

Width, ft 30 

Thickness, in. 8 

Haunch, in. 4 

Rail Type T4(S) 

Rebar 

# of Bar Longitudinal Top Row (#4) 41 

# of Bar Longitudinal Bottom Row (#5) 36 

# of Bar Longitudinal Top Row (#4) @support 41 

# of Bar Longitudinal Top Row (#5) @support 40 

# of Bar Longitudinal Bottom Row (#5) @support 36 

Transverse Spacing Top Row (#5), in. 5 

Transverse Spacing Bottom Row (#5), in. 5 
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(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.20 Grillage Analysis Results of Bridge 5-Spans 1&2 

4.3.7. Grillage Analysis of Bridge 6-NBI #12-102-0271-07-575 

Bridge 6 is a two-span continuous twin tub girder bride located in Harris County 

constructed along IH 10 in 2005. Both spans of Bridge 6 have a length of 140 ft, and it has 

a deck width of 30 ft with a thickness of 8.25 in. Table 4.13 contains the geometric details 

of the steel tubs. It should be noted that along the length of the girder the top flange 

thickness changes. Table 4.14 provides general information about the overall geometric 

properties of the bridge. Bridge 6 was created using the same principles as all the 

preceding bridges.  
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Table 4.13 Geometric Details of Steel Tub Girders of Bridge 6 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-110 18 1.000 76 0.6875 60 1.000 

110-130 22 1.000 76 0.6875 60 1.875 

130-150 22 1.875 76 0.6875 60 1.875 

150-170 22 1.000 76 0.6875 60 1.875 

170-280 18 1.000 76 0.6875 60 1.000 

Table 4.14 General Geometric Properties of Bridge 6 

Location Parameter Description/Value 

Bridge 

Location 
Harris County, 

IH10 

Year Designed/Year Built 2003/2005 

Design Load HS25 

Length, ft 280 

Spans, ft 140,140 

Radius of Curvature, ft 818.51 

Deck 

Width, ft 38.417 

Thickness, in. 8.25 

Haunch, in. 4.5 

Rail Type SSTR 

Rebar 

# of Bar Longitudinal Top Row (#5) 54 

# of Bar Longitudinal Bottom Row (#5) 48 

# of Bar Longitudinal Top Row (#5) @support 99 

# of Bar Longitudinal Bottom Row (#5) @support 48 

Transverse Spacing Top Row (#5), in. 4 

Transverse Spacing Bottom Row (#5), in. 4 

Figure 4.21 depicts the deflection profile of Spans 1&2 of Bridge 6 under ultimate 

loading condition with activated plastic hinges. Figure 4.22 shows the load deflection data 

at 0.4*L of Bridge 6. Both spans of Bridge 6 have an intact overstrength factor of 3.38. 

Post fracture of the outside girder, the overstrength factor is 1.43.  Yet, the fracture 
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overstrength factor is still greater than 1. This implies that the bridge is redundant and fails 

under the stiffness criteria. 

Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.21 Grillage Deflection Profile for Spans 1 & 2 of Bridge 6 with Activated 

Hinges 
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(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.22 Grillage Analysis Results of Bridge 6-Spans 1&2 

4.3.8. Grillage Analysis of Bridge 7-NBI #12-102-0177-07-394 

Bridge 7 is a two span continuous twin tub bridge with two spans of length 219 ft and 190 

ft, built in 2004 along IH10 in Harris County. This bridge has an overall deck width of 

28.4 ft and a thickness of 8 in. Table 4.15 contains the geometric information for the steel 

tub girder. It should be noted that the top and bottom flanges change thickness along length 

of the girder as well as the top flange width. Further geometric details of Bridge 7 are 

located in Table 4.16. This table includes details of the concrete deck including reinforcing 

bars.    

Figure 4.23 shows the grillage profile of Bridge 7 under ultimate loading condition 

on Span 2 with a fracture located midspan of Span 2 with activated plastic hinges. Figure 
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4.24 and Figure 4.25 contain the load displacement results for both Spans 1 and 2, 

respectively for Bridge 7. 

Table 4.15 Geometric Details of Steel Tub Girders of Bridge 7 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-17 20 1.100 63 0.625 60 1.000 

17-141 20 2.360 63 0.625 60 2.362 

141-162 20 1.770 63 0.625 60 1.772 

162-193 30 1.770 63 0.625 60 1.772 

193-219 30 3.150 63 0.625 60 3.150 

219-247 30 3.150 63 0.625 60 3.150 

247-292 30 1.770 63 0.625 60 1.772 

292-381 20 1.100 63 0.625 60 1.102 

381-408 20 1.100 63 0.625 60 1.000 
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Table 4.16 General Geometric Properties of Bridge 7 
Location Parameter Description/Value 

Bridge 

Location Harris County, IH10 

Year Designed/Year Built 2002/2004 

Design Load HS20 

Length, ft 408.62 

Spans, ft 218.92,189.7 

Radius of Curvature, ft 763.96 

Deck 

Width, ft 28.417 

Thickness, in. 7.9 

Haunch, in. 5.5 

Rail Type T501 

Rebar 

# of Bar Longitudinal Top Row (#5) 30 

# of Bar Longitudinal Bottom Row (#5) 40 

# of Bar Longitudinal Top Row (#5) @support 59 

# of Bar Longitudinal Bottom Row (#5) @support 40 

Transverse Spacing Top Row (#5), in. 6 

Transverse Spacing Bottom Row (#5), in. 6 

Span 1 and 2 have intact overstrength factors of 1.85 and 2.15. Span 1 has a 

fractured overstrength factor of 0.94, and Span 2 has a fractured overstrength factor of 

1.25. Span 1 having an Ω less than 1 is not considered redundant but, Span 2 is redundant 

post fracture. Both Span 1 and Span 2 fail due to excess longitudinal rotation. 
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.23 Grillage Deflection Profile for Span 2 of Bridge 7 with Activated 

Hinges 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.24 Grillage Analysis Results of Bridge 7-Span 1 
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(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.25 Grillage Analysis Results of Bridge 7-Span 2 

4.3.9. Grillage Analysis of Bridge 8-NBI #12-102-0271-06-661 

Bridge 8 is a two span twin tub girder continuous bridge built in Harris County along IH 

10 in 2011. Bridge 8 is composed of a 265 ft span and a 295 ft span with a 28.4 ft wide 

and 8 in. thick deck. Table 4.18 contains the geometric information for the steel tub portion 

for Bridge 8. It should be observed that the top flange and bottom flange of the tubs vary 

with thickness along the length of the girder. Table 4.17 provides further geometric 

information for Bridge 8 including, concrete deck information and reinforcing bar.  
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Table 4.17 General Geometric Properties of Bridge 8 

Location Parameter Description/Value 

Bridge 

Location Harris County, IH10 

Year Designed/Year Built 2011/NA 

Design Load NA 

Length, ft 560 

Spans, ft 265, 295 

Radius of Curvature, ft 881.47 

Deck 

Width, ft 28.417 

Thickness, in. 8 

Haunch, in. 4 

Rail Type SSTR 

Rebar 

# of Bar Longitudinal Top Row (#5) 38 

# of Bar Longitudinal Bottom Row (#5) 38 

# of Bar Longitudinal Top Row (#5) @support 76 

# of Bar Longitudinal Bottom Row (#5) @support 38 

Transverse Spacing Top Row (#5), in. 5 

Transverse Spacing Bottom Row (#5), in. 5 

Figure 4.26 depicts the grillage displacement profile of a fractured Span 1 under 

ultimate loading conditions. Figure 4.27 and Figure 4.28 contain the load vs. displacement 

behavior of Span 1 and Span 2. Span 1 has an intact overstrength factor of 1.75 and a 

fractured overstrength factor of 0.88. Span 2 has an intact overstrength factor of 1.45 and 

a fractured overstrength factor of 0.60.  Both spans do not exhibit redundant behavior 

having controlling overstrength factors less than 1, and are controlled by transverse and 

longitudinal rotation.   
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Table 4.18 Geometric Details of Steel Tub Girders of Bridge 8 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-30 24 1.25 93 0.75 53.5 1.250 

30-71 24 1.50 93 0.75 53.5 1.500 

71-142 24 1.50 93 0.75 53.5 2.000 

142-183 24 1.50 93 0.75 53.5 1.500 

183-214 24 1.25 93 0.75 53.5 1.500 

214-234 24 2.00 93 0.75 53.5 2.000 

234-307 24 2.50 93 0.75 53.5 2.500 

307-338 24 1.25 93 0.75 53.5 1.500 

338-370 24 1.50 93 0.75 53.5 1.500 

370-391 24 1.50 93 0.75 53.5 2.000 

391-496 24 2.00 93 0.75 53.5 2.500 

496-528 24 1.50 93 0.75 53.5 2.000 

528-560 24 1.25 93 0.75 53.5 1.250 

Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.26 Grillage Deflection Profile for Span 2 of Bridge 8 with Activated 

Hinges 
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(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.27 Grillage Analysis Results of Bridge 8-Span 1 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.28 Grillage Analysis Results of Bridge 8-Span 2 
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4.3.10. Grillage Analysis of Bridge 9-NBI #12-102-0177-07-394 

The first three span continuous bridge evaluated in this study is Bridge 9. Bridge 9 has 

spans of length 139.5 ft, 151.4 ft, and 125.5 ft. The overall deck width is 28.4 ft wide with 

a thickness of 8 in. It should be noted that Bridge 9 is the in the same segment of bridges 

which contain Bridge 7. Table 4.19 and Table 4.20 contain relevant geometric properties 

to produce a grillage model for Bridge 9. It should be noted that the top and bottom flange 

thicknesses change along the length of the tub girder.   

Table 4.19 General Geometric Properties of Bridge 9 

Location Parameter Description/Value 

Bridge 

Location Harris County, IH10 

Year Designed/Year Built 2002/2004 

Design Load HS20 

Length, ft 416.66 

Spans, ft 139.5,151.44,125.62 

Radius of Curvature, ft 763.93 

Deck 

Width, ft 28.417 

Thickness, in. 8 

Haunch, in. 4 

Rail Type T501 

Rebar 

# of Bar Longitudinal Top Row (#5) 30 

# of Bar Longitudinal Bottom Row (#5) 40 

# of Bar Longitudinal Top Row (#5) @support 59 

# of Bar Longitudinal Bottom Row (#5) 

@support 
30 

Transverse Spacing Top Row (#5), in. 5 

Transverse Spacing Bottom Row (#5), in. 5 

Figure 4.29 depicts the displacement profile of Bridge 9 with HL93 loading on the 

fractured Span 2. Figure 4.30, Figure 4.31, and Figure 4.32 depict the load displacement 
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results of all three spans in Bridge 9. Span 1 has an intact overstrength factor of 2.82 and 

a fractured overstrength factor of 1.35. Span 2 has an intact overstrength factor of 3.10 

and a fractured factor of 2.10. Span 3 has an intact overstrength factor of 3.05 and a 

fractured overstrength factor of 1.53. All spans of Bridge 9, even with the exterior girder 

fractured, have overstrength factors greater than 1 and considered to be redundant and are 

controlled by stiffness. 

Table 4.20 Geometric Details of Steel Tub Girders of Bridge 9 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-104 20 1.10 63 0.625 59 1.000 

104-127 20 1.10 63 0.625 59 1.250 

127-152 20 1.58 63 0.625 59 1.500 

152-177 20 1.10 63 0.625 59 1.250 

177-240 20 1.10 63 0.625 59 1.000 

240-265 20 1.10 63 0.625 59 1.250 

265-278 20 1.10 63 0.625 59 1.500 

278-316 20 1.58 63 0.625 59 1.500 

316-341 20 1.10 63 0.625 59 1.250 

341-416 20 1.10 63 0.625 59 1.000 
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.29 Grillage Deflection Profile for Span 2 of Bridge 9 with Activated 

Hinges 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.30 Grillage Analysis Results of Bridge 9-Span 1 
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(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.31 Grillage Analysis Results of Bridge 9-Span 2 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.32 Grillage Analysis Results of Bridge 9-Span 3 
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4.3.11. Grillage Analysis of Bridge 10-NBI #14-227-0-0015-13-450 

Bridge 10, built in 2002 in Harris County along IH 10, is a continuous three span bridge 

with span lengths of 148 ft, 265 ft, and 189.6 ft. It has a total deck width of 30 ft and 

thickness of 8 in. Table 4.21 and Table 4.22 contain the geometric property details of 

Bridge 10. It should be noted that the top flange, web, and bottom flange thicknesses 

change over the length of the girders. The top reinforcing bars are a mixture of number 4 

and 5 bars over the support.   

Table 4.21 Geometric Details of Steel Tub Girders of Bridge 10 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-50 24 1.00 78 0.625 59 0.750 

50-98 24 1.00 78 0.625 59 1.250 

98-131 24 2.00 78 0.75 59 2.000 

131-181 24 3.00 78 0.875 59 2.000 

181-230 24 1.00 78 0.875 59 1.250 

230-247 24 1.00 78 0.75 59 1.000 

247-297 24 1.00 78 0.75 59 1.250 

297-330 24 1.00 78 0.75 59 1.000 

330-380 24 1.00 78 0.875 59 1.250 

380-396 24 2.00 78 0.875 59 1.250 

396-430 24 3.00 78 0.875 59 2.000 

430-447 24 3.00 78 0.875 59 2.000 

447-464 24 2.00 78 0.75 59 1.250 

464-499 24 1.00 78 0.75 59 1.250 

499-602 24 1.00 78 0.625 59 0.750 

Figure 4.33 depicts the displacement profile of Bridge 10 with HL93 loading a 

fracture in Span 2. Figure 4.34, Figure 4.35, and Figure 4.36 illustrates the load 



101 

displacement results for all spans of Bridge 10. Span 1 has a fractured overstrength factor 

of 1.71. Span 2 has a fractured overstrength factor of 1.25 and an intact overstrength factor 

of 1.85. Span 3 has a fractured factor of 1.25 and an intact factor of 2.10. Each of the spans 

has an overstrength factor greater than one and are therefore exhibiting a necessary level 

of redundancy for load redistribution post fracture. Span 1 is controlled by stiffness, 

however Span 2 and Span 3 are controlled by longitudinal chord rotation.  

Table 4.22 General Geometric Properties of Bridge 10 

Location Parameter Description/Value 

Bridge 

Location Harris County, IH10 

Year Designed/Year Built 1998/2002 

Design Load HS20 

Length, ft 602.58 

Spans, ft 148, 265, 189.58 

Radius of Curvature, ft 716.2 

Deck 

Width, ft 30 

Thickness, in. 8 

Haunch, in. 5 

Rail Type T4(s) 

Rebar 

# of Bar Longitudinal Top Row (#4) 42 

# of Bar Longitudinal Bottom Row (#5) 32 

# of Bar Longitudinal Top Row (#4) @support 42 

# of Bar Longitudinal Top Row (#5) @support 40 

# of Bar Longitudinal Bottom Row (#5) @support 32 

Transverse Spacing Top Row (#5), in. 6 

Transverse Spacing Bottom Row (#5), in. 6 
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.33 Grillage Deflection Profile for Span 2 of Bridge 10 with Activated 

Hinges 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.34 Grillage Analysis Results of Bridge 10-Span 1 
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(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.35 Grillage Analysis Results of Bridge 10-Span 2 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.36 Grillage Analysis Results of Bridge 10-Span 3 
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4.3.12. Grillage Analysis of Bridge 11-NBI #12-102-0271-07-593 

Bridge 11, compared to Bridge 10, is a longer three span continuous bridge located along 

IH 10 in Harris County. Bridge 11 consist of three spans with span lengths of 223 ft, 366 

ft, and 235 ft with an overall deck width of 28.4 ft and a deck thickness of 8 in. Table 4.23 

and Table 4.24 contain the necessary geometric information to generate an accurate 

grillage model. It should be noted that both the top flange width and thickness changes 

over the length of the girder as well as the bottom flange thickness.  

Table 4.23 Geometric Details of Steel Tub Girders of Bridge 11 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-128 18 1.00 102 0.875 66 1.000 

128-154 18 1.00 102 0.875 66 1.500 

154-180 30 1.75 102 0.875 66 1.500 

180-247 30 3.00 102 0.875 66 3.000 

247-256 30 3.00 102 0.875 66 1.500 

256-281 30 1.75 102 0.875 66 1.500 

281-522 18 1.75 102 0.875 66 1.500 

522-555 30 1.75 102 0.875 66 1.500 

555-630 30 3.00 102 0.875 66 3.000 

630-647 30 1.75 102 0.875 66 1.500 

647-681 18 1.00 102 0.875 66 1.500 

681-824 18 1.00 102 0.875 66 1.000 

Figure 4.37 illustrates the deflection profile of Span 2 for an HL93 load. Figure 

4.38, Figure 4.39, and Figure 4.40 show the load displacement response of all three spans 

of Bridge 11. Span 1 has a fractured overstrength factor of 1.35. Span 2 has a fractured 
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overstrength factor of 1.00. Span 3 has a fractured overstrength factor of 1.30. Span 1 fails 

via stiffness, Span 2 fails via longitudinal rotation, and Span 3 is controlled by transverse 

rotation. 

Table 4.24 General Geometric Properties of Bridge 11 

Location Parameter Description/Value 

Bridge 

Location Harris County, IH10 

Year Designed/Year Built 2004/2007 

Design Load HS25 

Length, ft 824 

Spans, ft 223, 366, 235 

Radius of Curvature, ft 818.51 

Deck 

Width, ft 28.417 

Thickness, in. 8 

Haunch, in. 4 

Rail Type SSTR 

Rebar 

# of Bar Longitudinal Top Row (#5) 30 

# of Bar Longitudinal Bottom Row (#5) 38 

# of Bar Longitudinal Top Row (#5) @support 59 

# of Bar Longitudinal Bottom Row (#5) @support 38 

Transverse Spacing Top Row (#5), in. 6 

Transverse Spacing Bottom Row (#5), in. 6 
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.37 Grillage Deflection Profile for Span 2 of Bridge 11 with Activated 

Hinges 

(a) Load-displacement (b) Deck rotations
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.38 Grillage Analysis Results of Bridge 11-Span 1 
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(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.39 Grillage Analysis Results of Bridge 11-Span 2 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.40 Grillage Analysis Results of Bridge 11-Span 3 
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4.3.13. Grillage Analysis of Bridge 12-NBI #12-102-0271-07-639 

Bridge 12, built in 2007 in Harris County along IH10, is a three span continuous bridge. 

The lengths of the spans which comprise Bridge 12 are as 140 ft, 180 ft, and 145 ft 

respectively. The overall bridge deck width of 28.4 ft and deck thickness of 8.5 in. Table 

4.25 and Table 4.26 contain the geometric properties and information necessary for 

appropriately generating a grillage model to represent Bridge 12. Note, both the top and 

bottom flanges vary in thickness along the length of the member.  

Table 4.25 Geometric Details of Steel Tub Girders of Bridge 12 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-90 20 1.00 54 0.5 72 0.875 

90-116 20 1.75 54 0.5 72 1.750 

116-138 20 3.25 54 0.5 72 1.750 

138-160 20 3.25 54 0.5 72 1.750 

160-189 20 1.75 54 0.5 72 1.750 

189-267 20 1.00 54 0.5 72 0.875 

267-296 20 1.75 54 0.5 72 1.750 

296-318 20 3.25 54 0.5 72 1.750 

318-340 20 3.25 54 0.5 72 1.750 

340-377 20 1.75 54 0.5 72 1.750 

340-465 20 1.00 54 0.5 72 0.875 

Figure 4.41 depicts the displacement profile for Bridge 12 under the ultimate HL93 

loading state. Figure 4.42, Figure 4.43, and Figure 4.44 illustrates the load displacement 

behavior of all spans of Bridge 12 under HL93 loading. Span 1 has a fractured overstrength 

factor of 1.20 and an intact factor of 2.50. Span 2 has a fractured overstrength of 1.56 and 
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an intact factor of 2.60. Span 3 has a fractured overstrength factor of 1.15 and an intact 

factor of 2.35. Once again, the longer spans have lower overstrength factors. Span 1 fails 

due to transverse rotation while Spans 2 and 3 fail due to longitudinal rotation. 

Table 4.26 General Geometric Properties of Bridge 12 

Location Parameter Description/Value 

Bridge 

Location Harris County, IH10 

Year Designed/Year Built 2004/2007 

Design Load HS25 

Length, ft 465 

Spans, ft 140, 180, 145 

Radius of Curvature, ft 225 

Deck 

Width, ft 28.417 

Thickness, in. 8.5 

Haunch, in. 3.5 

Rail Type SSTR 

Rebar 

# of Bar Longitudinal Top Row (#5) 40 

# of Bar Longitudinal Bottom Row (#5) 30 

# of Bar Longitudinal Top Row (#5) @support 79 

# of Bar Longitudinal Bottom Row (#5) @support 30 

Transverse Spacing Top Row (#5), in. 5 

Transverse Spacing Bottom Row (#5), in. 5 
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.41 Grillage Deflection Profile for Span 2 of Bridge 12 with Activated 

Hinges 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.42 Grillage Analysis Results of Bridge 12-Span 1 
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(a) Load-displacement (b) Deck rotation

Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.43 Grillage Analysis Results of Bridge 12-Span 2 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.44 Grillage Analysis Results of Bridge 12-Span 3 
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4.3.14. Grillage Analysis of Bridge 13-NBI #14-227-0-0015-13-452 

Bridge 13, located in Travis County along IH 35, is a three span continuous bridge built 

in 2002. Bridge 13 has an overall deck width of 30 ft with a deck thickness of 8 in. and 

has 151.5 ft, 190 ft, and 151.5 ft long spans. Table 4.27 contains the geometric property 

details for the tub girders for Bridge 13. Table 4.28 details further geometric properties 

necessary for constructing an appropriate grillage model.  

Table 4.27 Geometric Details of Steel Tub Girders of Bridge 13 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-18 24 1.25 54 0.625 60 0.750 

18-94 24 1.25 54 0.625 60 0.750 

94-113 24 1.25 54 0.625 60 0.750 

113-132 24 1.25 54 0.625 60 1.250 

132-151 24 1.75 54 0.625 60 1.500 

151-170 24 2.75 54 0.625 60 2.000 

170-189 24 1.75 54 0.625 60 1.500 

189-208 24 1.25 54 0.625 60 1.250 

208-284 24 1.25 54 0.625 60 0.750 

284-303 24 1.25 54 0.625 60 0.750 

303-322 24 1.25 54 0.625 60 1.250 

322-341 24 1.75 54 0.625 60 1.500 

341-360 24 2.75 54 0.625 60 2.000 

360-379 24 1.75 54 0.625 60 1.500 

379-398 24 1.25 54 0.625 60 1.250 

398-474 24 1.25 54 0.625 60 0.750 

474-493 24 1.25 54 0.625 60 0.750 
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Figure 4.45 illustrates the deflection profile of Bridge 13 with a fractured second 

span and with the HL93 load case. Figure 4.46 and Figure 4.47 depict the load 

displacement behavior of each span of Bridge 13. Span 1 and 3 has an intact overstrength 

factor of 2.10 with fractured overstrength factor of 1.10. Span 2 has an intact overstrength 

factor of 2.20 and a fractured overstrength factor of 1.35. All spans of Bridge 13 fail due 

to longitudinal rotation.   

Table 4.28 General Geometric Properties of Bridge 13 

Location Parameter Description/Value 

Bridge 

Location Travis County, IH35 

Year Designed/Year Built 1998/2002 

Design Load HS20 

Length, ft 493 

Spans, ft 151.5, 190, 151.5 

Radius of Curvature, ft 450 

Deck 

Width, ft 30 

Thickness, in. 8 

Haunch, in. 4 

Rail Type T4(S) 

Rebar 

# of Bar Longitudinal Top Row (#4) 40 

# of Bar Longitudinal Bottom Row (#5) 32 

# of Bar Longitudinal Top Row (#4) @support 39 

# of Bar Longitudinal Top Row (#5) @support 40 

# of Bar Longitudinal Bottom Row (#5) @support 32 

Transverse Spacing Top Row (#5), in. 6 

Transverse Spacing Bottom Row (#5), in. 6 
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.45 Grillage Deflection Profile for Span 2 of Bridge 13 with Activated 

Hinges 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.46 Grillage Analysis Results of Bridge 13-Spans 1&3 
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(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.47 Grillage Analysis Results of Bridge 13-Span 2 

4.3.15. Grillage Analysis of Bridge 14-NBI #18-057-0-0009-11-460 

Bridge 14, built in Dallas County in 2012, is a three span continuous bridge built along 

IH30. Bridge 14 consists of three spans with lengths of 150 ft, 190 ft, and 150 ft. It has a 

deck with an overall width of 28 ft and a thickness 8 in.  Table 4.29 contains the geometric 

information of the steel tub girders for Bridge 14. Note that the top flanges, web, and 

bottom flange vary in thickness along the length of the girder. Table 4.30 contains 

additional information needed to construct an accurate grillage model of Bridge 14.    
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Table 4.29 Geometric Details of Steel Tub Girders of Bridge 14 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-103 22 1.00 60 0.5625 70 0.750 

103-112 22 1.00 60 0.5625 70 1.125 

112-131 22 1.00 60 0.625 70 1.125 

131-169 22 1.75 60 0.625 70 1.500 

169-198 22 1.00 60 0.625 70 1.125 

198-302 22 1.00 60 0.5625 70 0.750 

302-321 22 1.00 60 0.625 70 1.125 

321-358 22 1.75 60 0.625 70 1.500 

358-386 22 1.00 60 0.625 70 1.125 

386-490 22 1.00 60 0.5625 70 0.750 

Figure 4.48 shows the deflection profile of Span 2 under the ultimate HL93 loading 

with a midspan fracture and activated plastic hinge. Figure 4.49 and Figure 4.50 illustrate 

the load displacement behavior of all spans of Bridge 14. Spans 1 and 3 have an intact 

overstrength factor of 2.15 fractured overstrength factor of 1.25. Span 2 has an intact 

overstrength factor of 2.05 fractured overstrength factor of 1.35. All spans of Bridge 14 

have fractured overstrength factors greater than 1 and are therefore redundant. All spans 

of Bridge 14 are controlled by the longitudinal rotation limit.  
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Table 4.30 General Geometric Properties of Bridge 14 

Location Parameter Description/Value 

Bridge 

Location Dallas County, IH30 

Year Designed/Year Built 2008/2012 

Design Load HS20 

Length, ft 490 

Spans, ft 150,190,150 

Radius of Curvature, ft 1010 

Deck 

Width, ft 28 

Thickness, in. 8 

Haunch, in. 4 

Rail Type SSTR 

Rebar 

# of Bar Longitudinal Top Row (#4) 38 

# of Bar Longitudinal Bottom Row (#5) 32 

# of Bar Longitudinal Top Row (#4) @support 38 

# of Bar Longitudinal Top Row (#5) @support 38 

# of Bar Longitudinal Bottom Row (#5) @support 32 

Transverse Spacing Top Row (#5), in. 6 

Transverse Spacing Bottom Row (#5), in. 6 

Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.48 Grillage Deflection Profile for Span 2 of Bridge 14 with Activated 

Hinges 
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(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.49 Grillage Analysis Results of Bridge 14-Spans 1&3 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.50 Grillage Analysis Results of Bridge 14-Span 2 
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4.3.16. Grillage Analysis of Bridge 15-NBI #12-102-0271-06-689 

The final bridge investigated in this study is Bridge 15. It is a three span continuous bridge. 

Bridge 15 contains 200 ft, 295 ft, and 200 ft long spans with an overall deck width 28.4 ft 

and a thickness of 8 in. Table 4.31 details the geometric details of the tub girders in Bridge 

15. It should be noted that the top and bottom flanges vary in thickness along the length

of the girder. Table 4.32 outlines additional information regarding the geometric 

configuration of Bridge 15 need to generate an appropriate grillage model.   

Table 4.31 Geometric Details of Steel Tub Girders of Bridge 15 

Location   

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-126 24 1.25 84 0.6875 53.5 1.250 

126-147 24 1.50 84 0.6875 53.5 1.750 

147-168 24 1.75 84 0.6875 53.5 2.000 

168-189 24 2.25 84 0.6875 53.5 2.250 

189-210 24 2.25 84 0.6875 53.5 2.250 

210-231 24 2.50 84 0.6875 53.5 2.500 

231-252 24 1.75 84 0.6875 53.5 2.000 

252-284 24 1.25 84 0.6875 53.5 1.250 

284-410 24 1.50 84 0.6875 53.5 1.750 

410-422 24 1.25 84 0.6875 53.5 1.250 

422-463 24 1.75 84 0.6875 53.5 2.000 

463-484 24 2.25 84 0.6875 53.5 2.250 

484-505 24 2.50 84 0.6875 53.5 2.500 

505-526 24 2.25 84 0.6875 53.5 2.250 

526-547 24 1.75 84 0.6875 53.5 2.000 

547-568 24 1.50 84 0.6875 53.5 1.750 

568-698 24 1.25 84 0.6875 53.5 1.250 
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Figure 4.51 depicts the displacement profile of the fractured Span 2 under the 

ultimate HL93 loading case. Figure 4.52 and Figure 4.53 shows the load displacement 

response of all spans in Bridge 15. Spans 1 and 3 have an intact overstrength factor of 2.45 

and a fractured overstrength factor of 1.40. Span 2 has a fractured overstrength factor of 

1.25. All three spans of Bridge 15 have fractured Ω factors greater than 1 and considered 

redundant. Every span in Bridge 15 is controlled by longitudinal rotation.  

Table 4.32 General Geometric Properties of Bridge 15 

Location Parameter Description/Value 

Bridge 

Location Dallas County, IH30 

Year Designed/Year Built 2008/2012 

Design Load HL93 

Length, ft 695 

Spans, ft 200,295,200 

Radius of Curvature, ft 809 

Deck 

Width, ft 28.417 

Thickness, in. 8 

Haunch, in. 4.5 

Rail Type SSTR 

Rebar 

# of Bar Longitudinal Top Row (#5) 38 

# of Bar Longitudinal Bottom Row (#5) 36 

# of Bar Longitudinal Top Row (#5) @support 78 

# of Bar Longitudinal Bottom Row (#5) 

@support 
36 

Transverse Spacing Top Row (#5), in. 5 

Transverse Spacing Bottom Row (#5), in. 5 
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Note: The colors represent achieved curvature limits (Magenta=yielding, Yellow=beyond yielding, 

Orange=beyond yielding close to failure, Red=Failure) Additional Hinge Data Located in 

Appendix 

Figure 4.51 Grillage Deflection Profile for Span 2 of Bridge 15 with Activated 

Hinges 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.52 Grillage Analysis Results of Bridge 15-Spans 1&3 



122 

(a) Load-displacement (b) Deck rotation
Note: δ is along the centerline of the girder,  Ω is the load normalized by factored design load 

Figure 4.53 Grillage Analysis Results of Bridge 15-Span 2 

4.4. Conclusion 

In this portion of this STTG study, 15 bridges from the Texas Bridge inventory were 

evaluated to determine their strength and redundancy before and after a simulated fracture 

under HL93 design load. The 15 bridges were modeled using the state of the art structural 

analysis program SAP2000, based on matrix analysis methods and principles.  These 

bridges were evaluated in manner outlined in Chapter 6. Table 4.33 offers a summary of 

the grillage analysis results gathered and includes the normalized load for the fractured 

and nonfractured cases for each bridge. From the grillage analysis results, the following 

observations were seen: 

 Overall, simple span bridges have much lower fractured overstrength factors than

their continuous span counterparts. The fractured overstrength factors range from
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0.16 to 1.11 while their intact overstrength factors range from 3.42 to 1.00. On 

average, after simulating a full web fracture, simple span bridges experience a 

strength reduction of nearly 74%. 

 In the case of exterior spans of continuous bridge (all spans in two span bridges

and exterior span in three span bridges) fractured overstrength factors range from

0.60 to 1.71. Their intact overstrength factors range from 1.45 to 3.38. However,

as a whole, exterior spans lose an average of 46% of their initial strength post web

fracture, which, is significantly less than that of the single span bridges.

 When compared to single span bridges and the exterior spans, the interior spans

of the three span continuous bridge had the lowest strength reduction post full web

fracture. This can be seen by looking at the results of the continuous bridges. The

intact overstrength factors range from 1.85 to 3.10. The fractured overstrength

factors range from 1.00 to 2.10. Yet, the average strength reduction of the interior

spans is only 35%. This is significantly lower than that of the simple spans and

exterior spans.

 From the results it is clear that there is some redundancy due to continuity due to

the fact that as the degree of continuity increases, the average strength reduction

decreases. These results demonstrate that, even though there exist transverse

redundancy between the two girders, there is some longitudinal redundancy and

load redistribution between the spans of the same bridge.
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Table 4.33 Overstrength Factors for Single Span Bridges utilizing Grillage Analysis 

ID Span R (ft) L (ft) B (ft) S (ft) 5% SF 
5° 

Trans. 

2° 

Long. 

0 1 1300 120 23 6.0 1.33 1.33 1.07 

1 1 573 220 32 9.5 0.46 0.28 0.21 

2 1 1910 115 26 6.1 1.11 1.65 1.11 

3 1 2207 230 39 12.6 0.60 0.16 0.37 

Note: L= length, B=breadth, R=radius of curvature, S=spacing between interior top flanges 

Table 4.34 Overstrength Factors for End Spans utilizing Grillage Analysis 

ID Span R (ft) L (ft) B (ft) S (ft) 5% SF 
5° 

Trans. 

3° 

Long. 

4 1 195 132 28 7.6 1.50 1.45 1.30 

4 2 195 128 28 7.6 1.58 1.53 1.32 

5 1 450 140 30 9.7 1.25 1.30 1.10 

5 2 450 140 30 9.7 1.25 1.30 1.10 

6 1 819 140 38 9.8 1.43 1.58 1.58 

6 2 819 140 38 9.8 1.43 1.58 1.58 

7 1 764 219 28 7.4 1.30 1.15 0.94 

7 2 764 190 28 7.4 1.50 1.45 1.25 

8 1 882 265 28 8.4 0.94 0.88 0.83 

8 2 882 295 28 8.4 0.80 0.60 0.60 

9 1 764 140 28 7.4 1.35 1.65 1.40 

9 3 764 126 28 7.4 1.53 1.95 1.61 

10 1 716 148 30 7.7 1.71 2.10 1.94 

10 3 716 190 30 7.7 1.40 1.35 1.25 

11 1 819 223 28 7.0 1.35 1.45 1.50 

11 3 819 235 28 7.0 1.40 1.30 1.40 

12 1 225 140 28 7.6 1.55 1.20 1.40 

12 3 225 145 28 7.6 1.50 1.35 1.15 

13 1 450 152 30 9.3 1.40 1.25 1.10 

13 3 450 152 30 9.3 1.40 1.25 1.10 

14 1 1010 150 28 6.5 1.35 1.45 1.25 

14 3 1010 150 28 6.5 1.35 1.45 1.25 

15 1 809 200 28 8.0 1.55 1.60 1.40 

15 3 809 200 28 8.0 1.55 1.60 1.40 

Note: L= length, B=breadth, R=radius of curvature, S=spacing between interior top flanges 
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Table 4.35 Overstrength Factors for Interior Spans utilizing Grillage Analysis 

ID Span R (ft) L (ft) B (ft) S (ft) 5% SF 
5° 

Trans. 

2° 

Long. 

9 2 764 151 28 7.0 2.10 2.50 2.15 

10 2 716 265 30 7.7 1.50 1.45 1.25 

11 2 819 366 28 7.0 1.15 1.10 1.00 

12 2 225 180 28 7.6 2.05 1.67 1.56 

13 2 450 190 30 9.3 1.60 1.50 1.35 

14 2 1010 190 28 6.5 1.45 1.60 1.35 

15 2 809 295 28 8.0 1.50 1.45 1.25 

Note: L= length, B=breadth, R=radius of curvature, S=spacing between interior top flanges 

4.5. Grillage Analysis: Additional Parametric Study 

In addition to the parametric study involving the 15 selected bridges form the TxDOT 

inventory, a parametric study was completed on two of the bridges varying multiple 

parameters of the bridge. Bridge 2, a single span bridge, and the middle span of Bridge 9, 

a three span bridge, were selected to analyze in the parametric study. A single span bridge 

and a middle span were selected to see the varying effect with the greatest degree of 

continuity difference. Three parameters: concrete strength, reinforcing bar area, and deck 

thickness, were varied for both spans involved in the parametric study.  

4.5.1. Concrete Strengths  

TxDOT’s design strength of all off the bridges involved in the parametric study was 4000 

psi. In this study the bridges were analyzed with the design strength of 4000 psi as well as 

concrete strengths of 5000 psi and 6000 psi.  

The results for Bridge 2 and the middle span of Bridge 9 are located in Table 4.36 

and Table 4.37 respectively. Both bridge spans failure overstrength factors increase 
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relatively similar amounts from 4000 psi to 5000 psi (0.05 for Bridge 2, and 0.02 for 

Bridge 9) and from 4000 psi to 6000 psi (0.08 for Bridge 2 and Bridge 9). Not only did 

increasing the concrete strength increase the overstrength factor, but it also shifted the 

failure mode from structural failure to longitudinal rotation failure for both bridges when 

transitioning from a concrete strength of 5000 psi to 6000 psi.  

Table 4.36 Bridge 2: Overstrength Factors (Ω) with Varied Concrete Strengths 

f'c (psi) 5% S.F 5˚ Trans 2˚ Long 

4000 1.11 1.65 1.11 

5000 1.16 1.36 1.16 

6000 1.30 1.24 1.19 

Table 4.37 Bridge 9 (Mid-Span): Overstrength Factors (Ω) with Varied Concrete 

Strengths  

f'c (psi) 5% S.F 5˚ Trans 2˚ Long 

4000 2.10 2.50 2.15 

5000 2.12 2.62 2.15 

6000 2.18 2.63 2.18 

4.5.2. Reinforcing Bar Area 

Reinforcing bar area was another variable altered in the parametric study. The design 

reinforcing bar area was analyzed for both Bridge 2 and the middle span of Bridge 9. The 

percentage of reinforcing bar area was increased 25% and 50% and analyzed using the 

grillage method. Both transverse and longitudinal reinforcing bar areas were increased in 

this study. 
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Table 4.38 and Table 4.39 contain the overstrength factor results from increasing 

the reinforcing bar areas in the slab of bridge deck of Bridge 2 and the middle span of 

Bridge 9. The overstrength factors of Bridge 2 and mid-span of Bridge of 9 increased as 

the percentage of reinforcing increased and the failure mode consistently remained 

structural failure. However, the amount by which the overstrength factors increased varied 

significantly between the bridges for the both the 25% increase (0.01 for Bridge 2 and 

0.05 for Bridge 9) and the 50% increase (0.03 for Bridge 2 and 0.14 for Bridge 9). This 

could be accounted for by the increase in continuity.  

Table 4.38 Bridge 2: Overstrength Factors (Ω) with Varied Reinforcing Bar Areas 

% rebar 5% S.F 5˚ Trans 2˚ Long 

100 1.11 1.65 1.11 

125 1.12 1.77 1.18 

150 1.14 1.80 1.21 

Table 4.39 Bridge 9 (Mid-Span): Overstrength Factors (Ω) with Varied Reinforcing 

Bar Areas 

% rebar 5% S.F 5˚ Trans 2˚ Long 

100 2.10 2.50 2.15 

125 2.15 2.80 2.21 

150 2.24 3.00 2.29 

4.5.3. Concrete Deck Thickness 

Another key parameter investigated in this study is concrete deck thickness. The design 

concrete deck thickness for both Bridge 2 and Bridge 9 is 8 inches. The parametric study 
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increased the deck thickness by 1 and 2 inches, which takes the total deck thicknesses to 

9 and 10 inches respectively. 

Table 4.40 and Table 4.41 contains the overstrength results for Bridge 2 and the 

mid-span of Bridge 9 with increased deck thicknesses. Bridge 2 and Bridge 9 have 

overstrength factors which increase as deck thickness increase. However, Bridge 2 

changes failure modes from structural failure with a 9 inch thickness to a longitudinal 

rotation failure at 10 inches. Bride 9 has a consistent failure mode of structural failure. 

Overstrength values increased more rapidly for Bridge 2 than for the mid-span of Bridge 

9. This indicates that deck thickness may influence less continuous structures more than

bridge spans with greater continuity. 

Table 4.40 Bridge 2: Overstrength Factors (Ω) with Varied Concrete Thicknesses 

Deck (in.) 5% S.F 5˚ Trans 2˚ Long 

8 1.11 1.65 1.11 

9 1.19 1.74 1.24 

10 1.66 1.86 1.39 

Table 4.41 Bridge 9 (Mid-Span): Overstrength Factors (Ω) with Varied Concrete 

Thicknesses 

Deck (in.) 5% S.F 5˚ Trans 2˚ Long 

8 2.10 2.50 2.15 

9 2.13 2.88 2.19 

10 2.23 N/A 2.35 
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5. GRILLAGE METHOD AND FEM COMPARISON

5.1. Introduction  

From the FEM results in Section 3.3.2 and the Grillage results in Section 4.4 it can be 

clearly seen that for some bridge spans the two methods are in good agreement and for 

other bridge spans the results seem to diverge. This section will discuss the observed 

similarities and differences between the two analysis methods and the impact of these 

results on potential industry use of the grillage method to adequately assess failure 

capacity of steel twin tub girder bridges. This section will break down bridge spans for 

comparison by number of fixed supports. First, spans with no fixed supports, or single 

span Bridges 0 to 3 will be looked at. Then, bridge spans with two fixed supports, or the 

middle spans of Bridges 9 to 15 will be evaluated. Finally, bridge spans with one fixed 

support, or the end spans of Bridges 4 to 15 will be compare and contrasted. Note: All of 

the FEM data came from TxDOT Report 0-6937 (Hurlebaus et al. 2018).  

5.2. Single Span Bridges 

Single span bridges have the least amount of support redundancy and it is expected that 

their overstrength factors will be lower than that of the interior spans and end spans. In all 

of the simply sported bridge cases the location of fracture was assumed to be at the center 

of the span along the exterior girder. Table 5.1 contains the overstrength factor results 

from both FEM analysis and Grillage Push-Down analysis. The table is organized in 

 Part of this chapter is reprinted with permission from “Fracture Critical Steel Twin Tub Girder Bridges 

Technical Report” 0-6937-R1 by Hurlebaus S., Mander J., Terzioglu T., Boger N., Fatima A., 2018. Texas 

A&M Texas Transportation Institute, 259-282, Copyright 2018 by Texas A&M Texas Transportation 

Institute 
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increasing order in accordance with span length. It should be noted that span length 

increases the overstrength factor decreases for both the FEM and Grillage analysis 

methods.  

Table 5.1 Results for Simple Spans 

ID Span R (ft) L (ft) B (ft) S (ft) FEM Grillage 

2 1 1910 115 26 6.1 1.65 1.11 

0 1 1300 120 23 6 0.86 1.07 

1 1 573 220 32 9.5 0.82 0.21 

3 1 2207 230 39 12.6 0.85 0.16 

The single span bridges are divided into two categories: short single span bridges 

(spans less than or equal to 120 feet) and long single span bridges (spans greater than or 

equal to 220 feet). The single span bridges can be considered redundant if the overstrength 

factor is greater than 1. For the shorter span bridges, there is some, however not 

conclusive, agreement between the FEM and Grillage methods. However, there is greater 

disparity between FEM and Grillage for the longer span bridges. The Grillage method of 

analysis does not incorporate some of the internal redundancies such as: cross bracing, 

diaphragms, and shear stud connectors, which the FEM analysis accounts for. This is a 

probable explanation for the magnification of difference between the overstrength factors 

for the FEM and Grillage methods.  

Figure 5.1 demonstrates that the shorter span bridges have the potential to reach 

an overstrength factor of at least 1 and quite possibly be considered redundant. Figure 5.2 

illustrates the vast difference in the FEM and Grillage analysis results for longer simple 
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span bridges. However, both methods conclude that longer span simply supported bridges 

are unable to meet the criteria of a redundant structure.  

(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 2, L=115 ft

(i) Load displacement (ii) Deck rotations

(b) Comparision of the Results for Bridge 0, L=120 ft

Figure 5.1. Results for Short Single Span (Simply Supported) Fractured Twin Tub 

Bridges 
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(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 1, L=220 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 3, L=230 ft

Figure 5.2. Results for Long Single Span (Simply Supported) Fractured Twin Tub 

Bridges 
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5.3. Interior Spans 

Interior spans, or the middle spans on three span bridges, have the greatest about of 

structural support redundancy and are expected to have the highest overstrength factors 

when compared to their single span and end span counterparts. Table 5.2 below list the 

overstrength factors for the interior span bridges sorted by span length in ascending order. 

It should be noted that all of the interior spans have overstrength factors greater than or 

equal to one, all are redundant. Grillage analysis results are consistently lower than the 

FEM analysis results. This correlation can be explained by the fact that Grillage analysis 

method is a conservative simplified lower bound strip method and the FEM adequately 

models and the 3-D components. Grillage and FEM overstrength factors values for the 

interior spans are in closer agreement than the simple span bridges. Detailed results for all 

of the interior spans are located in Figure 5.3, Figure 5.4, Figure 5.5, and Figure 5.6 are 

presented according to bridge length.  

Table 5.2 Results for Interior Spans 

ID Span R (ft) L (ft) B (ft) S (ft) FEM Grillage 

9 2 764 151 28 7 2.45 2.10 

12 2 225 180 28 7.6 1.80 1.56 

13 2 450 190 30 9.3 1.40 1.35 

14 2 1010 190 28 6.5 1.80 1.35 

10 2 716 265 30 7.7 1.45 1.25 

15 2 809 295 28 8 1.40 1.25 

11 2 819 366 28 7 1.20 1.00 
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(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 9 Span 2, L=151 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 12 Span 2, L=180 ft

Figure 5.3. Results for Shorter Interior Spans of Fractured Twin Tub Bridges 
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(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 13 Span 2, L=190 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 14 Span 2, L=190 ft

Figure 5.4. Results for Average Interior Spans of Fracture Twin Tub Bridges 
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(i) Load displacement (i) Deck rotations

(a) Comparison of the Results for Bridge 10 Span 2, L=265 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 15 Span 2, L=295 ft

Figure 5.5. Results for Long Interior Spans of Fracture Twin Tub Bridges 
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(i) Load displacement (ii) Deck rotations

Comparison of the Results for Bridge 11 Span 2, L=366 ft 

Figure 5.6. Results for Very Long Interior Span of Fracture Twin Tub Bridges 

Figure 5.3 illustrates the FEM and Grillage analysis results for shorter interior 

spans (span lengths ≤ 180 feet) as shows great agreement amongst the analysis methods. 

Figure 5.4 shows the results for average interior spans (180 feet <span lengths≤ 250 feet). 

Both interior spans from Bridge 14 and 13 are 190 feet but differ in overstrength values, 

with Bridge 13 having a lower value. One significant reason in due to the fact that the 

radius of curvature for Bridge 13 is nearly have of that of Bridge 14. However both have 

overstrength factors greater than one. Figure 5.5 depicts the results for longer interior 

spans (250 feet<span length≤300 feet). Interior spans from Bridge 10 and 15 are longer 

interior span have overstrength values greater than one and excellent agreement between 

the two analysis methods. Very long interior span (span lengths≥ 300 feet) results can be 

seen in Figure 5.6. There is slight disparity between the two analysis methods the very 
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long interior span of Bridge 11 with FEM yielding a result of 1.2 and Grillage Method an 

overstrength factor of 1.0. However, since Grillage Method is a conservative analysis 

approach, Bridge 11 can safely be classified as a redundant structure.  

Overall, interior spans of three span bridges, are more redundant than single span 

bridges and exterior span with all overstrength factors being greater than one. As the span 

length increased, the overstrength values decreased. It is also notable that as the radius of 

curvature increases so does the overstrength value. 

5.4. Exterior Spans 

Exterior spans, all spans of two span bridges and end spans of three span bridges, have 

greater overstrength values than single span bridges but lower overstrength factors than 

the interior spans. Unlike the interior and single spans, the exterior spans fail at 

approximately 0.4*L distance away from the free support due to indeterminate behavior. 

Table 5.3 presents both the Grillage and FEM overstrength factor results in increasing 

span length order. All but 3 of the 24 exterior spans are redundant according to FEM and 

Grillage analysis methods; and 1 of the 3 spans is considered redundant under FEM 

analysis. Increasing span length and decreased radii of curvatures yields lower 

overstrength factors in exterior spans and is complementary to trend seen in single spans 

and interior spans. Majority of the exterior spans (all but 3) the Grillage overstrenght 

factors are less than the FEM analysis results, which was expected. Figure 5.7, Figure 5.8, 

Figure 5.9, Figure 5.10, and Figure 5.11 depict detailed FEM and Grillage analysis results 

for shorter (span lengths<150 feet) exterior spans. Figure 5.12, Figure 5.13, and 

Figure 5.14 compare the results for average (150 feet ≤ span length ≤200 feet) exterior 
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span lengths. Figure 5.15 and Figure 5.16 illustrates the results for FEM and Grillage 

analysis of longer (200 feet < span lengths <250 feet) exterior spans. Finally, Figure 5.17 

displays the results for very long (span length ≥ 250 feet) exterior spans.  

Table 5.3 Exterior Span Results 

ID Span R (ft) L (ft) B (ft) S (ft) FEM Grillage 

9 3 764 126 28 7.4 1.80 1.53 

4 2 195 128 28 7.6 1.73 1.32 

4 1 195 132 28 7.6 1.65 1.30 

9 1 764 140 28 7.4 1.70 1.35 

6 1 819 140 38 9.8 1.80 1.43 

6 2 819 140 38 9.8 1.80 1.43 

5 1 450 140 30 9.7 1.20 1.10 

5 2 450 140 30 9.7 1.20 1.10 

12 1 225 140 28 7.6 1.60 1.20 

12 3 225 145 28 7.6 1.60 1.15 

10 1 716 148 30 7.7 1.70 1.71 

14 1 1010 150 28 6.5 1.65 1.25 

14 3 1010 150 28 6.5 1.65 1.25 

13 1 450 152 30 9.3 1.00 1.10 

13 3 450 152 30 9.3 1.00 1.10 

7 2 764 190 28 7.4 1.45 1.25 

10 3 716 190 30 7.7 1.45 1.25 

15 1 809 200 28 8 1.70 1.40 

15 3 809 200 28 8 1.70 1.40 

7 1 764 219 28 7.4 1.20 0.94 

11 1 819 223 28 7 1.60 1.35 

11 3 819 235 28 7 1.60 1.30 

8 1 882 265 28 8.4 0.99 0.83 

8 2 882 295 28 8.4 0.88 0.60 
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(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 9 Span 3, L=126 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 4 Span 2, L=128 ft

Figure 5.7. Results for Short Exterior Spans of Fracture Twin Tub Bridges 
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(i) Load displacement (i) Deck rotations

(a) Comparison of the Results for Bridge 4 Span 1, L=132 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 9 Span 1, L=140 ft

Figure 5.8. Results for Short Exterior Spans of Fracture Twin Tub Bridges 
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(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 6 Span 1and 2, L=140 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 5 Span 1 and 2, L=140 ft

Figure 5.9. Results for Short Exterior Spans of Fracture Twin Tub Bridges 
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(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 12 Span 1, L=140 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 12 Span 3, L=145 ft

Figure 5.10. Results for Short Exterior Spans of Fracture Twin Tub Bridges 
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(i) Load displacement (ii) Deck rotations

Comparison of the Results for Bridge 10 Span 1, L=148 ft 

Figure 5.11. Results for Short Exterior Span of Fracture Twin Tub Bridges 

FEM and Girllage Analysis results are in acceptable agreement for short exterior 

spans, and all short exterior spans in this study are considered redundant. The Grillage and 

FEM results for exterior spans from Bridge 4, located in Figure 5.8, and Bridge 12, located 

in Figure 5.10, vary more than the other spans short span category. This difference can be 

accounted for by their tight radius of curvatures (195 feet for Bridge 4 and 225 feet for 

Bridge 12) and is conservatively accounted for in the Grillage analysis method. Span 1 of 

Bridge 10 is another note worth short exterior span due to the Grillage overstrength factor 

(1.71) being greater than the FEM value (1.70). This can potentially be accounted for by 

the lack of elastic representation in the FEM data. However, since both methods provide 

overstrength values significantly greater than one, Span 1 of Bridge 10 can be considered 

redundant.  
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(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 14 Span 1and 3, L=150 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 13 Span 1and 3, L=152 ft

Figure 5.12. Results for Average Exterior Spans of Fracture Twin Tub Bridges 
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(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 7 Span 2, L=190 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 10 Span 3, L=190 ft

Figure 5.13. Results for Average Exterior Spans of Fracture Twin Tub Bridges 
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(i) Load displacement (ii) Deck rotations

Comparison of the Results for Bridge 15 Span 1 and 3, L=200 ft 

Figure 5.14. Results for Average Exterior Spans of Fracture Twin Tub Bridges 

Grillage analysis and FEM results for average length exterior spans are 

complementary to one another. In all cases but one, Spans 1&2 of Bridge 13, the Grillage 

overstrength factors for average length exterior spans are lower than the FEM overstrength 

factors, which is expected. Bridge 13, Spans 1&2, present a minor contradiction to the 

trend of FME and Grillage results but both methods present overstrength values greater 

than or equal to one, and therefore redundant. Another observable trend of average exterior 

spans is that as the length of the span increases the disparity between the FEM and Grillage 

results increases slightly. The slight increase can be attributed by the increasingly 

conservative approach of Grillage analysis.  
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(i) Load displacement (ii) Deck rotations

Comparison of the Results for Bridge 7 Span 1, L=219 ft 

Figure 5.15. Results for Long Exterior Spans of Fracture Twin Tub Bridges 

Grillage and FEM results for long exterior spans are in close agreement will the 

Grillage analysis results offering a more conservative outcome. Span 1 of Bridge 7 

presents a discrepancy in redundancy when comparing the two methods having and FEM 

overstrength of 1.20 and a Grillage overstrength factor of 0.94 (less than 1). However, 

with the Grillage method being a conservative approach, if the Grillage method provides 

a result marginally close to 1 it is advisable to use a more rigorous method of analysis. 

Other spans of the long exterior span category are classified as redundant by both analysis 

methods.   
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(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 11 Span 1, L=223 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 11 Span 3, L=235 ft

Figure 5.16. Results for Long Exterior Spans of Fracture Twin Tub Bridges 
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(i) Load displacement (ii) Deck rotations

(a) Comparison of the Results for Bridge 8 Span 1, L=265 ft

(i) Load displacement (ii) Deck rotations

(b) Comparison of the Results for Bridge 8 Span 2, L=295 ft

Figure 5.17. Results for Very Long Exterior Spans of Fracture Twin Tub Bridges 

Spans 1&2 of Bridge 8 are both considered very long exterior span (span length 

≥ 250 feet). FEM and Grillage analysis results are in agreement with one another with 
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the Grillage analysis being more conservative. None of the very long exterior spans are 

considered redundant as both spans have overstrength factors less than one utilizing both 

analysis methods. Due to a lack of redundancy of the very long spans, there may be a 

length limit at which exterior spans may no longer be considered redundant.  
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6. GRILLAGE METHOD DESIGN GUIDE

6.1. Procedure 

The computational analysis of the Fracture Critical Twin Tub Girder Bridges (TTGB) may 

be implemented using commercial nonlinear structural analysis software. Programs such 

as SAP2000 may be useful to carry out the following steps. Detailed design examples for 

Bridge 2, Bridge 5, and Bridge 10 are located in Appendix C. The steps detailed in this 

section are as follows: 

1. Define cylindrical coordinate system

2. Define non-linear material properties

3. Define member section properties

4. Define section hinge properties

5. Assign frame members to grid

6. Assign hinges to frame members

7. Assign boundary conditions

8. Define load patterns and load cases

9. Assign frame loads to frames

10. Assign data collection points along frame members

11. Run analysis for dead load case

12. Run analysis for all load cases

 Part of this chapter is reprinted with permission from “Analysis Guidelines and Examples for Fracture 

Critical Steel Twin Tub Girder Bridges” 0-6937-P1 by Hurlebaus S., Mander J., Terzioglu T., Boger N., 

Fatima A., 2018. Texas A&M Texas Transportation Institute, 11-20, Copyright 2018 by Texas A&M Texas 

Transportation Institute 
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13. Replace hinges at fracture location

14. Run analysis for all load cases

15. Post process the data

6.1.1. Define Cylindrical Coordinate System 

For the TTGB, the longitudinal grids need to be located at the location of the two exterior 

edges of the bridge, the centerline of the two exterior top flanges, and the two interior top 

flanges. The transverse grillage grids need to be located at ends, at 7 ft spacing increments 

in the middle of the bridge (for easier assignment of the HS20 truck load), and at pier 

locations for the case of a multi-span bridge. An illustration of the grid system for a single 

span bridge is located in Figure 6.1. The transverse spacing increments will need to be 

converted to a radial spacing in the cylindrical coordinate system using Equation (6.1).         

𝑅𝑎𝑑𝑖𝑎𝑙 𝑆𝑝𝑎𝑐𝑖𝑛𝑔 (deg. ) = (
𝑆𝑝𝑎𝑐𝑖𝑛𝑔 𝐿𝑒𝑛𝑔𝑡ℎ

𝑅𝑎𝑑𝑖𝑢𝑠 𝑜𝑓 𝑏𝑟𝑖𝑑𝑔𝑒
) ∗ (

180

𝜋
) (6.1) 

Figure 6.1 Grillage Grid System for a Single Span Bridge 
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6.1.2. Define Non-Linear Material Properties 

The fractured TTGB will be analyzed at ultimate loading conditions therefore the steel 

and concrete components of the bridge will be taken beyond their elastic capacity. The 

composite girder and deck system is composed of concrete that will reach cracking and 

crushing strains and rebar and steel plate that will reach strains beyond yielding. The 

material models to be used are represented in Figure 6.2. Nonlinear constitutive material 

behavior is defined in the advanced properties within the material definition.    

(a) Reinforcing Bar (b) Steel Plate (c) Concrete

Figure 6.2 Constitutive Material Models (SAP2000) 

6.1.3. Define Section Properties 

Using the section designer feature in SAP2000 a composite tub, deck, and railing section 

can be generated. The exterior longitudinal member, in Figure 6.3, consist of: the railing, 

the deck from the centerline of the girder to the exterior edge with corresponding 

reinforcing bar, one top flange, one web, and half of the bottom flange. The interior 

longitudinal member consist of: the deck from the centerline of the bridge to the centerline 

of the girder with corresponding longitudinal reinforcing bar, one top flange, one web, and 



155 

one half of the bottom flange. The transverse members, in Figure 6.4, consists of concrete 

deck and transverse reinforcing bar. However, it is critical to set the weight modifier to 

zero of the transverse section as to not double count the concrete deck weight. It should 

be noted that as the steel plate members change dimensions and the reinforcing pattern 

changes throughout the length of the bridge new sections will need to be created to 

represent the new dimensions.    

a) Exterior Longitudinal Member b) Interior Longitudinal Member

Figure 6.3 Representative Longitudinal Members 
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a) End Transverse Member b) Interior Transverse Member

Figure 6.4 Representative Transverse Members 

The fractured girder can be modeled by simply copying the exterior and interior 

longitudinal sections and removing the bottom flange, web, and top flange steel plate 

components.  

6.1.4. Defining Hinge Properties 

Following the creation of the necessary longitudinal and transverse members, plastic 

hinges need to be created for each section. The grillage push down analysis will generate 

plastic hinge formation under the ultimate loading condition. Within the section designer 

of SAP2000, there is a moment curvature response tool which allow the user to generate 

moment curvature data for each of the members created in Step 3. The data form SAP2000 

is then exported into an Excel spreadsheet. Then the angle on the Moment Curvature 

window can be changed to 180 to get the negative moment curvature and once again the 

data is exported to the same Excel spreadsheet. The moment curvature response is then 

normalized against the maximum positive and negative moments and their corresponding 
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curvatures and plotted. The hinge definition window in SAP2000 will only allow four 

normalized positive and negative moment curvature data points per section hinge. 

Therefore, a best fit plot for each moment curvature response needs to be generated in 

Excel using only 9 points (4 positive, 4 negative, and 1 zero). The hinge length is assigned 

as half the member depth.  A representative hinge property is depicted in Figure 6.5. For 

ease of convergence nonnegative slopes are recommended for the hinge properties.  

Figure 6.5 Representative Hinge Property 

6.1.5. Assign Members to Grid 

Using the “quick draw” fame section tool in SAP2000 the various longitudinal and 

transverse frame sections can be assigned to the grillage grid that was established in Step 

1 by merely selecting the desired section from the drop down menu and clicking on the 
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appropriate grillage grid. Figure 6.6 shows a screenshot from SAP2000 after all members 

have been assigned to a simple span bridge.  

Figure 6.6 Screenshot of SAP2000 Post Frame Section Assignment 

6.1.6. Assign Hinges to Frame Members 

At this stage, the longitudinal and transverse members are already assigned to the grillage 

grid. To allow for plastic hinge formation hinges need to be assigned at the nodal 

intersection of all members as represented in Figure 6.7. Longitudinal hinges need be 

placed at both joints at the end of each member. Transverse hinges need to be assigned at 

a distance of half a top flange width away from each node.   
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Figure 6.7 Representative Hinge Assignments 

6.1.7. Assign Boundary Conditions 

The support conditions of the physical bridge are elastomeric bearing pads. These will be 

represent by springs with a lateral stiffness of 6 kip/in. and a vertical stiffness of 3050 

kip/in. in the grillage model as represented in Figure 6.8. For the single span bridges, 

springs will be assigned at each of end longitudinal joints. For the two and three span 

bridges, springs are also assigned to the ends longitudinal joints as well as the joints at the 

pier location.  
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Figure 6.8 Spring Boundary Conditions 

6.1.8. Define Load Patterns and Cases 

For the single span bridges, two additional load patterns need to be created: the HS20 truck 

load and the lane load for lane load. For the two and three span bridges a HS20 truck load 

pattern needs to be defined for each span and the same follows for lane load. Once, load 

patterns are established load cases need to be created. Each load case represents a load 

combination of 1.25*DL+1.75(LL+IM) where DL=dead load, LL=live load, and 

IM=impact load or 1.25*DL+1.75*LL+2.33*HS20 where DL=dead load, LL=lane load, 

and HS20=truck load. Each load case should be set to nonlinear behavior. The first load 

case should start from a zero initial conditions. Each proceeding load case should start 

from the end of the previous load case.  Each span should have its own set of load cases. 

Also, each load case should be divided into 20 or more steps.  

6.1.9.  Assign Frame Loads 

Two lanes of HS20 truck loading should be assigned as a series of point loads; and the 

two lines of lane loads should be distributed as line loads to the longitudinal members (as 

depicted in Figure 6.9) . A HS20 truck load consists of two sets of 16 kip axle loads and 
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one set of 4 kip axle loads spaced 14 feet longitudinally and 6 feet in transversely. The 

first line of axels will be placed 3 ft from the curved edge, the second 9 ft from the edge, 

the third 15 ft from the edge, and the fourth 21 ft from the edge. The middle axle load of 

each truck should be place at have the span length on the single span bridges and interior 

middle spans of three span bridges. The middle axle should be placed at approximately 

0.4*L from the end of the end spans of two span and three span bridges. Two lanes of lane 

loading (0.64 kip/in. each) located at 8 ft from the edge, and the second line located at 20 

ft from the edge. However, since the longitudinal members are placed according to the 

girder placement, the lane loads have to be distributed according to tributary area.  

a) HS20 Truck Load b) Lane Load

Figure 6.9 Grillage HS20 Truck and Lane Load 

6.1.10. Assign Data Collection Points 

At the location of each of the center axles, the transverse members between the outer 

longitudinal member and the interior longitudinal member need to be divided it two pieces 
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using the divide lines feature in SAP2000. This allow for the collection of data at the 

centerline of the member.  

6.1.11. Run Analysis for Dead Load Only 

In order to get to dead load value of the data the intact bridge should be ran solely under 

the dead load case. The reactions should be recorded for all supports.  

6.1.12. Run Analysis for All Load Cases (Intact Bridge) 

For the intact bridge run all HL93 load cases for the span being evaluated. Once the 

program has ran, collect the displacement data for points 1 thru 4 (seen in Figure 6.10) 

and the centerline points of the inside and outside girder at the location of the center axle. 

Be sure to obtain the results in the step-by-step format so that the load case and step for 

each displacement point can be collected as well. This process will be completed once for 

each span.  

Figure 6.10 Location of Grillage Data Collection Points 
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6.1.13. Replace Hinges at Fracture 

At the location of the center axle for the span being evaluated, replace the longitudinal 

hinges on the outside girder with their fractured counterparts. The hinge assignment is 

depicted in Figure 6.11.  

Figure 6.11 Fractured Hinge Pattern 

6.1.14. Run Analysis for All Load Cases (Fractured Bridge) 

For the fractured bridge run all HL93 load cases for the span being evaluated. Once the 

program has ran, collect the displacement data for points 1 thru 4 (seen in Figure 6.10) 

and the centerline points of the inside and outside girder at the location of the center axle. 

Be sure to obtain the results in the step-by-step format so that the load case and step for 

each displacement point can be collected as well. This process will be completed once for 

each span, making certain to replace intact hinges in the preceding span before assigning 

fractured hinges in the following span.  
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6.1.15. Post Process Data 

For both the intact and fractured bridge the following calculations need to be made: 

 Omega (Ω)

o 𝛺𝑖 = 𝛺𝑖−1 + (
1

# 𝑜𝑓 𝑆𝑡𝑒𝑝𝑠 𝑖𝑛 𝐿𝑜𝑎𝑑 𝑐𝑎𝑠𝑒
) 

 Longitudinal Chord Rotation of Interior and Exterior Girder

o 𝐶ℎ𝑜𝑟𝑑 𝑅𝑜𝑡.𝑆𝑖𝑛𝑔𝑙𝑒 𝑆𝑝𝑎𝑛 𝑜𝑟 𝐼𝑛𝑡𝑒𝑟𝑖𝑜𝑟 𝑆𝑝𝑎𝑛 = −1 ∗ (
𝛿𝐶𝐿

0.5∗𝐿
) 

o 𝐶ℎ𝑜𝑟𝑑 𝑅𝑜𝑡.𝐸𝑥𝑡𝑒𝑟𝑖𝑜𝑟 𝑆𝑝𝑎𝑛 = −1 ∗ (
𝛿𝐶𝐿

0.4∗𝐿
) 

o The above equations are in radians

 Transverse Deck Rotation

o Relative rotation of deck at inside flange of inside girder

 𝛼2−3 = (
𝛿3−𝛿2

𝑠
) − (

𝛿2−𝛿1

𝑤
) 

 𝛼3−2 = (
𝛿3−𝛿2

𝑠
) − (

𝛿4−𝛿3

𝑤
) 

 Where s=spacing between the interior top flanges of the inside

and outside girders and w=spacing between the top flanges of the

same girder

 The above rotations are in radians.

 Applied load

o Calculate unit applied load or applied load at 1 Ω

 𝑈𝑛𝑖𝑡 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑𝑠𝑖𝑛𝑔𝑙𝑒 𝑠𝑝𝑎𝑛 = 1.25 ∗

𝑇𝑜𝑡𝑎𝑙 𝑅𝑒𝑎𝑐𝑡𝑖𝑜𝑛 𝑓𝑟𝑜𝑚 𝐷𝑒𝑎𝑑 𝐿𝑜𝑎𝑑 𝐶𝑎𝑠𝑒 + 2 ∗ (2.33 ∗

𝐻𝑆20 𝑡𝑟𝑢𝑐𝑘 + 1.75 ∗ 𝐿𝑎𝑛𝑒 𝐿𝑜𝑎𝑑)

 𝑈𝑛𝑖𝑡 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑𝑚𝑢𝑙𝑡𝑖 𝑠𝑝𝑎𝑛 = 1.25 ∗

𝑇𝑜𝑡𝑎𝑙 𝑅𝑒𝑎𝑐𝑡𝑖𝑜𝑛 𝑓𝑟𝑜𝑚 𝐷𝑒𝑎𝑑 𝐿𝑜𝑎𝑑 𝐶𝑎𝑠𝑒 ∗ (
𝐿𝑠𝑝𝑎𝑛

𝐿𝑇𝑜𝑡𝑎𝑙
) + 2 ∗ (2.33 ∗

𝐻𝑆20 𝑡𝑟𝑢𝑐𝑘 + 1.75 ∗ 𝐿𝑎𝑛𝑒 𝐿𝑜𝑎𝑑)

 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑 = 𝑈𝑛𝑖𝑡 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑 ∗ 𝛺

 Intact Stiffness of Intact Bridge
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o 𝐼𝑛𝑖𝑡𝑖𝑎𝑙 𝑆𝑡𝑖𝑓𝑓𝑛𝑒𝑠𝑠𝐼𝑛𝑡𝑎𝑐𝑡 𝑎𝑡 𝛺=0.4 =
0.4

𝐴𝑏𝑠(𝛿𝑂𝐺−𝐶𝐿)

 Instantaneous Stiffness for Fracture Bridge

o 𝐼𝑛𝑠𝑡𝑎𝑛𝑡𝑎𝑛𝑒𝑜𝑢𝑠 𝑆𝑡𝑖𝑓𝑓𝑛𝑒𝑠𝑠𝑂𝐺−𝐹𝑟𝑎𝑐.  𝑖 =
𝛺𝑖−𝛺𝑖−1

𝛿𝑖−𝛿𝑖−1

The criteria above can be organized into an Excel spreadsheet noted in Figure 6.12. 

Figure 6.12 Spreadsheet of Grillage Data 

Failure Criteria: 

 The instantaneous stiffness for the fractured outside girder is less than 5% of the

initial stiffness of intact outside girder.

 The chord angle of the outside girder for simple spans or interior spans is greater

than 2°. The chord angle for exterior spans in multi-span bridges is greater than

3°.

 The transverse deck rotation is greater than 5°.
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7. CONCLUSION AND FINDINGS

7.1. Conclusion 

The Grillage Push-Down Analysis has proven to be an accurate lower bound solution to 

modeling fracture twin tub girder bridges in this research and shown that it can be an 

effective tool for declassifying twin tub girder bridges as non-redundant structures. The 

Grillage results, in vast majority of the bridge spans analyzed, is conservative and in good 

agreement with the FEM results.  

Single span bridges presented the greatest amount of difference between FEM and 

Grillage analysis results. Shorter single span bridge Grillage results have better agreement 

than the longer single spans with FEM results however the results were still not consistent. 

Long single span bridges show very little consistency between FEM and Grillage analysis 

with an average 77% difference in the results, where the shorter single span bridges have 

28.7% agreement. However, both FEM and Grillage analysis demonstrate a lack of 

redundancy of long single span bridges. This is understandable due to the lack of structural 

redundancy at a fixed support.  

Interior spans of three span bridges show the greatest amount of similarity between 

the Grillage and FEM results of any of the bridge categories, with an average 13.9% 

difference between results. All of the interior spans demonstrate redundancy, having 

overstrength factors greater than one. However, it should be noted that the longest interior 

 Part of this chapter is reprinted with permission from “Fracture Critical Steel Twin Tub Girder Bridges 

Technical Report” 0-6937-R1 by Hurlebaus S., Mander J., Terzioglu T., Boger N., Fatima A., 2018. Texas 

A&M Texas Transportation Institute, 283-285, Copyright 2018 by Texas A&M Texas Transportation 

Institute 
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span, Span 2 of Brige 11, having a length of 366 feet approached an overstrength factor 

of 1, implying that there may exist a limit on span length at which interior spans can no 

longer be considered redundant structures.  

Exterior spans, like the interior spans, show satisfactory compatibility between the 

Grillage analysis results and those gathered from FEM. There is only an average 17.8% 

difference between the two analysis methods with the Grillage analysis being 

conservative. Span 1 of Bridge 7, is the only bridge that presents a conflict of results as to 

the classification of redundancy. The Grillage Analysis yields an overstrength value of 

0.94 whereas, the FEM analysis calculates the overstrength factor to be 1.2. However, as 

discussed in Chapter 5 with spans that present overstrength values marginally close to 1 

under Grillage analysis, may warrant the use of a more rigorous approach (such as FEM) 

to reclassify them as redundant spans. It should also be noted that the two very long 

exterior spans, Spans 1&2 of Bridge 8 (265 feet and 295 feet respectively), fail prior to 

reaching an overstrength value of 1 under both analysis methods. This is indicative that a 

span length limit exists for exterior spans to be considered redundant structures. 

An additional parametric was conducted to evaluate the effect of increasing 

concrete strength, reinforcing bar area, and deck thickness on the overstrength factor of 

the fractured bridge. The results demonstrated that increasing all three variables increases 

the overstrength factor for both the single span bridge and the interior span evaluated 

(Bridge 2 and Span 2 of Bridge 9). Increasing the deck thickness was most effective in 

increasing the overstrength value for the single span bridge. However, increasing the 

percentage of reinforcing bar was most effective for increasing the overstrength value of 
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the interior span analyzed. The outcomes of this portion of the research demonstrates there 

are ways to improve the bridges that are marginally close to being redundant in a way to 

reclassify them. 

7.2. Findings  

1) Bridges can be declassified a non-redundant structures if determined by the

Grillage method of having a satisfactory overstrength value (Ω>1). Or if they

have a Grillage overstrength value marginally close to 1 and determined by a

more rigorous method to be sufficient (such as FEM).

2) Due to the inconsistency of the Grillage and FEM results for single span bridges,

it is advisable to continue to classify all single span bridges as fracture critical

unless the span length is ≤ 120 feet.

3) If a bridges span has structural redundancy, as provided by continuity of a girder

over interior supports bridges may be declassified so long as the following

conditions are met

a. Exterior Spans ≤ 250 feet

b. Interior Span ≤ 350 feet

c. Achieve an acceptable overstrength value (Ω≥1) under Grillage Analysis

4) If all the above conditions are not met a more rigorous analysis method should be

utilized (such as FEM).

7.3. Future Work 

The research results presented in this dissertation provide substantial information and data 

to support grillage analysis as an acceptable analysis method for steel twin tub girder 
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bridge post fracture of the exterior girder. However, there are many areas where this 

research could be supplemented with further research. Areas of additional research include 

the following: 

1. Improving compatibility between FEM and Grillage analysis results for single

span bridges by altering grillage method. The greatest amount of variation between

the two analysis methods occurred in the simple span bridges. Many times the

grillage analysis was significantly lower than that of the FEM analysis. This could

simply be due to the simplicity of the model but improvements to the model to

should be investigate to see if greater compatibility could be achieved between the

two methods for simple span bridges.

2. Strive to generate hinge moment curvature behavior more compatible with cross

section moment curvature response. The moment curvature behavior of hinges in

the grillage analysis are fairly accurate. However, due to limitations within

SAP2000, no regions with negative slope could be represented in the hinge

properties without crashing the program due to convergence issues. Investigating

how to incorporate the regions of negative sloping moment curvature response into

the hinge properties would be valuable.

3. Conducting a more comprehensive assessment of the effects of various variables

such as deck thickness, reinforcing bar area, and concrete strength on the

redundancy of the bridges. A brief study was completed as part of this research but

a more in depth assessment is warranted. It may be of value to change plate

thicknesses of the steel as another variable.
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4. Adjusting time of fracture initiation in grillage models. The FEM analysis initiates

the fracture of the exterior girder after all construction loads are applied. However,

due to software limitations, the grillage analysis method initiates the complete

girder fracture before construction loads are applied. This scenario does not

adequately represent how the bridge is loaded in the field. More time should be

invested into determining how to represent a more accurate fracture sequence in

the software.
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APPENDIX A 

STRUCTURAL DRAWINGS 
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BRIDGE 1: 12-102-3256-01-403 



180 



181 



182 



 

183 

 

 



 

184 

 

 

  



185 

BRIDGE 2: 12-102-0271-17-530 
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BRIDGE 3: 12-102-0508-01-294 
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BRIDGE 4: 12-102-0271-07-637 
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BRIDGE 5: 14-227-0-0015-13-452 
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BRIDGE 6: 12-102-0271-07-575 
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BRIDGE 7: 12-102-0177-07-394 
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BRIDGE 8: 12-102-0271-06-661 
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BRIDGE 9: 12-102-0177-07-394 
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BRIDGE 10: 14-227-0-0015-13-450 
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BRIDGE 11: 12-102-0271-07-593 
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BRIDGE 12: 12-102-0271-07-639 
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BRIDGE 13: 14-227-0-0015-13-452 
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BRIDGE 14: 18-057-0-0009-11-460 
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BRIDGE 15: 12-102-0271-06-689 
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APPENDIX B 

GRILLAGE HINGE PROPERTIES 
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Bridge 1: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.1 Long. Int. 2.1 

 M C M C M C M C 

Positive SF 325620 5.8E-05 301909 0.00019 409992 6E-05 382836 0.0002 

Negative SF 198418 5.8E-05 203118 6.4E-05 267269 6E-05 272043 6.7E-05 

Normalized 

Moment 

Curvature 

-1.36 -35 -1.38 -35 -1.36 -35 -1.38 -35 

-1.36 -23 -1.38 -23 -1.36 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.75 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.92 0.56 0.87 0.19 0.95 0.56 0.91 0.25 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Frac. Ext. 1.1 Frac. Int. 1.1 Trans.  Trans.End 

 M C M C M C M C 

Positive SF 12736 1.14E-04 1730 2.42E-03 1910 0.00187 371 0.00187 

Negative SF 1915 5.15E-04 2066 5.37E-04 1640 0.00187 316 0.00187 

Normalized 

Moment 

Curvature 

-1 -35 -1 -20 -1 -30 -1 -30 

-1 -23 -1 -10 -1 -22 -1 -22 

-1 -1 -1 -5 -1 -1 -1 -1 

-0.91 -0.22 -1 -1 -0.76 -0.22 -0.76 -0.22 

0 0 0 0 0 0 0 0 

1 1 0.88 0.22 0.76 0.22 0.77 0.14 

1 3 1 1 1 1 1 1 

1 5 1 5 1 3 1 3 

1 15 1 15 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 

 

Section Start (ft) End (ft) 

1.1 0 47 

2.1 47 166 

1.1 166 220 
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Bridge 2: Hinge and Section Data 

Long. Ext. 1.1 Long. Int. 1.1 Frac. Ext. 1.1 Frac. Int. 1.1 

M C M C M C M C 

Positive SF 250798 5.96E-05 221238 0.000154 13209 1.05E-04 1130 2.45E-3 

Negative SF 144085 5.96E-05 142720 6.91E-05 1844 7.36E-04 1611 5.44E-4 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.38 -35 -1 -35 -1 -20

-1.35 -25 -1.38 -25 -1 -22 -1 -10

-1 -1 -1 -1 -1 -1 -1 -1

-0.72 -0.56 -0.8 -0.56 -0.76 -0.36 -1 -1

0 0 0 0 0 0 0 0 

0.91 0.56 0.955 0.45 1 1 0.98 0.56 

1 1 1 1 1 3 1 1 

1 3 1 3 1 5 1 5 

1 13 1 13 1 15 1 15 

Trans. Trans.End 

M C M C 

Positive SF 1970 0.00168 1367 0.00168 

Negative SF 1598 0.00168 1104 0.00168 

Normalized 

Moment 

Curvature 

-1.1 -25 -1.1 -25

-1.1 -15 -1.1 -15

-1 -1 -1 -1

-0.76 -0.22 -0.76 -0.22

0 0 0 0 

0.76 0.22 0.76 0.22 

1 1 1 1 

1 3 1 3 

1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 

Section Start (ft) 
End 

(ft) 

1.1 0 115 
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Bridge 3: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.1 Long. Int. 2.1 

 M C M C M C M C 

Positive SF 469639 7.72E-05 454024 0.000203 556185 7.86E-05 539178 0.00016 

Negative SF 303757 4.96E-05 314564 5.22E-05 407572 5.05E-05 417493 5.3E-05 

Normalized 

Moment 

Curvature 

-1.36 -35 -1.37 -35 -1.37 -35 -1.38 -35 

-1.36 -23 -1.37 -23 -1.37 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.75 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.88 0.36 0.85 0.14 0.91 0.36 0.96 0.33 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 3.1 Long. Int. 3.1 Frac. Ext. 3.1 Frac. Int. 3.1 

 M C M C M C M C 

Positive SF 720943 5.36E-05 707906 0.000125 13389 1.30E-4 2978 1.99E-3 

Negative SF 528265 5.36E-05 540368 5.62E-05 2402 5.84E-4 2835 4.43E-4 

Normalized 

Moment 

Curvature 

-1.37 -35 -1.38 -35 -1 -35 -1 -20 

-1.37 -23 -1.38 -23 -1 -23 -1 -10 

-1 -1 -1 -1 -1 -1 -1 -3 

-0.7 -0.56 -0.8 -0.56 -0.9 -0.22 -1 -1 

0 0 0 0 0 0 0 0 

0.91 0.36 0.91 0.25 1 1 0.86 0.22 

1 1 1 1 1 3 1 1 

1 3 1 3 1 5 1 5 

1 13 1 13 1 15 1 15 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Trans Trans End 

 M C M C 

Positive SF 2325 0.002166 2166 0.002166 

Negative SF 1937 0.002166 1814 0.002166 

Normalized 

Moment 

Curvature 

-1.12 -30 -1.15 -30 

-1.12 -13 -1.15 -20 

-1 -1 -1 -1 

-0.76 -0.22 -0.76 -0.22 

0 0 0 0 

0.77 0.14 0.77 0.14 

1 1 1 1 

1 3 1 3 

1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 

 

Section Start (ft) End (ft) 

1.1 0 17 

2.1 17 38 

3.1 38 185 

2.1 185 206 

1.1 206 230 
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Bridge 4: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.2 Long. Int. 2.2 

 M C M C M C M C 

Positive SF 190121 8.16E-05 163477 0.000285 265333 4.94E-05 242505 0.00016 

Negative SF 97566 8.16E-05 102225 9.49E-05 143129 8.89E-05 147628 0.0001 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.35 -35 -1.4 -30 -1.4 -30 

-1.35 -25 -1.35 -25 -1.4 -20 -1.4 -20 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.86 -0.56 -0.92 -0.56 

0 0 0 0 0 0 0 0 

0.95 0.56 0.89 0.19 0.54 0.4 0.94 0.36 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 3.2 Long. Int. 3.2 Frac. Ext. 1.1 Frac. Int. 1.1 

 M C M C M C M C 

Positive SF 269552 8.63E-05 248898 0.00022 11005 1.04E-4 1361 2.26E-3 

Negative SF 199102 8.63E-05 201214 9.89E-05 1607 4.66E-4 1740 5.03E-4 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.35 -35 -1 -35 -1 -20 

-1.35 -25 -1.35 -25 -1 -25 -1 -10 

-1 -1 -1 -1 -1 -1 -1 -3 

-0.7 -0.56 -0.89 -0.56 -0.92 -0.22 -1 -1 

0 0 0 0 0 0 0 0 

0.95 0.56 0.93 0.25 1 1 1 1 

1 1 1 1 1 3 1 3 

1 3 1 3 1 5 1 5 

1 13 1 13 1 15 1 15 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Trans Trans End 1 Trans End 2 Trans Pier 

 M C M C M C M C 

Positive SF 2107 0.00152 1971 0.00152 1325 0.00152 3400 0.00152 

Negative SF 1745 0.00152 1633 0.00152 1094 0.00152 2822 0.00152 

Normalized 

Moment 

Curvature 

-1.2 -25 -1.2 -25 -1.2 -25 -1.2 -25 

-1.2 -15 -1.2 -15 -1.2 -15 -1.2 -15 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.76 -0.22 -0.76 -0.22 -0.76 -0.22 -0.76 -0.22 

0 0 0 0 0 0 0 0 

0.76 0.22 0.76 0.22 0.76 0.22 0.76 0.22 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 

 

Section Start (ft) End (ft) 

1.1 0 80 

2.2 80 108 

3.2 108 154 

2.2 154 182 

1.1 182 260 
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Bridge 5: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.2 Long. Int. 2.2 

 M C M C M C M C 

Positive SF 130422 0.000132 126415 0.000343 177826 0.000141 175804 0.000284 

Negative SF 80979 8.46E-05 84913 8.83E-05 115300 9.08E-05 120784 9.48E-05 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.35 -35 -1.35 -35 -1.35 -35 

-1.35 -25 -1.35 -25 -1.35 -25 -1.35 -25 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.97 0.64 0.85 0.14 0.936 0.36 0.85 0.14 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 3.2 Long. Int. 3.2 Long. Ext. 4.2 Long. Int. 4.2 

 M C M C M C M C 

Positive SF 180799 0.000138 178975 0.00027 204632 0.000139 203853 0.000278 

Negative SF 136766 8.88E-05 139570 9.23E-05 161921 8.93E-05 164301 9.26E-05 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.38 -35 -1.4 -35 -1.42 -35 

-1.35 -25 -1.38 -25 -1.4 -25 -1.42 -25 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.936 0.36 0.85 0.14 0.936 0.36 0.85 0.14 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Frac. Ext. 1.1 Frac. Int. 1.1 

Trans/Trans 

Pier 

Trans End 

1&2 

 M C M C M C M C 

Positive SF 5557 2.32E-4 1612 2.61E-3 1876 0.00168 890 0.00168 

Negative SF 1615 5.81E-4 1868 5.80E-4 1513 0.00168 714 0.00168 

Normalized 

Moment 

Curvature 

-1 -35 -1 -20 -1.1 -25 -1.1 -25 

-1 -20 -1 -10 -1.1 -15 -1.1 -15 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.83 -0.4 -1 -1 -0.76 -0.22 -0.76 -0.22 

0 0 0 0 0 0 0 0 

1 1 0.84 0.22 0.76 0.22 0.76 0.22 

1 3 1 1 1 1 1 1 

1 5 1 5 1 3 1 3 

1 15 1 15 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 

 

Section Start (ft) End (ft) 

1.1 0 91 

2.2 91 112 

3.2 112 126 

4.2 126 147 

3.2 147 161 

2.2 161 182 

1.1 182 280 
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Bridge 6: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.2 Long. Int. 2.2 

 M C M C M C M C 

Positive SF 326511 6.38E-05 300556 0.000159 473215 7.08E-05 438043 8.05E-05 

Negative SF 175770 6.38E-05 178676 7.16E-05 226048 7.08E-05 232720 8.05E-05 

Normalized 

Moment 

Curvature 

-1.37 -35 -1.38 -35 -1.4 -35 -1.45 -35 

-1.37 -25 -1.38 -25 -1.4 -20 -1.45 -17 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.97 0.64 0.85 0.14 0.936 0.36 0.85 0.14 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 3.2 Long. Int. 3.2 Frac. Ext. 1.1 Frac. Int. 1.1 

 M C M C M C M C 

Positive SF 481552 6.91E-05 451631 0.000121 15849 1.23E-4 1915 2.55E-3 

Negative SF 294883 6.91E-05 302235 7.76E-05 2130 5.55E-4 1139 3.96E-3 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.36 -35 -1 -35 -1 -20 

-1.38 -20 -1.36 -19 -1 -20 -1 -12 

-1 -1 -1 -1 -1 -1 -1 -2 

-0.7 -0.56 -0.8 -0.56 -0.83 -0.56 -1 -1 

0 0 0 0 0 0 0 0 

0.936 0.36 0.85 0.14 1 1 0.97 0.56 

1 1 1 1 1 1 1 1 

1 3 1 3 1 5 1 5 

1 13 1 13 1 15 1 15 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Trans/Trans 

Pier 

Trans End 

1&2 

 M C M C 

Positive SF 2422 0.0016 1211 0.0016 

Negative SF 2023 0.0016 1011 0.0016 

Normalized 

Moment 

Curvature 

-1.15 -25 -1.15 -25 

-1.15 -15 -1.15 -15 

-1 -1 -1 -1 

-0.76 -0.22 -0.76 -0.22 

0 0 0 0 

0.76 0.22 0.76 0.22 

1 1 1 1 

1 3 1 3 

1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 

 

Section Start (ft) End (ft) 

1.1 0 98 

2.2 98 119 

3.2 119 154 

2.2 154 175 

1.1 175 280 
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Bridge 7: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.1 Long. Int. 2.1 

 M C M C M C M C 

Positive SF 213076 7.09E-05 188227 0.000244 354649 7.85E-05 323880 0.000141 

Negative SF 121565 7.09E-05 120700 8.12E-05 226366 7.85E-05 225805 9.03E-05 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.37 -35 -1.35 -35 -1.35 -35 

-1.35 -25 -1.37 -25 -1.35 -25 -1.35 -20 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.97 0.64 0.87 0.19 0.936 0.36 0.93 0.36 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 3.1 Long. Int. 3.1 Long. Ext. 3.2 Long. Int. 3.2 

 M C M C M C M C 

Positive SF 297884 7.57E-05 265857 0.000194 298366 7.57E-05 266127 0.000136 

Negative SF 180976 7.57E-05 179504 8.71E-05 187592 7.57E-05 187181 8.71E-05 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.38 -35 -1.35 -35 -1.38 -35 

-1.35 -25 -1.38 -25 -1.35 -25 -1.38 -21 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.936 0.36 0.977 0.45 0.936 0.36 0.977 0.45 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Long. Ext. 4.1 Long. Int. 4.1 Long. Ext. 4.2 Long. Int. 4.2 

 M C M C M C M C 

Positive SF 297327 7.47E-05 266825 0.000187 297795 7.47E-05 268404 0.000187 

Negative SF 210110 7.47E-05 209302 8.43E-05 214882 7.47E-05 214860 8.43E-05 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.36 -35 -1.35 -35 -1.37 -35 

-1.35 -25 -1.36 -25 -1.35 -25 -1.37 -25 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.936 0.36 0.85 0.14 0.936 0.36 0.85 0.14 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 5.2 Long. Int. 5.2 Long. Ext. 6.1 Long. Int. 6.1 

 M C M C M C M C 

Positive SF 437012 7.92E-05 409104 0.000138 225491 7.18E-05 198753 0.000183 

Negative SF 355101 7.92E-05 354835 8.86E-05 127166 7.18E-05 126139 8.25E-05 

Normalized 

Moment 

Curvature 

-1.36 -35 -1.38 -35 -1.36 -35 -1.38 -35 

-1.36 -25 -1.38 -25 -1.36 -25 -1.38 -25 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.936 0.36 0.85 0.14 0.936 0.36 0.88 0.25 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Frac. Ext. 2.1  Frac. Int. 2.1 Frac. Ext. 6.1 Frac. Int. 6.1 

 M C M C M C M C 

Positive SF 11389 1.26E-4 1288 3.22E-3 11389 1.26E-4 1288 3.22E-3 

Negative SF 2220 5.66E-4 1999 4.60E-4 2220 5.66E-4 1999 4.60E-4 

Normalized 

Moment 

Curvature 

-1 -35 -1 -20 -1 -35 -1 -20 

-1 -20 -1 -10 -1 -20 -1 -10 

-1 -1 -1 -5 -1 -1 -1 -5 

-0.86 -0.22 -1 -1 -0.86 -0.22 -1 -1 

0 0 0 0 0 0 0 0 

1 1 0.93 0.36 1 1 0.93 0.36 

1 3 1 1 1 3 1 1 

1 5 1 5 1 5 1 5 

1 15 1 15 1 15 1 15 

 Trans Trans End 1 Trans End 2 Trans Pier 

 M C M C M C M C 

Positive SF 1683 0.00168 1938 0.00168 1810 0.00168 3844 0.00168 

Negative SF 1341 0.00168 1546 0.00168 1443 0.00168 3076 0.00168 

Normalized 

Moment 

Curvature 

-1.06 -25 -1.09 -25 -1.09 -25 -1.09 -25 

-1.06 -15 -1.09 -15 -1.09 -15 -1.09 -15 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.76 -0.22 -0.76 -0.22 -0.76 -0.22 -0.76 -0.22 

0 0 0 0 0 0 0 0 

0.76 0.22 0.76 0.22 0.76 0.22 0.76 0.22 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Section Start (ft) End (ft) 

1.1 0 18.5 

2.1 18.5 137.5 

3.1 137.5 144.5 

3.2 144.5 165.5 

4.2 165.5 186.5 

5.2 186.5 244 

4.2 244 272 

4.1 272 286 

6.1 286 377 

1.1 377 409 
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Bridge 8: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.1 Long. Int. 2.1 

 M C M C M C M C 

Positive SF 370539 5.49E-05 349445 0.000133 403697 5.59E-05 382149 0.000135 

Negative SF 233674 5.49E-05 243588 5.98E-05 257589 5.59E-05 267853 6.09E-05 

Normalized 

Moment 

Curvature 

-1.37 -35 -1.37 -35 -1.37 -35 -1.38 -35 

-1.37 -25 -1.37 -25 -1.37 -25 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.91 0.56 0.87 0.19 0.915 0.56 0.98 0.7 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 3.1 Long. Int. 3.1 Long. Ext. 4.2 Long. Int. 4.2 

 M C M C M C M C 

Positive SF 466905 5.82E-05 439859 0.000099 435027 5.73E-05 414385 0.000139 

Negative SF 287156 5.82E-05 298668 6.36E-05 273090 5.73E-05 289604 6.27E-05 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.39 -35 -1.35 -35 -1.39 -35 

-1.38 -25 -1.39 -25 -1.35 -25 -1.39 -25 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.924 0.56 0.97 0.64 0.936 0.36 0.96 0.45 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Long. Ext. 5.2 Long. Int. 5.2 Long. Ext. 6.2 Long. Int. 6.2 

M C M C M C M C 

Positive SF 471122 5.72E-05 450807 0.000138 538066 5.84E-05 513367 9.83E-05 

Negative SF 333928 5.72E-05 348645 6.21E-05 396561 5.84E-05 411494 6.32E-05 

Normalized 

Moment 

Curvature 

-1.37 -35 -1.38 -35 -1.37 -35 -1.38 -35

-1.37 -25 -1.38 -25 -1.37 -25 -1.38 -25

-1 -1 -1 -1 -1 -1 -1 -1

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56

0 0 0 0 0 0 0 0 

0.936 0.36 0.85 0.14 0.932 0.56 0.88 0.25 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Long. Ext. 7.1 Long. Int. 7.1 Frac. Ext. 3.1 Frac. Int. 3.1 

M C M C M C M C 

Positive SF 531378 5.93E-05 506462 0.0001 10423 1.04E-4 1636 2.39E-3 

Negative SF 356981 5.93E-05 368277 6.45E-05 1661 7.3E-4 2162 5.3E-4 

Normalized 

Moment 

Curvature 

-1.37 -35 -1.39 -35 -1 -35 -1 -20

-1.37 -25 -1.39 -25 -1 -22 -1 -10

-1 -1 -1 -1 -1 -1 -1 -5

-0.7 -0.56 -0.8 -0.56 -0.77 -0.36 -1 -1

0 0 0 0 0 0 0 0 

0.932 0.56 0.97 0.64 1 1 0.83 0.22 

1 1 1 1 1 3 1 1 

1 3 1 3 1 5 1 5 

1 13 1 13 1 15 1 15 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Frac. Ext. 7.1 Frac. Int. 7.1 

Trans/Trans 

Pier Trans End 1 

 M C M C M C M C 

Positive SF 10423 1.04E-4 1636 2.39E-3 1970 0.00168 857 0.00163 

Negative SF 1661 7.3E-4 2162 5.3E-4 1598 0.00168 697 0.00163 

Normalized 

Moment 

Curvature 

-1 -35 -1 -20 -1.09 -30 -1.09 -30 

-1 -22 -1 -10 -1.09 -22 -1.09 -20 

-1 -1 -1 -5 -1 -1 -1 -1 

-0.77 -0.36 -1 -1 -0.76 -0.22 -0.76 -0.22 

0 0 0 0 0 0 0 0 

1 1 0.83 0.22 0.76 0.22 0.76 0.22 

1 3 1 1 1 1 1 1 

1 5 1 5 1 3 1 3 

1 15 1 15 1 13 1 13 

 Trans End 2       

 M C       

Positive SF 1112 0.00168       

Negative SF 900 0.00168       

Normalized 

Moment 

Curvature 

-1.09 -25       

-1.09 -15       

-1 -1       

-0.76 -0.22       

0 0       

0.76 0.22       

1 1       

1 3       

1 13       
Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Section Start (ft) End (ft) 

1.1 0 20.5 

2.1 20.5 62.5 

3.1 62.5 139.5 

2.1 139.5 174.5 

4.2 174.5 202.5 

5.2 202.5 223.5 

6.2 223.5 300.5 

4.2 300.5 335.5 

2.1 335.5 363.5 

3.1 363.5 384.5 

7.1 384.5 489.5 

3.1 489.5 524.5 

1.1 524.5 560 
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Bridge 9: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 1.2 Long. Int. 1.2 

 M C M C M C M C 

Positive SF 207692 7.21E-05 183132 0.000249 207889 7.21E-05 184293 0.000249 

Negative SF 119209 7.21E-05 121462 8.29E-05 124631 7.21E-05 127592 8.29E-05 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.37 -35 -1.35 -35 -1.38 -35 

-1.35 -24 -1.37 -23 -1.35 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.91 0.56 0.87 0.19 0.92 0.56 0.98 0.52 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 2.2 Long. Int. 2.2 Long. Ext. 3.2 Long. Int. 3.2 

 M C M C M C M C 

Positive SF 236543 7.43E-05 210295 0.000191 270759 7.59E-05 242600 0.000195 

Negative SF 137495 7.43E-05 140681 0.000086 168541 7.59E-05 171669 8.78E-05 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.39 -35 -1.35 -35 -1.39 -35 

-1.38 -25 -1.39 -25 -1.35 -25 -1.39 -25 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.93 0.56 0.97 0.64 0.939 0.56 0.96 0.45 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Frac. Ext. 3.1  Frac. Int. 3.1 Trans 

Trans Pier 

1&2 

 M C M C M C M C 

Positive SF 10410 1.20E-4 1386 2.45E-3 1970 0.00168 1588 0.00163 

Negative SF 1613 8.37E-4 1628 5.45E-4 1598 0.00168 1291 0.00163 

Normalized 

Moment 

Curvature 

-1 -35 -1 -20 -1.09 -30 -1.1 -30 

-1 -22 -1 -10 -1.09 -22 -1.1 -20 

-1 -1 -1 -5 -1 -1 -1 -1 

-0.8 -0.36 -1 -1 -0.76 -0.22 

-

0.76 -0.22 

0 0 0 0 0 0 0 0 

1 1 0.875 0.22 0.76 0.22 0.76 0.22 

1 3 1 1 1 1 1 1 

1 5 1 5 1 3 1 3 

1 15 1 15 1 13 1 13 

 Trans End 1&2       

 M C       

Positive SF 985 0.00163       

Negative SF 799 0.00163       

Normalized 

Moment 

Curvature 

-1.09 -30       

-1.09 -20       

-1 -1       

-0.76 -0.22       

0 0       

0.76 0.22       

1 1       

1 3       

1 13       
Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Section Start (ft) End (ft) 

1.1 0 77 

1.2 77 91 

2.2 91 119 

3.2 119 145.5 

2.2 145.5 173.5 

1.1 173.5 243.5 

2.2 243.5 271.5 

3.2 271.5 298 

2.2 298 326 

1.2 326 333 

1.1 333 417 
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Bridge 10: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.2 Long. Int. 2.2 

 M C M C M C M C 

Positive SF 217603 9.71E-05 212466 0.000254 278214 0.000103 270328 0.000208 

Negative SF 140128 6.24E-05 142863 6.53E-05 179860 0.000066 183001 6.94E-05 

Normalized 

Moment 

Curvature 

-1.36 -35 -1.37 -35 -1.35 -35 -1.38 -35 

-1.36 -24 -1.37 -23 -1.35 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.966 0.64 0.84 0.14 0.92 0.56 0.98 0.52 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 3.1 Long. Int. 3.1 Long. Ext. 3.2 Long. Int. 3.2 

 M C M C M C M C 

Positive SF 296612 0.000104 286104 0.000157 298104 0.000104 288148 0.000157 

Negative SF 178276 6.71E-05 181632 7.05E-05 188232 6.71E-05 191464 7.05E-05 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.39 -35 -1.37 -35 -1.39 -35 

-1.38 -25 -1.39 -25 -1.37 -25 -1.39 -25 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.97 0.64 0.97 0.64 0.885 0.36 0.96 0.45 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Long. Ext. 4.2 Long. Int. 4.2 Long. Ext. 5.2 Long. Int. 5.2 

 M C M C M C M C 

Positive SF 384584 0.000108 375509 0.000113 392385 0.000105 383816 0.000156 

Negative SF 281405 6.95E-05 284502 7.28E-05 320221 6.73E-05 322860 7.01E-05 

Normalized 

Moment 

Curvature 

-1.37 -35 -1.39 -35 -1.38 -35 -1.39 -35 

-1.37 -25 -1.39 -23 -1.38 -25 -1.39 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.885 0.36 0.96 0.45 0.885 0.36 0.96 0.45 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 6.2 Long. Int. 6.2 Long. Ext. 7.2 Long. Int. 7.2 

 M C M C M C M C 

Positive SF 409398 0.000106 402775 0.000158 40078 0.000109 393203 0.00115 

Negative SF 331376 6.81E-05 333892 7.09E-05 289823 7.03E-05 293010 7.36E-05 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.38 -35 -1.38 -35 -1.38 -35 

-1.38 -25 -1.38 -23 -1.38 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.885 0.36 0.96 0.45 0.919 0.36 0.96 0.45 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Long. Ext. 8.1 Long. Int. 8.1 Long. Ext. 8.2 Long. Int. 8.2 

 M C M C M C M C 

Positive SF 311592 0.000106 300765 0.000111 314537 0.000106 306241 0.000159 

Negative SF 186784 6.81E-05 190210 7.15E-05 196656 6.81E-05 199977 7.15E-05 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.38 -35 -1.38 -35 -1.38 -35 

-1.38 -23 -1.38 -23 -1.38 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.88 0.36 0.96 0.45 0.88 0.36 0.977 0.64 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 9.1 Long. Int. 9.1 Long. Ext. 10.1 Long. Int. 10.1 

 M C M C M C M C 

Positive SF 286913 0.000103 276390 0.000155 267679 0.000102 257893 0.000152 

Negative SF 172623 6.64E-05 175858 6.96E-05 164251 6.53E-05 167380 6.85E-05 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.38 -35 -1.38 -35 -1.38 -35 

-1.38 -23 -1.38 -23 -1.38 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.88 0.36 0.955 0.45 0.87 0.36 0.955 0.45 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Long. Ext. 11.2 Long. Int. 11.2 Long. Ext. 12.2 Long. Int. 12.2 

 M C M C M C M C 

Positive SF 321647 0.000103 312965 0.000207 462765 0.00011 460216 0.000164 

Negative 

SF 238811 6.06E-05 241427 6.89E-05 368211 7.05E-05 371099 7.36E-05 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.38 -35 -1.38 -35 -1.38 -35 

-1.38 -23 -1.38 -23 -1.38 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.87 0.36 0.955 0.45 0.93 0.36 0.955 0.45 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Frac. Ext. 1.1 Frac. Int. 1.1 Frac. Ext. 2.2 Frac. Int. 2.2 

 M C M C M C M C 

Positive SF 4870 2.69E-4 1288 3.14E-3 7056 2.69E-4 1597 2.02E-3 

Negative 

SF 1882 6.73E-4 1963 4.48E-4 2966 6.73E-4 2950 4.48E-4 

Normalized 

Moment 

Curvature 

-1 -35 -1 -20 -1 -35 -1 -20 

-1 -20 -1 -10 -1 -20 -1 -10 

-1 -1 -1 -3 -1 -1 -1 -5 

-0.86 -0.4 -1 -1 -0.7 -0.4 -1 -1 

0 0 0 0 0 0 0 0 

1 1 0.93 0.36 1 1 0.88 0.56 

1 3 1 1 1 3 1 1 

1 5 1 5 1 5 1 5 

1 15 1 15 1 15 1 15 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Frac. Ext. 3.1 Frac. Int. 3.1 Trans Trans End 1&2 

 M C M C M C M C 

Positive SF 4870 2.69E-4 1288 3.14E-3 1683 0.00163 1810 0.00163 

Negative SF 1882 6.73E-4 1963 4.48E-4 1341 0.00163 1443 0.00163 

Normalized 

Moment 

Curvature 

-1 -35 -1 -20 -1.09 -30 -1.09 -30 

-1 -20 -1 -10 -1.09 -22 -1.09 -20 

-1 -1 -1 -3 -1 -1 -1 -1 

-0.86 -0.4 -1 -1 -0.76 -0.22 -0.76 -0.22 

0 0 0 0 0 0 0 0 

1 1 0.93 0.36 0.76 0.22 0.76 0.22 

1 3 1 1 1 1 1 1 

1 5 1 5 1 3 1 3 

1 15 1 15 1 13 1 13 

 Trans Pier 1&2       

 M C       

Positive SF 2573 0.00168       

Negative SF 2056 0.00168       

Normalized 

Moment 

Curvature 

-1.1 -30       

-1.1 -20       

-1 -1       

-0.76 -0.22       

0 0       

0.76 0.22       

1 1       

1 3       

1 13       
Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Section Start (ft) End (ft) 

1.1 0 53 

2.2 53 95 

3.2 95 102 

4.2 102 116 

5.2 116 123 

6.2 123 161.5 

7.2 161.5 175.5 

8.2 175.5 210.5 

9.1 210.5 217.5 

10.1 217.5 238.5 

3.1 238.5 294.5 

10.1 294.5 315.5 

9.1 315.5 322.5 

8.1 322.5 343.5 

8.2 343.5 364.5 

11.1 364.5 378.5 

6.2 378.5 399.5 

12.2 399.5 424 

6.2 424 438 

11.2 438 459 

3.2 459 494 

1.1 494 603 
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Bridge 11: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 1.2 Long. Int. 1.2 

 M C M C M C M C 

Positive SF 447209 5.19E-05 408675 9.05E-05 448318 5.19E-05 411855 9.05E-05 

Negative SF 247199 5.19E-05 250474 5.82E-05 255876 5.19E-05 259154 5.82E-05 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.39 -35 -1.38 -35 -1.38 -35 

-1.38 -24 -1.39 -23 -1.38 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.91 0.56 0.86 0.36 0.9 0.56 0.96 0.64 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 2.2 Long. Int. 2.2 Long. Ext. 3.2 Long. Int. 3.2 

 M C M C M C M C 

Positive SF 530622 5.46E-05 472660 6.18E-05 539602 5.22E-05 508662 8.94E-05 

Negative SF 293839 5.46E-05 296990 6.18E-05 387820 5.22E-05 390551 5.75E-05 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.37 -35 -1.37 -35 -1.39 -35 

-1.38 -23 -1.37 -21 -1.37 -23 -1.39 -25 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.92 0.56 0.91 0.56 0.92 0.56 0.96 0.45 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Long. Ext. 4.2 Long. Int. 4.2 Long. Ext. 5.1 Long. Int. 5.1 

 M C M C M C M C 

Positive SF 802228 5.61E-05 774300 9.56E-05 535682 5.36E-05 494752 9.34E-05 

Negative SF 624428 5.61E-05 626681 6.14E-05 326054 5.36E-05 329068 0.00006 

Normalized 

Moment 

Curvature 

-1.37 -35 -1.4 -35 -1.37 -35 -1.36 -35 

-1.37 -23 -1.4 -23 -1.37 -23 -1.36 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.92 0.56 0.977 0.64 0.92 0.56 0.977 0.64 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 5.2 Long. Int. 5.2 Long. Ext. 6.1 Long. Int. 6.1 

 M C M C M C M C 

Positive SF 537206 5.36E-05 498665 9.34E-05 539611 0.000053 503906 9.17E-05 

Negative SF 335055 5.36E-05 338073 0.00006 351542 0.000053 354478 0.000059 

Normalized 

Moment 

Curvature 

-1.37 -35 -1.39 -35 -1.37 -35 -1.39 -35 

-1.37 -23 -1.39 -23 -1.37 -23 -1.39 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.92 0.56 0.977 0.64 0.92 0.56 0.977 0.64 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Frac. Ext. 1.2 Frac. Int. 1.2 Frac. Ext. 6.1 Frac. Int. 6.1 

 M C M C M C M C 

Positive SF 15220 1.09E-4 1584 2.29E-3 11569 1.09E-4 1347 2.29E-3 

Negative SF 2476 4.91E-4 2458 5.09E-4 1859 4.91E-4 1799 5.09E-4 

Normalized 

Moment 

Curvature 

-1 -35 -1 -20 -1 -35 -1 -20 

-1 -22 -1 -11 -1 -22 -1 -10 

-1 -1 -1 -5 -1 -1 -1 -5 

-0.7 -0.22 -1 -1 -0.88 -0.22 -1 -1 

0 0 0 0 0 0 0 0 

1 1 0.93 0.56 1 1 0.87 0.22 

1 3 1 1 1 3 1 1 

1 5 1 5 1 5 1 5 

1 15 1 15 1 15 1 15 

 Trans Trans End 1 Trans End 2 Trans Pier 1 

 M C M C M C M C 

Positive SF 1683 0.00168 663 0.00168 407 0.00168 1810 0.00168 

Negative SF 1341 0.00168 524 0.00168 319 0.00168 1443 0.00168 

Normalized 

Moment 

Curvature 

-1.06 -30 -1.09 -30 -1.09 -30 -1.1 -30 

-1.06 -22 -1.09 -20 -1.09 -20 -1.1 -20 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.76 -0.22 -0.76 -0.22 -0.76 -0.22 -0.76 -0.22 

0 0 0 0 0 0 0 0 

0.76 0.22 0.76 0.22 0.76 0.22 0.76 0.22 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 

 



335 

Trans Pier 2 

M C 

Positive SF 1556 0.00168 

Negative 

SF 1239 0.00168 

Normalized 

Moment 

Curvature 

-

1.05 -30

-

1.05 -22

-1 -1

-

0.76 -0.22

0 0 

0.76 0.22 

1 1 

1 3 

1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 

Section Start (ft) End (ft) 

1.1 0 62.5 

1.2 62.5 118.5 

2.2 118.5 153.5 

3.2 153.5 167.5 

4.2 167.5 245 

3.2 245 280 

5.2 280 315 

5.1 315 336 

6.1 336 462 

5.1 462 490 

5.2 490 518 

3.2 518 553 

4.2 553 629.5 

3.2 629.5 650.5 

2.2 650.5 678.5 

1.2 678.5 734.5 

1.1 734.5 824 
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Bridge 12: Hinge and Section Data 

Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.2 Long. Int. 2.2 

M C M C M C M C 

Positive SF 177808 8.01E-05 150041 0.000279 265809 4.91E-05 242338 0.00016 

Negative SF 91919 8.01E-05 95191 9.29E-05 148519 8.83E-05 152662 0.000103 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.36 -35 -1.39 -35 -1.38 -35

-1.38 -24 -1.36 -23 -1.39 -21 -1.38 -19

-1 -1 -1 -1 -1 -1 -1 -1

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56

0 0 0 0 0 0 0 0 

0.93 0.56 0.89 0.19 0.54 0.4 0.91 0.56 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Long. Ext. 3.2 Long. Int. 3.2 Frac. Ext. 1.1 Frac. Int. 1.1 

M C M C M C M C 

Positive SF 271522 8.54E-05 249832 0.000216 9162 1.04E-4 1291 3.40E-3 

Negative SF 206366 8.54E-05 208809 9.71E-05 1456 1.04E-4 1448 4.86E-4 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.37 -35 -1 -35 -1 -20

-1.35 -23 -1.37 -23 -1 -22 -1 -11

-1 -1 -1 -1 -1 -5 -1 -5

-0.7 -0.56 -0.8 -0.56 -1 -1 -1 -1

0 0 0 0 0 0 0 0 

0.92 0.56 0.96 0.45 1 1 0.86 0.14 

1 1 1 1 1 3 1 1 

1 3 1 3 1 5 1 5 

1 13 1 13 1 15 1 15 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Trans Trans End 1 Trans End 2 Trans Pier 1 

 M C M C M C M C 

Positive SF 2107 0.00152 1053 0.00152 1836 0.00152 1836 0.00152 

Negative SF 1745 0.00152 872 0.00152 1522 0.00152 1522 0.00152 

Normalized 

Moment 

Curvature 

-1.12 -30 -1.12 -30 -1.13 -30 -1.13 -30 

-1.12 -22 -1.12 -21 -1.13 -21 -1.13 -21 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.76 -0.22 -0.76 -0.22 -0.76 -0.22 -0.76 -0.22 

0 0 0 0 0 0 0 0 

0.76 0.22 0.76 0.22 0.76 0.22 0.76 0.22 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Trans Pier 2       

 M C       

Positive SF 2618 0.00152       

Negative SF 2172 0.00152       

Normalized 

Moment 

Curvature 

-1.13 -30       

-1.13 -21       

-1 -1       

-0.76 -0.22       

0 0       

0.76 0.22       

1 1       

1 3       

1 13       
Note: M=Moment (kip-in.) and C=Curvature (1/in.) 

 

  

Section Start (ft) End (ft) 

1.1 0 84 

2.2 84 112 

3.2 112 153 

2.2 153 181 

1.1 181 258 

2.2 258 286 

3.2 286 336.5 

2.2 336.5 364.5 

1.1 364.5 465 
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Bridge 13: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.1 Long. Int. 2.1 

 M C M C M C M C 

Positive SF 141226 0.000132 137479 0.000344 131426 0.00013 127379 0.000338 

Negative SF 94747 0.000085 96545 8.84E-05 89122 8.37E-05 90702 0.000087 

Normalized 

Moment 

Curvature 

-1.38 -35 -1.38 -35 -1.39 -35 -1.4 -35 

-1.38 -24 -1.38 -23 -1.39 -23 -1.4 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.97 0.64 0.89 0.19 0.88 0.36 0.91 0.56 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 3.2 Long. Int. 3.2 Long. Ext. 4.2 Long. Int. 4.2 

 M C M C M C M C 

Positive SF 183037 0.000141 181343 0.000282 206928 9.14E-05 204910 0.000285 

Negative SF 127072 9.04E-05 130833 9.41E-05 154578 9.14E-05 158006 0.000095 

Normalized 

Moment 

Curvature 

-1.36 -35 -1.37 -35 -1.36 -35 -1.37 -35 

-1.36 -23 -1.37 -23 -1.36 -23 -1.37 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.8 -0.56 -0.83 -0.56 

0 0 0 0 0 0 0 0 

0.93 0.36 0.97 0.52 0.93 0.56 0.96 0.33 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Long. Ext. 5.2 Long. Int. 5.2 Frac. Ext. 2.1 Frac. Int. 2.1 

 M C M C M C M C 

Positive SF 255210 9.29E-05 251558 0.000214 4670 2.45E-4 1313 3.58E-3 

Negative 

SF 206924 9.29E-05 209171 9.61E-05 1517 1.10E-4 1654 5.11E-4 

Normalized 

Moment 

Curvature 

-1.36 -35 -1.39 -35 -1 -35 -1 -20 

-1.36 -23 -1.39 -23 -1 -18 -1 -10 

-1 -1 -1 -1 -1 -1 -1 -5 

-0.85 -0.56 -0.83 -0.56 -0.84 -0.22 -1 -1 

0 0 0 0 0 0 0 0 

0.95 0.56 0.97 0.45 1 1 0.95 0.36 

1 1 1 1 1 3 1 1 

1 3 1 3 1 5 1 5 

1 13 1 13 1 15 1 15 

 Trans  Trans End 1&2 Trans Pier 1&2   

 M C M C M C   

Positive SF 1683 0.00168 523 0.00168 2430 0.00168   
Negative 

SF 1341 0.00168 415 0.00168 1946 0.00168   

Normalized 

Moment 

Curvature 

-1.06 -30 -1.05 -30 -1.06 -30   

-1.06 -22 -1.05 -21 -1.06 -21   

-1 -1 -1 -1 -1 -1   

-0.76 -0.22 -0.76 -0.22 -0.76 -0.22   

0 0 0 0 0 0   

0.76 0.22 0.76 0.22 0.76 0.22   

1 1 1 1 1 1   

1 3 1 3 1 3   

1 13 1 13 1 13   
Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Section Start (ft) End (ft) 

1.1 0 12.75 

2.1 12.75 89.75 

1.1 89.75 96.75 

3.2 96.75 124.75 

4.2 124.75 131.75 

5.2 131.75 162.5 

4.2 162.5 169.5 

3.2 169.5 197.5 

1.1 197.5 204.5 

2.1 204.5 281.5 

1.1 281.5 288.5 

3.2 295.5 316.5 

4.2 316.5 323.5 

5.2 323.5 354.5 

4.2 354.5 361.25 

3.2 361.5 389.25 

1.1 389.25 396.25 

2.1 396.25 473.25 

1.1 473.25 439 
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Bridge 14: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 2.1 Long. Int. 2.1 

 M C M C M C M C 

Positive SF 173059 0.000077 141867 0.000273 212111 8.09E-05 179280 0.000215 

Negative SF 92595 0.000077 95620 9.09E-05 105407 8.09E-05 111621 9.69E-05 

Normalized 

Moment 

Curvature 

-1.34 -35 -1.36 -35 -1.39 -35 -1.35 -35 

-1.34 -23 -1.36 -23 -1.39 -23 -1.35 -21 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.92 0.56 0.87 0.19 0.95 0.56 0.91 0.25 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 3.2 Long. Int. 3.2 Long. Ext. 4.2 Long. Int. 4.2 

 M C M C M C M C 

Positive SF 216831 8.15E-05 185714 0.000271 250576 8.53E-05 222027 0.000161 

Negative SF 117869 8.15E-05 122621 9.75E-05 123737 8.53E-05 131276 0.000103 

Normalized 

Moment 

Curvature 

-1.36 -35 -1.37 -35 -1.39 -35 -1.37 -35 

-1.36 -23 -1.37 -23 -1.39 -21 -1.37 -19 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.8 -0.56 -0.83 -0.56 

0 0 0 0 0 0 0 0 

0.95 0.56 0.97 0.45 0.98 0.56 0.96 0.33 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Long. Ext. 5.2 Long. Int. 5.2 Frac. Ext. 1.1 Frac. Int. 1.1 

M C M C M C M C 

Positive SF 254768 8.39E-05 226322 0.000221 9168 1.04E-4 1220 2.28E-3 

Negative 

SF 162599 8.39E-05 166674 9.96E-05 1539 1.04E-4 1522 5.06E-4 

Normalized 

Moment 

Curvature 

-1.35 -35 -1.38 -35 -1 -35 -1 -20

-1.35 -23 -1.38 -23 -1 -23 -1 -10

-1 -1 -1 -1 -1 -5 -1 -5

-0.85 -0.56 -0.83 -0.56 -1 -1 -1 -1

0 0 0 0 0 0 0 0 

0.98 0.56 0.97 0.45 1 1 0.88 0.22 

1 1 1 1 1 3 1 1 

1 3 1 3 1 5 1 5 

1 13 1 13 1 15 1 15 

Trans Trans End 1&2 Trans Pier 1&2 

M C M C M C 

Positive SF 1683 0.00168 297 0.002611 2192 0.00168 

Negative 

SF 1341 0.00168 216 0.00168 1750 0.00168 

Normalized 

Moment 

Curvature 

-1.06 -30 -1 -30 -1.06 -30

-1.06 -22 -1 -21 -1.06 -21

-1 -1 -1 -1 -1 -1

-0.76 -0.22 -0.76 -0.22 -0.76 -0.22

0 0 0 0 0 0 

0.76 0.22 0.77 0.14 0.76 0.22 

1 1 1 1 1 1 

1 3 1 3 1 3 

1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Bridge 15: Hinge and Section Data 

 Long. Ext. 1.1 Long. Int. 1.1 Long. Ext. 1.2 Long. Int. 1.2 

 M C M C M C M C 

Positive SF 323409 5.78E-05 293107 0.000147 323958 5.78E-05 295102 0.000147 

Negative SF 203763 5.78E-05 207149 6.61E-05 212854 5.78E-05 216195 6.61E-05 

Normalized 

Moment 

Curvature 

-1.36 -35 -1.38 -35 -1.36 -35 -1.38 -35 

-1.36 -23 -1.38 -23 -1.36 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.91 0.56 0.87 0.19 0.91 0.56 0.87 0.19 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 2.1 Long. Int. 2.1 Long. Ext. 2.2 Long. Int. 2.2 

 M C M C M C M C 

Positive SF 384229 5.99E-05 350980 0.000153 385000 5.99E-05 350195 0.000107 

Negative SF 246757 5.99E-05 250145 6.88E-05 256878 5.99E-05 260221 6.88E-05 

Normalized 

Moment 

Curvature 

-1.36 -35 -1.38 -35 -1.36 -35 -1.38 -35 

-1.36 -23 -1.38 -23 -1.36 -23 -1.38 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.7 -0.56 -0.8 -0.56 

0 0 0 0 0 0 0 0 

0.95 0.56 0.91 0.25 0.95 0.56 0.91 0.25 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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 Long. Ext. 3.2 Long. Int. 3.2 Long. Ext. 4.2 Long. Int. 4.2 

 M C M C M C M C 

Positive SF 415986 6.06E-05 383112 0.000155 448197 0.000061 411657 0.000108 

Negative SF 285021 6.06E-05 288302 6.96E-05 326085 0.000061 329189 6.95E-05 

Normalized 

Moment 

Curvature 

-1.36 -35 -1.38 -35 -1.37 -35 -1.39 -35 

-1.36 -23 -1.38 -23 -1.37 -23 -1.39 -23 

-1 -1 -1 -1 -1 -1 -1 -1 

-0.7 -0.56 -0.8 -0.56 -0.8 -0.56 -0.83 -0.56 

0 0 0 0 0 0 0 0 

0.95 0.56 0.97 0.45 0.98 0.56 0.96 0.33 

1 1 1 1 1 1 1 1 

1 3 1 3 1 3 1 3 

1 13 1 13 1 13 1 13 

 Long. Ext. 5.2 Long. Int. 5.2 Frac. Ext. 1.1 Frac. Int. 1.1 

 M C M C M C M C 

Positive SF 582446 4.79E-05 550752 9.82E-05 12087 1.15E-4 1347 2.12E-3 

Negative SF 469228 8.62E-05 471302 9.82E-05 2126 8.06E-4 2067 4.72E-4 

Normalized 

Moment 

Curvature 

-1.24 -35 -1.25 -35 -1 -35 -1 -20 

-1.24 -19 -1.25 -17 -1 -23 -1 -10 

-1 -1 -1 -1 -1 -1 -1 -5 

-0.85 -0.56 -0.96 -0.56 -0.78 -0.36 -1 -1 

0 0 0 0 0 0 0 0 

0.55 0.4 0.96 0.56 1 1 0.77 0.22 

1 1 1 1 1 3 1 1 

1 3 1 3 1 5 1 5 

1 13 1 13 1 15 1 15 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Frac. Ext. 2.1 Frac. Int. 2.1 Trans 

Trans End 

1&2 

M C M C M C M C 

Positive SF 12087 1.15E-4 1347 2.12E-3 1970 0.00168 1588 0.00168 

Negative SF 2126 8.06E-4 2067 4.72E-4 1598 0.00168 1291 0.00168 

Normalized 

Moment 

Curvature 

-1 -35 -1 -20

-

1.06 -30

-

1.11 -30

-1 -23 -1 -10

-

1.06 -22

-

1.11 -22

-1 -1 -1 -5 -1 -1 -1 -1

-0.78 -0.36 -1 -1

-

0.76 -0.22

-

0.76 -0.22

0 0 0 0 0 0 0 0 

1 1 0.77 0.22 0.76 0.22 0.77 0.14 

1 3 1 1 1 1 1 1 

1 5 1 5 1 3 1 3 

1 15 1 15 1 13 1 13 

Trans Pier 1&2 

M C 

Positive SF 2701 0.00168 

Negative SF 2193 0.00168 

Normalized 

Moment 

Curvature 

-1.09 -30

-1.09 -21

-1 -1

-0.76 -0.22

0 0 

0.76 0.22 

1 1 

1 3 

1 13 

Note: M=Moment (kip-in.) and C=Curvature (1/in.) 
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Section Start (ft) End (ft) 

1.1 0 100 

2.1 100 114 

2.2 114 135 

3.2 135 156 

4.2 156 177 

5.2 177 207.5 

4.2 207.5 228.5 

3.2 228.5 249.5 

1.2 249.5 256.5 

1.1 256.5 277.5 

2.1 277.5 410.5 

1.1 410.5 424.5 

1.2 424.5 431.5 

3.2 431.5 452.5 

4.2 452.5 473.5 

5.2 473.5 504 

4.2 504 525 

3.2 525 546 

2.2 546 567 

1.1 567 695 
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APPENDIX C 

GRILLAGE DESIGN EXAMPLES 

  

                                                 

 Part of this chapter is reprinted with permission from “Analysis Guidelines and Examples for Fracture 

Critical Steel Twin Tub Girder Bridges” 0-6937-P1 by Hurlebaus S., Mander J., Terzioglu T., Boger N., 

Fatima A., 2018. Texas A&M Texas Transportation Institute, 26-48, 60-82, 99-123, Copyright 2018 by 

Texas A&M Texas Transportation Institute 
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Grillage Analysis Example of Bridge 2 

1. Gather Bridge Geometry and Material Information.

Steel Tub Properties (fy=50 ksi) 

Location 

ft 

Top Flange Web Bottom Flange 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

Width 

in. 

Thickness 

in. 

0-115 18 1.00 79 0.625 50 1.00 

Location Parameter Description/Value 

Bridge 

Location 
Harris County, 

I610 

Year Designed/Year Built 2002/2004 

Design Load HS25 

Length, ft 115 

Spans, ft 115 

Radius of Curvature, ft 1909.86 

Deck 

Width, ft 26.417 

Thickness, in. 8 

Haunch, in. 4 

Rail Type SSTR 

Rebar 

# of Bar Longitudinal Top Row (#5) 40 

# of Bar Longitudinal Bottom Row (#5) 32 

Transverse Spacing Top Row (#5) 5 

Transverse Spacing Bottom Row (#5) 5 

Rebar Strength (ksi) 60 

Girder 

CL of Bridge to CL of Girder (in.) 79.5 

CL of Top Flange to CL of Top Flange 

(in.) 
86 
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2. Material constitutive behavior 

Concrete (4 ksi)  Rebar (60 ksi)  Steel (50 ksi) 

Stress 

(ksi) 

Strain 

(1/in)  

Stress 

(ksi) 

Strain 

(1/in)  

Stress 

(ksi) 

Strain 

(1/in) 

-4 -3.79E-03  -87.9 -0.095  -71.6 -0.1 

-4 -3.56E-03  -87.9 -0.0944  -71.6 -0.097 

-4 -2.69E-03  -86.6 -0.0761  -71.6 -0.095 

-4 -1.78E-03  -78 -0.0386  -71.6 -0.0946 

-3.8205 -1.40E-03  -60.7 -9.80E-03  -70.3 -0.0764 

-2.8718 -8.69E-04  -60.3 -2.08E-03  -62.5 -0.039 

-0.6403 -1.78E-04  0 0  -50 -0.0196 

0 0  60.3 2.08E-03  -50 -1.72E-03 

0.378 1.06E-04  60.7 9.80E-03  0 0 

0.378 1.16E-03  78 0.0386  50 1.72E-03 

   86.6 0.0761  50 0.0196 

   87.9 0.0944  62.5 0.039 

   87.9 0.095  70.3 0.0764 

      71.6 0.0946 

      71.6 0.095 

      71.6 0.097 

      71.6 0.1 

 

 

3. Create a Coordinate system for half width of  the span 

 

 



350 

4. Create a cylindrical coordinate system for the curved bridge assuring that the

middle transverse divisions are 7 ft, as this will aid is applying the HS20 truck

load whose axels are separated by 14 ft.

a. # 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠 = (
𝐿𝑒𝑛𝑔𝑡ℎ (𝑓𝑡)∗12

84 𝑖𝑛 (7𝑓𝑡)
)  𝑟𝑜𝑢𝑛𝑑𝑒𝑑 𝑡𝑜 𝑛𝑒𝑎𝑟𝑒𝑠𝑡 𝑒𝑣𝑒𝑛 𝑛𝑢𝑚𝑏𝑒𝑟 

i. # 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠 = (
115∗12

84
) = 16.428 𝑠𝑜 14 𝑤𝑎𝑠 𝑠𝑒𝑙𝑒𝑐𝑡𝑒𝑑 

b. 𝐸𝑛𝑑 𝑆𝑒𝑔𝑚𝑒𝑛𝑡 𝐿𝑒𝑛𝑔𝑡ℎ = ((𝐿𝑒𝑛𝑔𝑡ℎ ∗ 12) − (# 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠 ∗ 84))/2

i. 𝐸𝑛𝑑 𝑆𝑒𝑔𝑚𝑒𝑛𝑡 𝐿𝑒𝑛𝑔𝑡ℎ =
((115∗12)−(14∗84))

2
= 102 𝑖𝑛. 

c. 𝑇ℎ𝑒𝑡𝑎 =
𝐿𝑒𝑛𝑔𝑡ℎ

𝑅𝑎𝑑𝑖𝑢𝑠

i. 𝑇ℎ𝑒𝑡𝑎 =
115

1909.86
= 0.0602 𝑟𝑎𝑑 𝑜𝑟 3.450 𝑑𝑒𝑔𝑟𝑒𝑒𝑠 

d. Determine the radial offsets using the outside edge, the outside flange, the

inner flange and centerline of the bridge.

Offsets (in.) 

Edge 158.5 

Outside Flange 122.5 

Inner Flange 36.5 

CL of Bridge 0 
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Radial Spacing (in.) 

A 23077.3 CL+Edge 

B 23041.3 CL+OF 

C 22955.3 CL+IF 

Center Line 22918.8 or 1909.86 (ft) 

D 22882.3 CL-IF

E 22796.3 CL-OF

F 22760.3 CL-Edge

a. The Longitudinal or spacing along theta is determined by converting the

longitudinal segment lengths into degrees.

i. The first and last segments are 102 in. and the intermediate

segments are 84 in. The total length is 115 ft or 1380 in.

ii. 𝑅𝑎𝑑𝑖𝑎𝑙 𝑆𝑝𝑎𝑐𝑖𝑛𝑔 (𝑟𝑎𝑑) =
𝐿𝑜𝑛𝑔.𝑆𝑝𝑎𝑐𝑖𝑛𝑔

𝑅𝑎𝑑𝑖𝑢𝑠

iii. 𝑅𝑎𝑑𝑖𝑎𝑙 𝑆𝑝𝑎𝑐𝑖𝑛𝑔 (𝑑𝑒𝑔𝑟𝑒𝑒) = 𝑅𝑎𝑑𝑖𝑢𝑠 𝑆𝑝𝑎𝑐𝑖𝑛𝑔 (𝑟𝑎𝑑) ∗
180

𝜋

Long. 

Spacing (in.) 

Radial 

Spacing (rad.) 

Radial Spacing 

(degrees) 

0 0.0000 0.000 

102 0.0045 0.255 

186 0.0081 0.465 

270 0.0118 0.675 

354 0.0154 0.885 

438 0.0191 1.095 

522 0.0228 1.305 

606 0.0264 1.515 

690 0.0301 1.725 

774 0.0338 1.935 

858 0.0374 2.145 

942 0.0411 2.355 

1026 0.0448 2.565 

1110 0.0484 2.775 

1194 0.0521 2.985 

1278 0.0558 3.195 

1380 0.0602 3.450 

iv. 𝐼𝑛𝑡. 𝑇𝑟𝑎𝑛𝑠𝑣𝑒𝑟𝑠𝑒 𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑤𝑖𝑑𝑡ℎ = 84 𝑖𝑛.
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v. 𝐸𝑛𝑑 𝑇𝑟𝑎𝑛𝑠𝑣𝑒𝑟𝑠𝑒 𝐸𝑙𝑒𝑚𝑒𝑛𝑡 = 102 − (
84

2
) = 60 𝑖𝑛. 

5. Inputting the coordinate system into SAP2000 

a. Select File -> New Model -> Blank model (making sure units are in kips 

and inches) 

b. Right click on the blank workspace and select Edit Grid Data-> 

Modify/Show System->Quick Start->Cylindrical. 

i. In the Number of Grid Lines panel set “Along Z=1”  

ii. In the Grid Spacing panel set “Along Z=1” 

iii. Select OK. 

iv. Delete all R and T Coordinates that were generated 

c. Add correct coordinates for R 

i. All radial coordinates (A, B, C, D, E, and F). 

d. Add correct coordinates for T 

i. All theta coordinates for T (0 to 1380 in.) 

ii. Click OK 

e. The Grid System in now formed. 
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6. Defining Material in SAP200

a. Click Define-> Materials->Add New Material->Material Type (Steel,

Concrete, or Rebar)->Standard (User)->OK

b. At the bottom of the window select the box which states “Switch to

Advanced Properties”

c. In the open window name the material “Concrete” “Steel” or “Rebar”

depending on which material is being defined. Then click “Modify/Show

Material Properties”

d. On the Material Property Data window click “Nonlinear Material Data”

icon.

e. In the Nonlinear Material Data window select the “Convert to User

Defined” icon.

f. Input the number of number of data points for the stress strain behavior

(10 for concrete, 13 for rebar, 17 for steel)

g. Input the data points for the stress strain behavior.

h. Select “OK”

i. Repeat this process again for the remaining materials.
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7. Defining Frame Cross Sections in SAP2000. 

a. Click Define->Section Properties->Frame Sections->Add New Properties 

b. In the Frame Section Properties Drop down box select “Other” and click 

Section Designer. In the SD Section Designer Window name the section 

B2Long click the “Section Designer” Icon. 

c. Using the Polygon feature draw the features of the half width of the 

bridge from Step 3.  This includes: one rail, two concrete deck pieces, to 

concrete haunches, two top flanges, two webs, and two pieces of the 

bottom flange.  

i. To change material types for the polygons right click on the 

polygon and select the desired material type from the material 

drop down menu. 

ii. To change the coordinates of the polygon’s nodes use the 

Reshaper too to change the coordinates.   

d. Add in the longitudinal rebar to both concrete deck elements by using the 

Line Bar from the Draw Reinforcing Shape tool. From the design 

drawings it can be determined that there are 11 #5 top bars and 9 #5 

bottom bars in the outer concrete deck element and 9 #5 top bars and 7 #5 

bottom bars in the inner concrete element. With a 2 inch top cover and 

transvers reinforcement the top bars are located at 5.0625 inches and with 
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a 1.25 inch bottom cover and transverse reinforcement are located at 

2.1875.  

e. Click Done 

 

f. Repeat this process for the transverse elements 

i. At the SD Section Designer Window select Modifiers and set 

Mass and Weight to 0, as to not double count the dead weight. 

ii. The interior transverse members are 84 inches wide (end members 

are 60 in. wide) with #5 rebar at 5 inch spacing at 5.6875 in. and 

1.5625 in.  

 

g. To generate and exterior longitudinal member and an interior longitudinal 

member. Make two copies of the B2Long section. Label one LongOut 

and on LongInt.  
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i. For the LongOut delete every element right of the centerline.

ii. For the LongInt delete every element left of the centerline.

h. To generate a simulated fracture section make copies of LongOut and

LongInt.

i. Name the copy of LongOut FracOut.

1. Delete the bottom flange, web, and top flange of the steel

tub.
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ii. Name the copy of LongInt FracInt.  

1. Delete the bottom flange, web, and top flange of the steel 

tub.  

 

8. Generating plastic hinges for frame elements in SAP2000.  

a. Define->Section Properties->Frame Sections  

b. Select the desired cross section. Hinges will need to be made for the 

LongOut, LongInt, FracOut, FracInt, Trans, and TransEnd.  

c. Once selected, click Modify/Show Property->Section Designer 

d. Once in the section designer select the Moment Curvature Curve tool. 

e. In the Moment Curvature Curve window select Details. 

i. Copy the moment curvature data to an Excel file.  

ii. Select OK. 

f.  In the Moment Curvature Curve window change the Angle (deg) to 180 

then select Details  
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i. Copy the moment curvature data to the same Excel file as 

previous. 

ii. Select OK. 

g. Generate a Normalized Moment Curvature Diagram 

i. Normalize the Moments by dividing each of the positive moments 

by the maximum positive moment and the negative moment by 

the maximum negative moment. And divide the curvatures by the 

curvatures corresponding to the maximum and negative moments.  

ii. Plot the normalized positive and negative moment curvatures on a 

chart.  

iii. Create a hinge moment curvature plot on the same chart with 4 

positive moment points and 4 negative moment points without 

generating a negative slope.   

 

h. Define Hinge Length  

i. The hinge length is one half of the section depth.  

1. 𝐻𝑖𝑛𝑔𝑒𝑙𝑜𝑛𝑔 = 0.5 ∗ (𝐷𝑒𝑐𝑘 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠 + ℎ𝑎𝑢𝑛𝑐ℎ ℎ𝑒𝑖𝑔ℎ𝑡 +

𝑡𝑜𝑝 𝑓𝑙𝑎𝑛𝑔𝑒 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠 + 𝑤𝑒𝑏 ℎ𝑒𝑖𝑔ℎ𝑡 +
𝑏𝑜𝑡𝑡𝑜𝑚 𝑓𝑙𝑎𝑛𝑔𝑒 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠) 

a. 𝐻𝑖𝑛𝑔𝑒𝑙𝑜𝑛𝑔 = 45.5 𝑖𝑛. 

2. 𝐻𝑖𝑛𝑔𝑒𝐹𝑟𝑎𝑐 = 0.5 ∗ (𝐷𝑒𝑐𝑘 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠 + ℎ𝑎𝑢𝑛𝑐ℎ ℎ𝑒𝑖𝑔ℎ𝑡) 

a. 𝐻𝑖𝑛𝑔𝑒𝐹𝑟𝑎𝑐 = 6 𝑖𝑛. 

3. 𝐻𝑖𝑛𝑔𝑒𝑇𝑟𝑎𝑛𝑠 = 0.5 ∗ (𝐷𝑒𝑐𝑘 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠) 

a. 𝐻𝑖𝑛𝑔𝑒𝑇𝑟𝑎𝑛𝑠 = 4 𝑖𝑛. 
i. Making the plastic hinge in SAP200. 

i. Select Define->Section Properties-> Hinge Properties->Add New 

Properties  

ii. In the Type window select moment curvature and input the 

corresponding correct Hinge Length. 
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iii. In the Moment Curvature table insert the 4 positive and 4 negative

normalized moment curvatures and the zero point.

iv. Uncheck the symmetric box and select the Is Extrapolated option

in the “Load Carrying Capacity beyond Point E” window.

v. In the “Scaling for Moment and Curvature” window insert the

maximum positive moment and corresponding curvature as well

as the maximum negative curvature and corresponding curvature.

vi. In the Acceptance Criteria use the values 1,2, and 3 for Immediate

Occupancy, Life Safety, and Collapse Prevention in the positive

column and -1, -2, and -3 for the negative column.

vii. Repeat for all remaining Frame Sections (LongOut, LongInt,

FracOut, FracInt, Trans, and TransOut)

9. Assign Frame Members to Grid.

a. Select the Draw tab->Quick Draw Frame/Cable/Tendon

b. In the Section drop down menu select LongOut.

c. Then click on every grid segment on second to last longitudinal grids (B

& E).
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d. Change the Section to LongInt and repeat step c but for the two interior

longitudinal grids (C & D).

e. Change the Section to TransEnd and repeat step c but for the end

transvers grids (1 & 17).

f. Change the Section to Trans and repeat step c but for all other transverse

grids (2 to 16).

10. Assign Hinges to Frame Elements
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a. The Longitudinal Hinges are placed at the ends of the longitudinal frame

elements or at a relative distance of 0 and 1.

b. The Transvers hinges are placed at a distance of half a top flange width

away from the node.

i. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐹 𝑡𝑜 𝐸 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
= 1 −

18/2

36
= 0.75 

ii. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐸 𝑡𝑜 𝐷 𝑎𝑛𝑑 𝐶 𝑡𝑜 𝐵 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
=

18/2

86
=

0.1046 𝑎𝑛𝑑 (1 − 0.1046) 𝑜𝑟 0.8954

iii. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐷 𝑡𝑜 𝐶 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
=

18/2

73
= 0.1233 𝑎𝑛𝑑 (1 −

0.1046) 𝑜𝑟 0.8767

iv. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐵 𝑡𝑜 𝐴 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
=

18/2

36
= 0.25 

c. In SAP2000 assign the hinges to corresponding frame elements.

i. Select the desired frame elements you wish to assign hinges to

such as LongOut. (The elements will turn from blue to yellow).

ii. In SAP2000 select the Assign tab->Frame->Hinges

1. From the drop down menu select LongOut and set relative

distance to 0 and click ADD.

2. From the drop down menu select LongOut and set relative

distance to 1 and click ADD.

3. Then click OK.

iii. Repeat Step ii. for all other frame elements.
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11. Assigning Loads to the Frame Elements

a. HS20 Wheel Axel Loads

i. HS20 Axel Loads will be placed at distances of 36 in., 108 in.,

180 in., and 252 in. from the outside of the curved edge.

ii. One line of the 16 kip axels will be placed at the half way point of

the bridge or transverse grid 9 with the second line 14 feet away at

transverse grid number 7. One line of 4 kip axels will be placed 14

feet away from the first line of axels at grid line 11.

iii. In SAP2000 the loads have to be placed at a relative distance so

this value needs to be calculated.

1. 𝐻𝑆20𝐴𝑥𝑒𝑙 1 𝐿𝑜𝑐 (𝐵−𝐴) =
𝐿1−36

𝐿1
=

36−36

36
= 0 

2. 𝐻𝑆20𝐴𝑥𝑒𝑙 2 𝐿𝑜𝑐 (𝐶−𝐵) =
𝐿1+𝐿2−108

𝐿2
=

36+86−108

86
= 0.1628 

3. 𝐻𝑆20𝐴𝑥𝑒𝑙 3 𝐿𝑜𝑐 (𝐷−𝐶) =
𝐿1+𝐿2+𝐿3−180

𝐿3
=

36+86+73−180

73
=

0.2055

4. 𝐻𝑆20𝐴𝑥𝑒𝑙 4 𝐿𝑜𝑐 (𝐸−𝐷) =
𝐿1+𝐿2+𝐿3+𝐿4−252

𝐿4
=

36+86+73+86−252

86
= 0.3372 

b. Lane Loads

i. Lane Loads are line loads of 0.640 kip/ft (0.05333 kip/in.)

centered at a distance of 96 in. and 240 in. from outside of the

curved edge.

ii. These lane loads will be placed on the longitudinal frame

elements. They will be assigned to elements along the B, C, D,
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and E longitudinal elements according to the appropriate tributary 

distance.  

1. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐵 = (
𝐿1+𝐿2−96

𝐿2
) ∗ 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 = (

36+86−96

86
) ∗

0.05333 = 0.016124
𝑘𝑖𝑝

𝑖𝑛
. 

2. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐶 = 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 − 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑𝐵 = 0.05333 −

0.016124 = 0.037209
𝑘𝑖𝑝

𝑖𝑛
.

3. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐷 = (
𝐿1+𝐿2+𝐿3+𝐿4−240

𝐿4
) ∗ 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 =

(
36+86+73+86−240

86
) ∗ 0.05333 = 0.025426

𝑘𝑖𝑝

𝑖𝑛
. 

4. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐸 = 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 − 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑𝐷 = 0.05333 −

0.025426 = 0.027907
𝑘𝑖𝑝

𝑖𝑛
.

c. In SAP2000 the load patterns must be first be defined.

i. Select the Define tab->Load Patterns.

1. Under the Load Pattern Name ender HS20 and change the

type in the drop down menu to Live. The self-weight

multiplier should be set to 0. Then click Add New Load

Pattern.

2. Under the Load Pattern Name ender LaneLoad and change

the type in the drop down menu to Live. The self-weight

multiplier should be set to 0. Then click Add New Load

Pattern.

3. Then click OK.

ii. Assigning the HS20 wheel loads in SAP2000.

1. Select the exterior transverse element of grid line 9 and 7.

2. Click Assign->Frame Loads->Point
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3. From the Load Pattern drop down menu select HS20 and

verify that the Coordinate System is set to Global, the

Load Direction is Gravity, and the Load Type is Force.

4. In column 1 enter a Relative Distance of 0 (HS20 Axel 1

Loc. B-A) and Load of 16 kips.

5. Click OK.

6. Repeat for grid line 11 to assign the 4 kip load.

7. Repeat Steps 1-6 for HS20 Axel 2,3,4 Loc. C-B, D-C, and

E-D.

iii. Assigning the Lane Load in SAP2000.

1. Select all exterior longitudinal frame elements along grid

line B.

2. Click Assign->Frame Loads->Distributed

3. From the Load Pattern drop down menu select Lane Load

and verify that the Coordinate System is set to Global, the

Load Direction is Gravity, and the Load Type is Force.

4. In the Uniform Load box enter 0.016124 (Lane Load B).

5. Click OK.

6. Repeat Steps 1-5 for all of the longitudinal elements along

gridlines C, D, and E.
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12. Defining Load Cases

a. The Load Case being used to determine redundancy is 1.25𝐷𝐿 +
1.75(𝐿𝐿 + 𝐼𝑀). Where DL=Dead Load, LL= Live Load, and IM= Impact

Load. When substituting in the HS20 truck load and the Lane Load the

preceding equation reduces to 1.25𝐷𝐿 + 1.75𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑 + 2.33𝐻𝑆20
b. Generating Load Cases in SAP2000.

i. Click Define->Load Cases->Add New Load Case

ii. In the Load Case Name Panel name the load case “LC1”

iii. In the Analysis Type select “Non-Linear”

iv. For the LC1 Load Case in the Stiffness to use panel select “Zero

Initial Conditions”

v. In the Loads Applied panel leave the Load Type “Load Pattern”

in the drop down Load Name menu select DEAD and change the

Scale Factor to 1.25. Click Add. Change the Load Name menu

select HS20 and change the Scale Factor to 2.33. Click ADD.

Change the Load Name menu select Lane Load and change the

Scale Factor to 1.75. Click ADD.

vi. In the Other Parameters panel in the Results Saved section click

Modify/Show.

vii. In the Results Saved for Nonlinear Static Load Cases window

change the Results Saved to Multiple States and in the For Each

Stage panel change the Minimum Number of Saved Steps and the

Maximum Number of Saved Steps to 20. Click OK.

viii. Then Click the OK on the Load Case Data Window.

ix. Repeat Steps i.-viii. to create an LC2, LC3, and LC4. However, in

the Initial Conditions Window select Continue from State at End
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of Nonlinear Case and from the drop down menu select the 

preceding load case. (For LC2 the Nonlinear Case LC1 would be 

selected). 

13. Defining End Supports

a. The elastomeric bearing pad for each girder have lateral stiffness of 12

kip/in. and a vertical stiffness of 6100 kip/in. Since the tub girders are

divided in half, the lateral stiffness will be 6 kip/in. and the vertical

stiffness will be 3050 kip/in.

b. Assigning spring supports in SAP2000.

i. Select the 8 nodes at the very end of the longitudinal members.

ii. Click Assign->Joint->Springs

iii. In the Assign Joint Springs window in the Simple Springs

Stiffness panel enter 6 for Translation 1&2 and 3050 for

Translation 3.

iv. Click OK.
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14. Defining Centerline Data Acquisition Points at Mid-Span of Girder

a. Select the transverse frame elements between B&C as well as D&E at

Mid-Span (Gridline 9).

b. Click Edit->Edit Lines->Divide Frames

c. In the Divide into Specified Number of Frames window enter 2 for

Number of Frames.

d. Click OK.

15. Analyzing the Non-Fracture Structure for Dead Load Only

a. In SAP2000 click Analyze->Run Analysis

b. In the Set Load Cases to Run window click the Run/Do Not Run All

button until every Action is Do Not Run.

c. Select DEAD then click Run/Do Not Run Case until the Action is Run.

d. Then click Run Now. Let SAP2000 Run the Load Cases until the scree

says the Analysis is Complete.

e. Once the analysis is complete, select the spring reactions.

f. Click Display->Show Tables
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g. In the Choose Table for Display window click the + symbol beside Joint

output and select the square box beside Reactions.

h. In the Output Options window in the Nonlinear Static Results panel select

Last Step.

i. Select and copy the information from the F3 column.

j. The sum of the F3 values is the dead load.

k. Then click Done.

l. Unlock the structure.

16. Analyzing the Non-Fractured Structure

a. In SAP2000 click Analyze->Run Analysis

b. In the Set Load Cases to Run window click the Run/Do Not Run All

button until every Action is Do Not Run.

c. Select LC1, LC2, LC3, and LC4 then click Run/Do Not Run Case until

the Action for all 4 is Run.

d. Then Click Run Now.

e. Let SAP2000 Run the Load Cases until the scree says the Analysis is

Complete.

f. Once the analysis is complete, select the data collection point on the

transverse member on the outside girder (C-B).

g. Click Display->Show Tables

h. In the Choose Table for Display window click the + symbol beside Joint

output and select the square box beside Displacements

i. Click the Modify/Show Options button.

j. In the Output Options window in the Nonlinear Static Results panel select

Step-by-Step.
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k. Click OK.

l. Select and copy the information from the Output Case, StepNum

Unitless, and the U3 in. column and paste them into an Excel worksheet.

These columns represent Load Case, Step Number, and Deflection for the

Outside Girder respectively.

m. Then click Done.

n. Select the data collection point on the transverse member on the inside

girder (E-D) and repeat Steps g-l. However, on Step l there is no need to

copy Output Case, Step Num Unitless again.

o. Select the joint on the transverse member on the outside girder at

transverse element 9 (at longitudinal element B) and repeat Steps g-l.

This information goes into the Delta 4 column. However, on Step l there

is no need to copy Output Case, Step Num Unitless again.

p. Select the joint on the transverse member on the outside girder at

transverse element 9 (at longitudinal element C) and repeat Steps g-l.

This information goes into the Delta 3 column. However, on Step l there

is no need to copy Output Case, Step Num Unitless again.

q. Select the joint on the transverse member on the inside girder at

transverse element 9 (at longitudinal element D) and repeat Steps g-l.

This information goes into the Delta 2 column. However, on Step l there

is no need to copy Output Case, Step Num Unitless again.
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r. Select the joint on the transverse member on the outside girder at

transverse element 9 (at longitudinal element E) and repeat Steps g-l. This

information goes into the Delta 1 column. However, on Step l there is no

need to copy Output Case, Step Num Unitless again.

s. Once all of the data is collected unlock the model by selecting the Lock

tool on the left hand side of SAP2000 screen.

17. Analyzing the Fractured Structure

a. At Mid-Span along grid line 9, replace the hinges of the outside

longitudinal element (gridline B) with FracOUT hinges according to Step

10.

b. At Mid-Span, along gridline 9, replace the hinges of the first interior

longitudinal element (gridline C) with FracInt hinges according to Step

10.

c. Repeat Step 15 for the Fractured Case and collect the data accordingly.

18. Post Processing of the Data

a. In the Excel Sheet the following values need to be calculated for each

step.

i. Omega (Ω)

1. 𝛺𝑖 = 𝛺𝑖−1 + (
1

# 𝑜𝑓 𝑆𝑡𝑒𝑝𝑠 𝑖𝑛 𝐿𝑜𝑎𝑑 𝑐𝑎𝑠𝑒
) 
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ii. Longitudinal Chord Rotation of Interior and Exterior Girder

1. 𝐶ℎ𝑜𝑟𝑑 𝑅𝑜𝑡.𝑆𝑖𝑛𝑔𝑙𝑒 𝑆𝑝𝑎𝑛 = −1 ∗ (
𝛿𝐶𝐿

0.5∗𝐿
) (rad) 

iii. Transverse Deck Roataion

1. 𝛼2−3 = (
𝛿3−𝛿2

𝑠
) − (

𝛿2−𝛿1

𝑤
) (rad) 

2. 𝛼2−3 = (
𝛿3−𝛿2

𝑠
) − (

𝛿2−𝛿1

𝑤
) (rad) 

3. Where s=spacing between the interior top flanges of the

inside and outside girders and w=spacing between the top

flanges of the same girder.

iv. Applied Load

1. Calculate unit applied load or applied load at 1 Ω.

2. 𝑈𝑛𝑖𝑡 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑𝑠𝑖𝑛𝑔𝑙𝑒 𝑠𝑝𝑎𝑛 = 1.25 ∗

𝑇𝑜𝑡𝑎𝑙 𝑅𝑒𝑎𝑐𝑡𝑖𝑜𝑛𝑠 𝑓𝑟𝑜𝑚 𝐷𝑒𝑎𝑑 𝐿𝑜𝑎𝑑 𝐶𝑎𝑠𝑒 + 2 ∗ (2.33 ∗

𝐻𝑆20 𝑡𝑟𝑢𝑐𝑘 + 1.75 ∗ 𝐿𝑎𝑛𝑒 𝐿𝑜𝑎𝑑)

3. 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑 = 𝑈𝑛𝑖𝑡 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑 ∗ 𝛺
b. Repeat Step A for the Fractured Case.

c. Calculate the initial stiffness for intact bridge and instantaneous stiffness

for fractured bridge.

i. For the Non-Fractured condition (Intact Bridge) find the absolute

displacement for the Outside Girder at an Ω value of 0.4.

1. 𝐼𝑛𝑖𝑡𝑖𝑎𝑙 𝑆𝑡𝑖𝑓𝑓𝑛𝑒𝑠𝑠 =
0.4

𝐴𝑏𝑠𝑜𝑙𝑢𝑡𝑒 𝐷𝑖𝑠𝑝𝑙𝑎𝑐𝑒𝑚𝑒𝑛𝑡 𝑂𝐺 (𝑎𝑡  𝛺=0.4)

ii. For the Fractured case add an additional column labeled stiffness

1. 𝐼𝑛𝑠𝑡𝑎𝑛𝑡𝑎𝑛𝑒𝑜𝑢𝑠 𝑆𝑡𝑖𝑓𝑓𝑛𝑒𝑠𝑠𝑂𝐺−𝐹𝑟𝑎𝑐.  𝑖 =
𝛺𝑖−𝛺𝑖−1

𝛿𝑖−𝛿𝑖−1

d. Failure of the structure occurs at the Ω of the Fractured Bridge at the first

of the following criteria.

i. The instantaneous stiffness for the fractured outside girder is less

than 5% of the initial stiffness of the intact outside girder.

ii. The chord angle of the outside girder for a simple spans or interior

spans is greater than 2°. The chord angle for exterior spans of

multi-span bridges is greater than 3°.

iii. The transverse deck rotation is greater than 5°.

e. On a chart plot the Non-Fractured Outside and Inside Girder as well as

the Fractured Outside and Inside Girder with displacement on the primary

x axis and the Total Force on the primary y axis and Ω on the secondary

y-axis
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Grillage Analysis Example of Bridge 5 

1. Gather Bridge Geometry and Material Information.

Location   

ft 

Top Flange Web Bottom Flange 

Width      

in. 

Thickness 

in. 

Width      

in. 

Thickness 

in. 

Width      

in. 

Thickness 

in. 

0-105 18 1.00 54 0.5 56 0.75 

105-122 18 1.00 54 0.5625 56 1.250 

122-140 18 1.75 54 0.5625 56 1.250 

140-157 18 1.75 54 0.5625 56 1.250 

157-174 18 1.57 54 0.5625 56 1.250 

174-192 18 1.00 54 0.5625 56 0.75 

192-280 18 1.00 54 0.5 56 0.75 

Location Parameter Description/Value 

Bridge 

Location Travis County, I35 

Year Designed/Year Built 1998/2002 

Design Load HS20 

Length, ft 279.58 

Spans, ft 140, 139.58 

Radius of Curvature, ft 450 

Deck 

Width, ft 30 

Thickness, in. 8 

Haunch, in. 4 

Rail Type T4(S) 

Rebar 

# of Bar Longitudinal Top Row (#4) 40 

# of Bar Longitudinal Bottom Row (#5) 36 

# of Bar Longitudinal Top Row (#4) 

@support 
41 

# of Bar Longitudinal Top Row (#5) 

@support 
40 

# of Bar Longitudinal Bottom Row (#5) 

@support 
36 

Transverse Spacing Top Row (#5), in. 5 

Transverse Spacing Bottom Row (#5), in. 5 

Girder 
CL of Bridge to CL of Girder (in.) 56.5 

CL of Top Flange to CL of Top Flange (in.) 83 



374 

2. Material constitutive behavior

Concrete (4 ksi) Rebar (60 ksi) Steel (50 ksi) 

Stress 

(ksi) 

Strain 

(1/in) 

Stress 

(ksi) 

Strain 

(1/in) 

Stress 

(ksi) 

Strain 

(1/in) 

-4 -3.79E-03 -87.9 -0.095 -71.6 -0.1

-4 -3.56E-03 -87.9 -0.0944 -71.6 -0.097

-4 -2.69E-03 -86.6 -0.0761 -71.6 -0.095

-4 -1.78E-03 -78 -0.0386 -71.6 -0.0946

-3.8205 -1.40E-03 -60.7 -9.80E-03 -70.3 -0.0764

-2.8718 -8.69E-04 -60.3 -2.08E-03 -62.5 -0.039

-0.6403 -1.78E-04 0 0 -50 -0.0196

0 0 60.3 2.08E-03 -50 -1.72E-03

0.378 1.06E-04 60.7 9.80E-03 0 0 

0.378 1.16E-03 78 0.0386 50 1.72E-03 

86.6 0.0761 50 0.0196 

87.9 0.0944 62.5 0.039 

87.9 0.095 70.3 0.0764 

71.6 0.0946 

71.6 0.095 

71.6 0.097 

71.6 0.1 

3. Create a Coordinate system for half width of the span for each cross section in 1.

An example of the first cross section is show below.
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4. Create a cylindrical coordinate system for the curved bridge assuring that the

middle transverse divisions are 7 ft, as this will aid is applying the HS20 truck

load whose axels are separated by 14 ft.

a. # 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠𝑝𝑒𝑟 𝑠𝑝𝑎𝑛 =

(
𝐿𝑒𝑛𝑔𝑡ℎ (𝑓𝑡)∗12

84 𝑖𝑛 (7𝑓𝑡)
)  𝑟𝑜𝑢𝑛𝑑𝑒𝑑 𝑡𝑜 𝑛𝑒𝑎𝑟𝑒𝑠𝑡 𝑒𝑣𝑒𝑛 𝑛𝑢𝑚𝑏𝑒𝑟 

i. # 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠𝑆𝑝𝑎𝑛 1&2 = (
140∗12

84
) = 20 

b. 𝐸𝑛𝑑 𝑆𝑒𝑔𝑚𝑒𝑛𝑡 𝐿𝑒𝑛𝑔𝑡ℎ = ((𝐿𝑒𝑛𝑔𝑡ℎ ∗ 12) − (# 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠 ∗ 84))/2



376 

i. 𝐸𝑛𝑑 𝑆𝑒𝑔𝑚𝑒𝑛𝑡 𝐿𝑒𝑛𝑔𝑡ℎ =
((140∗12)−(14∗84))

2
= 0 𝑖𝑛. 

ii. Therefore, the end segments are also equal to 84 in.

c. 𝑇ℎ𝑒𝑡𝑎 =
𝑇𝑜𝑡𝑎𝑙 𝐿𝑒𝑛𝑔𝑡ℎ

𝑅𝑎𝑑𝑖𝑢𝑠

i. 𝑇ℎ𝑒𝑡𝑎 =
280

450
= 0.6222 𝑟𝑎𝑑 𝑜𝑟 36.65 𝑑𝑒𝑔𝑟𝑒𝑒𝑠 

d. Determine the radial offsets using the outside edge, the outside flange, the

inner flange and centerline of the bridge.

Offsets (in.) 

Edge 180 

Outside Flange 139.5 

Inner Flange 56.5 

CL of Bridge 0 

Radial Spacing (in.) 

A 5580 CL+Edge 

B 5539.5 CL+OF 

C 5456.5 CL+IF 

Center Line 5400 or 450 (ft) 

D 5343.5 CL-IF

E 5260.5 CL-OF

F 5220 CL-Edge

b. The Longitudinal or spacing along theta is determined by converting the

longitudinal segment lengths into degrees.

i. All segments are 84 in. The total length is 280 ft or 3360 in.

ii. 𝑅𝑎𝑑𝑖𝑎𝑙 𝑆𝑝𝑎𝑐𝑖𝑛𝑔 (𝑟𝑎𝑑) =
𝐿𝑜𝑛𝑔.𝑆𝑝𝑎𝑐𝑖𝑛𝑔

𝑅𝑎𝑑𝑖𝑢𝑠

iii. 𝑅𝑎𝑑𝑖𝑎𝑙 𝑆𝑝𝑎𝑐𝑖𝑛𝑔 (𝑑𝑒𝑔𝑟𝑒𝑒) = 𝑅𝑎𝑑𝑖𝑢𝑠 𝑆𝑝𝑎𝑐𝑖𝑛𝑔 (𝑟𝑎𝑑) ∗
180

𝜋

Long. 

Spacing 

(in.) 

Radial 

Spacing 

(rad.) 

Radial 

Spacing 

(deg.) 

Cross 

Section 

0 0.0000 0.000 Long1 

84 0.0156 0.891 Long1 

168 0.0311 1.783 Long1 

252 0.0467 2.674 Long1 
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336 0.0622 3.565 Long1 

420 0.0778 4.456 Long1 

504 0.0933 5.348 Long1 

588 0.1089 6.239 Long1 

672 0.1244 7.130 Long1 

756 0.1400 8.021 Long1 

840 0.1556 8.913 Long1 

924 0.1711 9.804 Long1 

1008 0.1867 10.695 Long1 

1092 0.2022 11.586 Long1 

1176 0.2178 12.478 Long2 

1260 0.2333 13.369 Long2 

1344 0.2489 14.260 Long2 

1428 0.2644 15.152 Long3 

1512 0.2800 16.043 Long3 

1596 0.2956 16.934 Long4 

1680 0.3111 17.825 Long4 

1764 0.3267 18.717 Long4 

1848 0.3422 19.608 Long3 

1932 0.3578 20.499 Long3 

2016 0.3733 21.390 Long2 

2100 0.3889 22.282 Long2 

2184 0.4044 23.173 Long2 

2268 0.4200 24.064 Long1 

2352 0.4356 24.955 Long1 

2436 0.4511 25.847 Long1 

2520 0.4667 26.738 Long1 

2604 0.4822 27.629 Long1 

2688 0.4978 28.521 Long1 

2772 0.5133 29.412 Long1 

Long. 

Spacing 

(in.) 

Radial 

Spacing 

(rad.) 

Radial 

Spacing 

(deg.) 

Cross 

Section 

2856 0.5289 30.303 Long1 

2940 0.5444 31.194 Long1 

3024 0.5600 32.086 Long1 

3108 0.5756 32.977 Long1 
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3192 0.5911 33.868 Long1 

3276 0.6067 34.759 Long1 

3360 0.6222 35.651 Long1 

iv. 𝐼𝑛𝑡. 𝑇𝑟𝑎𝑛𝑠𝑣𝑒𝑟𝑠𝑒 𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑤𝑖𝑑𝑡ℎ = 84 𝑖𝑛.

v. 𝐸𝑛𝑑 𝑇𝑟𝑎𝑛𝑠𝑣𝑒𝑟𝑠𝑒 𝐸𝑙𝑒𝑚𝑒𝑛𝑡 = 84 − (
84

2
) = 42 𝑖𝑛. 

vi. 𝑃𝑒𝑖𝑟 𝑇𝑎𝑛𝑠𝑣𝑒𝑟𝑠 𝐸𝑙𝑒𝑚𝑒𝑛𝑡 = 84 + 84 − 84 = 84 𝑖𝑛.
5. Inputting the coordinate system into SAP2000

a. Select File -> New Model -> Blank model (making sure units are in kips

and inches)

b. Right click on the blank workspace and select Edit Grid Data->

Modify/Show System->Quick Start->Cylindrical.

i. In the Number of Grid Lines panel set “Along Z=1”

ii. In the Grid Spacing panel set “Along Z=1”

iii. Select OK.

iv. Delete all R and T Coordinates that were generated

c. Add correct coordinates for R

i. All radial coordinates (A, B, C, D, E, and F).

d. Add correct coordinates for T

i. All theta coordinates for T (0 to 3360 in.)

ii. Click OK

e. The Grid System in now formed.
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6. Defining Material in SAP200

a. Click Define-> Materials->Add New Material->Material Type (Steel,

Concrete, or Rebar)->Standard (User)->OK

b. At the bottom of the window select the box which states “Switch to

Advanced Properties”

c. In the open window name the material “Concrete” “Steel” or “Rebar”

depending on which material is being defined. Then click “Modify/Show

Material Properties”

d. On the Material Property Data window click “Nonlinear Material Data”

icon.

e. In the Nonlinear Material Data window select the “Convert to User

Defined” icon.

f. Input the number of number of data points for the stress strain behavior

(10 for concrete, 13 for rebar, 17 for steel)
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g. Input the data points for the stress strain behavior.

h. Select “OK”

i. Repeat this process again for the remaining materials.

7. Defining Frame Cross Sections in SAP2000.

a. Click Define->Section Properties->Frame Sections->Add New Properties

b. In the Frame Section Properties Drop down box select “Other” and click

Section Designer. In the SD Section Designer Window name the section

B5Long1 click the “Section Designer” Icon.

c. Using the Polygon feature draw the features of the half width of the

bridge from Step 3.  This includes: one rail, two concrete deck pieces, to

concrete haunches, two top flanges, two webs, and two pieces of the

bottom flange.

i. To change material types for the polygons right click on the

polygon and select the desired material type from the material

drop down menu.

ii. To change the coordinates of the polygon’s nodes use the

Reshaper too to change the coordinates.

d. Add in the longitudinal rebar to both concrete deck elements by using the

Line Bar from the Draw Reinforcing Shape tool. From the design

drawings it can be determined that there are 7 #4 top bars and 9 #5

bottom bars in the outer concrete deck element and 11 #4 top bars and 11
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#5 bottom bars in the inner concrete element. At the pier support 9 

additional #5 top bars are added to the top of the outer concrete deck and 

10 additional #5 top bars are added to the inner concrete deck. With a 2 

inch top cover and transvers reinforcement the top bars are located at 

5.0625 inches and with a 1.25 inch bottom cover and transverse 

reinforcement are located at 2.1875.  

e. Click Done (Below is an example of the 1st cross section).

f. Repeat this process for the remaining longitudinal elements.

g. Repeat the process for the transverse elements.

i. At the SD Section Designer Window select Modifiers and set

Mass and Weight to 0, as to not double count the dead weight.

ii. The interior transverse members are 84 inches wide (end members

are 42 in. wide) with #5 rebar at 5 inch spacing at 5.6875 in. and

1.5625 in.
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h. To generate and exterior longitudinal member and an interior longitudinal

member. Make two copies of the B5Long1 section. Label one Long1Out

and on Long1Int.

i. For the Long1Out delete every element right of the centerline.

ii. For the Long1Int delete every element left of the centerline.
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iii. Repeat this process for all cross sections.

i. To generate a simulated fracture section make copies of Long1Out and

Long1Int.

i. The reason Long1Out and Long1Int are chosen for the fractured

section is because the fracture occurs at 0.4*L or 672 inches.

Which from the radial spacing table Long1 is the section used at

672 in.

ii. Name the copy of Long1Out Frac1Out.

1. Delete the bottom flange, web, and top flange of the steel

tub.

iii. Name the copy of LongInt FracInt.

1. Delete the bottom flange, web, and top flange of the steel

tub.
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8. Generating plastic hinges for frame elements in SAP2000.

a. Define->Section Properties->Frame Sections

b. Select the desired cross section. Hinges will need to be made for the

Long(1-4)Out, Long(1-4)Int, FracOut, FracInt, Trans, and TransEnd.

c. Once selected, click Modify/Show Property->Section Designer

d. Once in the section designer select the Moment Curvature Curve tool.

e. In the Moment Curvature Curve window select Details.

i. Copy the moment curvature data to an Excel file.

ii. Select OK.

f. In the Moment Curvature Curve window change the Angle (deg) to 180

then select Details

i. Copy the moment curvature data to the same Excel file as

previous.

ii. Select OK.

g. Generate a Normalized Moment Curvature Diagram

i. Normalize the Moments by dividing each of the positive moments

by the maximum positive moment and the negative moment by

the maximum negative moment. And divide the curvatures by the

curvatures corresponding to the maximum and negative moments.

ii. Plot the normalized positive and negative moment curvatures on a

chart.

iii. Create a hinge moment curvature plot on the same chart with 4

positive moment points and 4 negative moment points without

generating a negative slope.
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h. Define Hinge Length

i. The hinge length is one half of the section depth.

1. 𝐻𝑖𝑛𝑔𝑒𝑙𝑜𝑛𝑔 = 0.5 ∗ (𝐷𝑒𝑐𝑘 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠 + ℎ𝑎𝑢𝑛𝑐ℎ ℎ𝑒𝑖𝑔ℎ𝑡 +

𝑡𝑜𝑝 𝑓𝑙𝑎𝑛𝑔𝑒 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠 + 𝑤𝑒𝑏 ℎ𝑒𝑖𝑔ℎ𝑡 +
𝑏𝑜𝑡𝑡𝑜𝑚 𝑓𝑙𝑎𝑛𝑔𝑒 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠)

a. 𝐻𝑖𝑛𝑔𝑒𝑙𝑜𝑛𝑔 = 30 𝑖𝑛.

2. 𝐻𝑖𝑛𝑔𝑒𝐹𝑟𝑎𝑐 = 0.5 ∗ (𝐷𝑒𝑐𝑘 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠 + ℎ𝑎𝑢𝑛𝑐ℎ ℎ𝑒𝑖𝑔ℎ𝑡)

a. 𝐻𝑖𝑛𝑔𝑒𝐹𝑟𝑎𝑐 = 6 𝑖𝑛.
3. 𝐻𝑖𝑛𝑔𝑒𝑇𝑟𝑎𝑛𝑠 = 0.5 ∗ (𝐷𝑒𝑐𝑘 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠)

a. 𝐻𝑖𝑛𝑔𝑒𝑇𝑟𝑎𝑛𝑠 = 4 𝑖𝑛.
i. Making the plastic hinge in SAP200.

i. Select Define->Section Properties-> Hinge Properties->Add New

Properties

ii. In the Type window select moment curvature and input the

corresponding correct Hinge Length.

iii. In the Moment Curvature table insert the 4 positive and 4 negative

normalized moment curvatures and the zero point.

iv. Uncheck the symmetric box and select the Is Extrapolated option

in the “Load Carrying Capacity beyond Point E” window.

v. In the “Scaling for Moment and Curvature” window insert the

maximum positive moment and corresponding curvature as well

as the maximum negative curvature and corresponding curvature.

vi. In the Acceptance Criteria use the values 1,2, and 3 for Immediate

Occupancy, Life Safety, and Collapse Prevention in the positive

column and -1, -2, and -3 for the negative column.

vii. Repeat for all remaining Frame Sections (Long(1-4)Out, Long(1-

4)Int, FracOut, FracInt, Trans, and TransEnd)
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9. Assign Frame Members to Grid.

a. Select the Draw tab->Quick Draw Frame/Cable/Tendon

b. In the Section drop down menu select Long1Out.

c. Then click on every grid segment on second to last longitudinal grids (B

& E) from transverse girds (1-15) and (28-41).

d. Change the Section to Long1Int and repeat step c but for the two interior

longitudinal grids (C & D).

e. In the Section drop down menu select Long2Out.

f. Then click on every grid segment on second to last longitudinal grids (B

& E) from transverse girds (15-18) and (25-28).

g. Change the Section to Long2Int and repeat step e but for the two interior

longitudinal grids (C & D).

h. In the Section drop down menu select Long3Out.

i. Then click on every grid segment on second to last longitudinal grids (B

& E) from transverse girds (18-20) and (23-25).

j. Change the Section to Long3Int and repeat step i but for the two interior

longitudinal grids (C & D).

k. In the Section drop down menu select Long4Out.

l. Then click on every grid segment on second to last longitudinal grids (B

& E) from transverse girds (20-23).

m. Change the Section to LongInt and repeat step l but for the two interior

longitudinal grids (C & D).
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n. Change the Section to TransEnd and repeat step c but for the end

transvers grids (1 & 41).

o. Change the Section to Trans and repeat step c but for all other transverse

grids (2 to 40).

10. Assign Hinges to Frame Elements

a. The Longitudinal Hinges are placed at the ends of the longitudinal frame

elements or at a relative distance of 0 and 1.

b. The Transvers hinges are placed at a distance of half a top flange width

away from the node.

i. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐹 𝑡𝑜 𝐸 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
= 1 −

18/2

40.5
= 0.7778 

ii. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐸 𝑡𝑜 𝐷 𝑎𝑛𝑑 𝐶 𝑡𝑜 𝐵 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
=

18/2

83
=

0.1084 𝑎𝑛𝑑 (1 − 0.1084) 𝑜𝑟 0.8916

iii. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐷 𝑡𝑜 𝐶 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
=

18/2

113
= 0.0796 𝑎𝑛𝑑 (1 −

0.0796) 𝑜𝑟 0.9204

iv. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐵 𝑡𝑜 𝐴 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
=

18/2

40.5
= 0.2222 

c. In SAP2000 assign the hinges to corresponding frame elements.

i. Select the desired frame elements you wish to assign hinges to

such as Long1Out. (The elements will turn from blue to yellow).
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ii. In SAP2000 select the Assign tab->Frame->Hinges

1. From the drop down menu select Long1Out and set

relative distance to 0 and click ADD.

2. From the drop down menu select Long1Out and set

relative distance to 1 and click ADD.

3. Then click OK.

iii. Repeat Step ii. for all other frame elements.

11. Assigning Loads to the Frame Elements

a. HS20 Wheel Axel Loads

i. HS20 Axel Loads will be placed at distances of 36 in., 108 in.,

180 in., and 252 in. from the outside of the curved edge.

ii. One line of the 16 kip axels will be placed at the 0.4L point of the

bridge or transverse grid 9 with the second line 14 feet away at
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transverse grid number 7. One line of 4 kip axels will be placed 14 

feet away from the first line of axels at grid line 11.  

iii. In SAP2000 the loads have to be placed at a relative distance so

this value needs to be calculated.

1. 𝐻𝑆20𝐴𝑥𝑒𝑙 1 𝐿𝑜𝑐 (𝐵−𝐴) =
𝐿1−36

𝐿1
=

40.5−36

40.5
= 0.1111 

2. 𝐻𝑆20𝐴𝑥𝑒𝑙 2 𝐿𝑜𝑐 (𝐶−𝐵) =
𝐿1+𝐿2−108

𝐿2
=

40.5+83−108

83
= 0.1867 

3. 𝐻𝑆20𝐴𝑥𝑒𝑙 3 𝐿𝑜𝑐 (𝐷−𝐶) =
𝐿1+𝐿2+𝐿3−180

𝐿3
=

40.5+83+113−180

113
=

0.5

4. 𝐻𝑆20𝐴𝑥𝑒𝑙 4 𝐿𝑜𝑐 (𝐸−𝐷) =
𝐿1+𝐿2+𝐿3+𝐿4−252

𝐿4
=

40.5+83+113+83−252

83
= 0.8133 

b. Lane Loads

i. Lane Loads are line loads of 0.640 kip/ft (0.05333 kip/in.)

centered at a distance of 96 in. and 240 in. from outside of the

curved edge.

ii. These lane loads will be placed on the longitudinal frame

elements. They will be assigned to elements along the B, C, D,

and E longitudinal elements according to the appropriate tributary

distance.

1. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐵 = (
𝐿1+𝐿2−96

𝐿2
) ∗ 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 = (

40.5+83−96

83
) ∗

0.05333 = 0.017671
𝑘𝑖𝑝

𝑖𝑛
. 

2. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐶 = 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 − 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑𝐵 = 0.05333 −

0.017671 = 0.035663
𝑘𝑖𝑝

𝑖𝑛
.

3. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐷 = (
𝐿1+𝐿2+𝐿3+𝐿4−240

𝐿4
) ∗ 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 =

(
40.5+83+113+83−240

83
) ∗ 0.05333 = 0.051084

𝑘𝑖𝑝

𝑖𝑛
. 

4. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐸 = 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 − 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑𝐷 = 0.05333 −

0.051084 = 0.002249
𝑘𝑖𝑝

𝑖𝑛
.

c. In SAP2000 the load patterns must be first be defined.

i. Select the Define tab->Load Patterns.

1. Under the Load Pattern Name ender HS20_1 and change

the type in the drop down menu to Live. The self-weight

multiplier should be set to 0. Then click Add New Load

Pattern.

2. Under the Load Pattern Name ender LaneLoad1 and

change the type in the drop down menu to Live. The self-
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weight multiplier should be set to 0. Then click Add New 

Load Pattern.  

3. Then click OK. 

 

ii. Assigning the HS20 wheel loads in SAP2000.  

1. Select the exterior transverse element of grid line 9 and 7. 

2. Click Assign->Frame Loads->Point 

3. From the Load Pattern drop down menu select HS20 and 

verify that the Coordinate System is set to Global, the 

Load Direction is Gravity, and the Load Type is Force.  

4. In column 1 enter a Relative Distance of 0 (HS20 Axel 1 

Loc. B-A) and Load of 16 kips. 

5. Click OK. 

6. Repeat for grid line 11 to assign the 4 kip load.   

7. Repeat Steps 1-6 for HS20 Axel 2,3,4 Loc. C-B, D-C, and 

E-D. 

 

iii. Assigning the Lane Load in SAP2000.   
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1. Select all exterior longitudinal frame elements along grid 

line B.  

2. Click Assign->Frame Loads->Distributed 

3. From the Load Pattern drop down menu select Lane Load 

and verify that the Coordinate System is set to Global, the 

Load Direction is Gravity, and the Load Type is Force.  

4. In the Uniform Load box enter 0.016124 (Lane Load B). 

5. Click OK. 

6. Repeat Steps 1-5 for all of the longitudinal elements along 

gridlines C, D, and E.  

 

12. Defining Load Cases 

a. The Load Case being used to determine redundancy is 1.25𝐷𝐿 +
1.75(𝐿𝐿 + 𝐼𝑀). Where DL=Dead Load, LL= Live Load, and IM= Impact 

Load. When substituting in the HS20 truck load and the Lane Load the 

preceding equation reduces to 1.25𝐷𝐿 + 1.75𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑 + 2.33𝐻𝑆20 

b. Generating Load Cases in SAP2000. 

i. Click Define->Load Cases->Add New Load Case 

ii. In the Load Case Name Panel name the load case “LC1_1” 

iii. In the Analysis Type select “Non-Linear” 

iv. For the LC1_1 Load Case in the Stiffness to use panel select 

“Zero Initial Conditions” 

v.  In the Loads Applied panel leave the Load Type “Load Pattern” 

in the drop down Load Name menu select DEAD and change the 

Scale Factor to 1.25. Click Add. Change the Load Name menu 

select HS20 and change the Scale Factor to 2.33. Click ADD. 

Change the Load Name menu select Lane Load and change the 

Scale Factor to 1.75. Click ADD.  

vi.  In the Other Parameters panel in the Results Saved section click 

Modify/Show. 
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vii. In the Results Saved for Nonlinear Static Load Cases window 

change the Results Saved to Multiple States and in the For Each 

Stage panel change the Minimum Number of Saved Steps and the 

Maximum Number of Saved Steps to 20. Click OK.  

viii. Then Click the OK on the Load Case Data Window.  

ix. Repeat Steps i.-viii. to create an LC2_1, LC3_1, and LC4_1. 

However, in the Initial Conditions Window select Continue from 

State at End of Nonlinear Case and from the drop down menu 

select the preceding load case. (For LC2_1 the Nonlinear Case 

LC1_1 would be selected). 

 

13. Defining End Supports 

a. The elastomeric bearing pad for each girder have lateral stiffness of 12 

kip/in. and a vertical stiffness of 6100 kip/in. Since the tub girders are 

divided in half, the lateral stiffness will be 6 kip/in. and the vertical 

stiffness will be 3050 kip/in.  

b. Assigning spring supports in SAP2000. 

i. Select the 12 nodes, 8 at the very end of the longitudinal 

members, 4 at the location of the pier. 

ii. Click Assign->Joint->Springs 

iii. In the Assign Joint Springs window in the Simple Springs 

Stiffness panel enter 6 for Translation 1&2 and 3050 for 

Translation 3.  

iv. Click OK. 
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14. Defining Centerline Data Acquisition Points at Mid-Span of Girder 

a. Select the transverse frame elements between B&C as well as D&E at 

0.4L (Gridline 9).  

b. Click Edit->Edit Lines->Divide Frames 

c. In the Divide into Specified Number of Frames window enter 2 for 

Number of Frames.  

d. Click OK.   

 

 

15. Analyzing the Non-Fracture Structure for Dead Load Only 

a. In SAP2000 click Analyze->Run Analysis  

b. In the Set Load Cases to Run window click the Run/Do Not Run All 

button until every Action is Do Not Run.  

c. Select DEAD then click Run/Do Not Run Case until the Action is Run.  

d. Then click Run Now. Let SAP2000 Run the Load Cases until the scree 

says the Analysis is Complete. 

e. Once the analysis is complete, select the spring reactions. 
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f. Click Display->Show Tables

g. In the Choose Table for Display window click the + symbol beside Joint

output and select the square box beside Reactions.

h. In the Output Options window in the Nonlinear Static Results panel select

Last Step.

i. Select and copy the information from the F3 column.

j. The sum of the F3 values is the dead load.

k. Then click Done.

l. Unlock the structure.

16. Analyzing the Non-Fractured Structure

a. In SAP2000 click Analyze->Run Analysis

b. In the Set Load Cases to Run window click the Run/Do Not Run All

button until every Action is Do Not Run.

c. Select LC1_1, LC2_1, LC3_1, and LC4_1 then click Run/Do Not Run

Case until the Action for all 4 is Run.

d. Then Click Run Now.

e. Let SAP2000 Run the Load Cases until the scree says the Analysis is

Complete.

f. Once the analysis is complete, select the data collection point on the

transverse member on the outside girder (C-B).

g. Click Display->Show Tables

h. In the Choose Table for Display window click the + symbol beside Joint

output and select the square box beside Displacements

i. Click the Modify/Show Options button.

j. In the Output Options window in the Nonlinear Static Results panel select

Step-by-Step.
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k. Click OK. 

l. Select and copy the information from the Output Case, StepNum 

Unitless, and the U3 in. column and paste them into an Excel worksheet. 

These columns represent Load Case, Step Number, and Deflection for the 

Outside Girder respectively.  

 

m. Then click Done.  

n.  Select the data collection point on the transverse member on the inside 

girder (E-D) and repeat Steps g-l. However, on Step l there is no need to 

copy Output Case, Step Num Unitless again.    

o. Select the joint on the transverse member on the outside girder at 

transverse element 9 (at longitudinal element B) and repeat Steps g-l. 

This information goes into the Delta 4 column. However, on Step l there 

is no need to copy Output Case, Step Num Unitless again.    

p. Select the joint on the transverse member on the outside girder at 

transverse element 9 (at longitudinal element C) and repeat Steps g-l. 

This information goes into the Delta 3 column. However, on Step l there 

is no need to copy Output Case, Step Num Unitless again.    

q. Select the joint on the transverse member on the inside girder at 

transverse element 9 (at longitudinal element D) and repeat Steps g-l. 

This information goes into the Delta 2 column. However, on Step l there 

is no need to copy Output Case, Step Num Unitless again.    
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r. Select the joint on the transverse member on the outside girder at 

transverse element 9 (at longitudinal element E) and repeat Steps g-l. This 

information goes into the Delta 1 column. However, on Step l there is no 

need to copy Output Case, Step Num Unitless again.    

 

19. Once all of the data is collected unlock the model by selecting the Lock tool on 

the left hand side of SAP2000 screen.  

17. Analyzing the Fractured Structure 

a. At Mid-Span along grid line 9, replace the hinges of the outside 

longitudinal element (gridline B) with FracOUT hinges according to Step 

10.  

b. At Mid-Span, along gridline 9, replace the hinges of the first interior 

longitudinal element (gridline C) with FracInt hinges according to Step 

10. 

 

c. Repeat Step 15 for the Fractured Case and collect the data accordingly.  

18. Post Processing of the Data 

a. In the Excel Sheet the following values need to be calculated for each 

step. 

i. Omega (Ω) 

1. 𝛺𝑖 = 𝛺𝑖−1 + (
1

# 𝑜𝑓 𝑆𝑡𝑒𝑝𝑠 𝑖𝑛 𝐿𝑜𝑎𝑑 𝑐𝑎𝑠𝑒
) 

ii. Longitudinal Chord Rotation of Interior and Exterior Girder 
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1. 𝐶ℎ𝑜𝑟𝑑 𝑅𝑜𝑡.𝑆𝑖𝑛𝑔𝑙𝑒 𝑆𝑝𝑎𝑛 = −1 ∗ (
𝛿𝐶𝐿

0.5∗𝐿
) (rad) 

iii. Transverse Deck Roataion 

1. 𝛼2−3 = (
𝛿3−𝛿2

𝑠
) − (

𝛿2−𝛿1

𝑤
) (rad) 

2. 𝛼2−3 = (
𝛿3−𝛿2

𝑠
) − (

𝛿2−𝛿1

𝑤
) (rad) 

3. Where s=spacing between the interior top flanges of the 

inside and outside girders and w=spacing between the top 

flanges of the same girder. 

iv. Applied Load 

1. Calculate unit applied load or applied load at 1 Ω. 

2. 𝑈𝑛𝑖𝑡 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑𝑠𝑖𝑛𝑔𝑙𝑒 𝑠𝑝𝑎𝑛 = 1.25 ∗

𝑇𝑜𝑡𝑎𝑙 𝑅𝑒𝑎𝑐𝑡𝑖𝑜𝑛𝑠 𝑓𝑟𝑜𝑚 𝐷𝑒𝑎𝑑 𝐿𝑜𝑎𝑑 𝐶𝑎𝑠𝑒 + 2 ∗ (2.33 ∗
𝐻𝑆20 𝑡𝑟𝑢𝑐𝑘 + 1.75 ∗ 𝐿𝑎𝑛𝑒 𝐿𝑜𝑎𝑑) 

3. 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑 = 𝑈𝑛𝑖𝑡 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑 ∗ 𝛺 

b. Repeat Step A for the Fractured Case.  

c. Calculate the initial stiffness for intact bridge and instantaneous stiffness 

for fractured bridge.  

i. For the Non-Fractured condition (Intact Bridge) find the absolute 

displacement for the Outside Girder at an Ω value of 0.4. 

1. 𝐼𝑛𝑖𝑡𝑖𝑎𝑙 𝑆𝑡𝑖𝑓𝑓𝑛𝑒𝑠𝑠 =
0.4

𝐴𝑏𝑠𝑜𝑙𝑢𝑡𝑒 𝐷𝑖𝑠𝑝𝑙𝑎𝑐𝑒𝑚𝑒𝑛𝑡 𝑂𝐺 (𝑎𝑡  𝛺=0.4)
 

ii. For the Fractured case add an additional column labeled stiffness  

1. 𝐼𝑛𝑠𝑡𝑎𝑛𝑡𝑎𝑛𝑒𝑜𝑢𝑠 𝑆𝑡𝑖𝑓𝑓𝑛𝑒𝑠𝑠𝑂𝐺−𝐹𝑟𝑎𝑐.  𝑖 =
𝛺𝑖−𝛺𝑖−1

𝛿𝑖−𝛿𝑖−1
  

d. Failure of the structure occurs at the Ω of the Fractured Bridge at the first 

of the following criteria. 

i. The instantaneous stiffness for the fractured outside girder is less 

than 5% of the initial stiffness of the intact outside girder. 

ii. The chord angle of the outside girder for a simple spans or interior 

spans is greater than 2°. The chord angle for exterior spans of 

multi-span bridges is greater than 3°. 

iii. The transverse deck rotation is greater than 5°.    

e. On a chart plot the Non-Fractured Outside and Inside Girder as well as 

the Fractured Outside and Inside Girder with displacement on the primary 

x axis and the Total Force on the primary y axis and Ω on the secondary 

y-axis  

19. Repeat Steps 11-18 for Span 2. 

a. However, since Span 1 and Span 2 are both 140 feet long. No repletion 

need.  
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Grillage Analysis Example of Bridge 10 

1. Gather Bridge Geometry and Material Information.  

Loc. ft  

Top Flange Web 
Bottom 

Flange Sec. Type 

W      

in. 
T in. W in. T in. W in. T in. Sect. Rebar 

0-50 24 1.00 78 0.625 59 0.750 1 Reg. 

50-98 24 1.00 78 0.625 59 1.250 2 Pier 

98-131 24 2.00 78 0.75 59 2.000 3 Pier 

131-181 24 3.00 78 0.875 59 2.000 4 Pier 

181-230 24 1.00 78 0.875 59 1.250 5 Pier 

230-247 24 1.00 78 0.75 59 1.000 6 Reg. 

247-297 24 1.00 78 0.75 59 1.250 7 Reg. 

297-330 24 1.00 78 0.75 59 1.000 8 Reg. 

330-380 24 1.00 78 0.875 59 1.250 5 Pier 

380-396 24 2.00 78 0.875 59 1.250 5 Pier 

396-430 24 3.00 78 0.875 59 2.000 9 Pier 

430-447 24 3.00 78 0.875 59 2.000 9 Pier 

447-464 24 2.00 78 0.75 59 1.250 10 Pier 

464-499 24 1.00 78 0.75 59 1.250 10 Pier 

499-602 24 1.00 78 0.625 59 0.750 1 Reg. 
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Location Parameter Description/Value 

Bridge 

Location 
Harris County, 

IH10 

Year Designed/Year Built 1998/2002 

Design Load HS20 

Length, ft 602.58 

Spans, ft 148, 265, 189.58 

Radius of Curvature, ft 716.2 

Deck 

Width, ft 30 

Thickness, in. 8 

Haunch, in. 5 

Rail Type T4(s) 

Rebar 

# of Bar Longitudinal Top Row (#4) 42 

# of Bar Longitudinal Bottom Row (#5) 32 

# of Bar Longitudinal Top Row (#4) 

@support 
42 

# of Bar Longitudinal Top Row (#5) 

@support 
40 

# of Bar Longitudinal Bottom Row (#5) 

@support 32 

Transverse Spacing Top Row (#5), in. 6 

Transverse Spacing Bottom Row (#5), in.  6 

Grider 
CL of Bridge to CL of Girder (in.) 45 

CL of Top Flange to CL of Top Flange (in.) 96 

 

2. Material constitutive behavior 
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Concrete (4 ksi)  Rebar (60 ksi)  Steel (50 ksi) 

Stress 

(ksi) 

Strain 

(1/in)  

Stress 

(ksi) 

Strain 

(1/in)  

Stress 

(ksi) 

Strain 

(1/in) 

-4 -3.79E-03  -87.9 -0.095  -71.6 -0.1 

-4 -3.56E-03  -87.9 -0.0944  -71.6 -0.097 

-4 -2.69E-03  -86.6 -0.0761  -71.6 -0.095 

-4 -1.78E-03  -78 -0.0386  -71.6 -0.0946 

-3.8205 -1.40E-03  -60.7 -9.80E-03  -70.3 -0.0764 

-2.8718 -8.69E-04  -60.3 -2.08E-03  -62.5 -0.039 

-0.6403 -1.78E-04  0 0  -50 -0.0196 

0 0  60.3 2.08E-03  -50 -1.72E-03 

0.378 1.06E-04  60.7 9.80E-03  0 0 

0.378 1.16E-03  78 0.0386  50 1.72E-03 

   86.6 0.0761  50 0.0196 

   87.9 0.0944  62.5 0.039 

   87.9 0.095  70.3 0.0764 

      71.6 0.0946 

      71.6 0.095 

      71.6 0.097 

      71.6 0.1 

 

 

3. Create a Coordinate system for half width of the span for each cross section. An 

example of the first cross section is show below.  
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4. Create a cylindrical coordinate system for the curved bridge assuring that the 

middle transverse divisions are 7 ft, as this will aid is applying the HS20 truck 

load whose axels are separated by 14 ft.  

a. # 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠𝑝𝑒𝑟 𝑠𝑝𝑎𝑛 =

(
𝐿𝑒𝑛𝑔𝑡ℎ (𝑓𝑡)∗12

84 𝑖𝑛 (7𝑓𝑡)
)  𝑟𝑜𝑢𝑛𝑑𝑒𝑑 𝑡𝑜 𝑛𝑒𝑎𝑟𝑒𝑠𝑡 𝑒𝑣𝑒𝑛 𝑛𝑢𝑚𝑏𝑒𝑟 

i. # 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠𝑆𝑝𝑎𝑛 1 = (
148∗12

84
) = 21.428 𝑜𝑟 18 

ii. # 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠𝑆𝑝𝑎𝑛 2 = (
265∗12

84
) = 37.857 𝑜𝑟 36 

iii. # 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠𝑆𝑝𝑎𝑛 3 = (
190∗12

84
) = 27.143 𝑜𝑟 24 

b. 𝐸𝑛𝑑 𝑆𝑒𝑔𝑚𝑒𝑛𝑡 𝐿𝑒𝑛𝑔𝑡ℎ = ((𝐿𝑒𝑛𝑔𝑡ℎ ∗ 12) − (# 𝑜𝑓 𝑆𝑒𝑔𝑚𝑒𝑛𝑡𝑠 ∗ 84))/2 

i. 𝐸𝑛𝑑 𝑆𝑒𝑔𝑚𝑒𝑛𝑡 𝐿𝑒𝑛𝑔𝑡ℎ𝑆𝑝𝑎𝑛 1 =
((148∗12)−(18∗84))

2
= 132 𝑖𝑛. 

ii.  𝐸𝑛𝑑 𝑆𝑒𝑔𝑚𝑒𝑛𝑡 𝐿𝑒𝑛𝑔𝑡ℎ𝑆𝑝𝑎𝑛 2 =
((265∗12)−(36∗84))

2
= 78 𝑖𝑛. 

iii. 𝐸𝑛𝑑 𝑆𝑒𝑔𝑚𝑒𝑛𝑡 𝐿𝑒𝑛𝑔𝑡ℎ𝑆𝑝𝑎𝑛 3 =
((190∗12)−(24∗84))

2
= 132 𝑖𝑛. 

c. 𝑇ℎ𝑒𝑡𝑎 =
𝑇𝑜𝑡𝑎𝑙 𝐿𝑒𝑛𝑔𝑡ℎ

𝑅𝑎𝑑𝑖𝑢𝑠
 

i. 𝑇ℎ𝑒𝑡𝑎 =
603

716.2
= 0.84194 𝑟𝑎𝑑 𝑜𝑟 48.24 𝑑𝑒𝑔𝑟𝑒𝑒𝑠 

d. Determine the radial offsets using the outside edge, the outside flange, the 

inner flange and centerline of the bridge.  
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Offsets (in.) 

Edge 180 

Outside Flange 141 

Inner Flange 45 

CL of Bridge 0 

Radial Spacing (in.) 

A 8774.4 CL+Edge 

B 8735.4 CL+OF 

C 8639.4 CL+IF 

Center Line 8594.4 or 450 (ft) 

D 8549.4 CL-IF

E 8453.4 CL-OF

F 8414.4 CL-Edge

c. The Longitudinal or spacing along theta is determined by converting the

longitudinal segment lengths into degrees.

i. The segments vary in length. The total length is 603 ft or 7236 in.

ii. 𝑅𝑎𝑑𝑖𝑎𝑙 𝑆𝑝𝑎𝑐𝑖𝑛𝑔 (𝑟𝑎𝑑) =
𝐿𝑜𝑛𝑔.𝑆𝑝𝑎𝑐𝑖𝑛𝑔

𝑅𝑎𝑑𝑖𝑢𝑠

iii. 𝑅𝑎𝑑𝑖𝑎𝑙 𝑆𝑝𝑎𝑐𝑖𝑛𝑔 (𝑑𝑒𝑔𝑟𝑒𝑒) = 𝑅𝑎𝑑𝑖𝑢𝑠 𝑆𝑝𝑎𝑐𝑖𝑛𝑔 (𝑟𝑎𝑑) ∗
180

𝜋

Long. 

Spacing 

(in.) 

Radial 

Spacing 

(rad.) 

Radial 

Spacing 

(deg.) 

0 0.0000 0.000 

132 0.0154 0.880 

216 0.0251 1.440 

300 0.0349 2.000 

384 0.0447 2.560 

468 0.0545 3.120 

552 0.0642 3.680 

636 0.0740 4.240 

720 0.0838 4.800 

804 0.0935 5.360 

888 0.1033 5.920 

972 0.1131 6.480 

1056 0.1229 7.040 



404 

Long. 

Spacing 

(in.) 

Radial 

Spacing 

(rad.) 

Radial 

Spacing 

(deg.) 

1140 0.1326 7.600 

1224 0.1424 8.160 

1308 0.1522 8.720 

1392 0.1620 9.280 

1476 0.1717 9.840 

1560 0.1815 10.400 

1644 0.1913 10.960 

1776 0.2066 11.840 

1854 0.2157 12.360 

1938 0.2255 12.920 

2022 0.2353 13.480 

2106 0.2450 14.040 

2190 0.2548 14.600 

2274 0.2646 15.160 

2358 0.2744 15.720 

2442 0.2841 16.280 

2526 0.2939 16.840 

2610 0.3037 17.400 

2694 0.3135 17.960 

2778 0.3232 18.520 

2862 0.3330 19.080 

2946 0.3428 19.640 

3030 0.3526 20.200 

3114 0.3623 20.760 

3198 0.3721 21.320 

3282 0.3819 21.880 

3366 0.3917 22.440 

3450 0.4014 23.000 

3534 0.4112 23.560 

3618 0.4210 24.120 

3702 0.4307 24.680 

3786 0.4405 25.240 

3870 0.4503 25.800 

3954 0.4601 26.360 

4038 0.4698 26.920 

4122 0.4796 27.480 
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Long. 

Spacing 

(in.) 

Radial 

Spacing 

(rad.) 

Radial 

Spacing 

(deg.) 

4206 0.4894 28.040 

4290 0.4992 28.600 

4374 0.5089 29.160 

4458 0.5187 29.720 

4542 0.5285 30.280 

4626 0.5383 30.840 

4710 0.5480 31.400 

4794 0.5578 31.960 

4878 0.5676 32.520 

4956 0.5767 33.040 

5088 0.5920 33.920 

5172 0.6018 34.480 

5256 0.6116 35.040 

5340 0.6213 35.600 

5424 0.6311 36.160 

5508 0.6409 36.720 

5592 0.6507 37.280 

5676 0.6604 37.840 

5760 0.6702 38.400 

5844 0.6800 38.960 

5928 0.6898 39.520 

6012 0.6995 40.080 

6096 0.7093 40.640 

6180 0.7191 41.200 

6264 0.7288 41.760 

6348 0.7386 42.320 

6432 0.7484 42.880 

6516 0.7582 43.440 

6600 0.7679 44.000 

6684 0.7777 44.560 

6768 0.7875 45.120 

6852 0.7973 45.680 

6936 0.8070 46.240 

7020 0.8168 46.800 

7104 0.8266 47.360 

7236 0.8419 48.240 
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iv. 𝐼𝑛𝑡. 𝑇𝑟𝑎𝑛𝑠𝑣𝑒𝑟𝑠𝑒 𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑤𝑖𝑑𝑡ℎ = 84 𝑖𝑛.

v. 𝐸𝑛𝑑 𝑇𝑟𝑎𝑛𝑠𝑣𝑒𝑟𝑠𝑒 𝐸𝑙𝑒𝑚𝑒𝑛𝑡 = 132 − (
84

2
) = 90 𝑖𝑛. 

vi. 𝑃𝑒𝑖𝑟 𝑇𝑎𝑛𝑠𝑣𝑒𝑟𝑠 𝐸𝑙𝑒𝑚𝑒𝑛𝑡 = 132 + 78 − 84 = 126 𝑖𝑛.
5. Inputting the coordinate system into SAP2000

a. Select File -> New Model -> Blank model (making sure units are in kips

and inches)

b. Right click on the blank workspace and select Edit Grid Data->

Modify/Show System->Quick Start->Cylindrical.

i. In the Number of Grid Lines panel set “Along Z=1”

ii. In the Grid Spacing panel set “Along Z=1”

iii. Select OK.

iv. Delete all R and T Coordinates that were generated

c. Add correct coordinates for R

i. All radial coordinates (A, B, C, D, E, and F).

d. Add correct coordinates for T

i. All theta coordinates for T (0 to 7236 in.)

ii. Click OK

e. The Grid System in now formed.
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6. Defining Material in SAP200 

a. Click Define-> Materials->Add New Material->Material Type (Steel, 

Concrete, or Rebar)->Standard (User)->OK 

b. At the bottom of the window select the box which states “Switch to 

Advanced Properties” 

c. In the open window name the material “Concrete” “Steel” or “Rebar” 

depending on which material is being defined. Then click “Modify/Show 

Material Properties” 

d. On the Material Property Data window click “Nonlinear Material Data” 

icon.  

e. In the Nonlinear Material Data window select the “Convert to User 

Defined” icon. 

f. Input the number of number of data points for the stress strain behavior 

(10 for concrete, 13 for rebar, 17 for steel) 
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g. Input the data points for the stress strain behavior.  

h. Select “OK” 

i. Repeat this process again for the remaining materials. 

 

7. Defining Frame Cross Sections in SAP2000. 

a. Click Define->Section Properties->Frame Sections->Add New Properties 

b. In the Frame Section Properties Drop down box select “Other” and click 

Section Designer. In the SD Section Designer Window name the section 

B5Long1 click the “Section Designer” Icon. 

c. Using the Polygon feature draw the features of the half width of the 

bridge from Step 3.  This includes: one rail, two concrete deck pieces, to 

concrete haunches, two top flanges, two webs, and two pieces of the 

bottom flange.  

i. To change material types for the polygons right click on the 

polygon and select the desired material type from the material 

drop down menu. 

ii. To change the coordinates of the polygon’s nodes use the 

Reshaper too to change the coordinates.   

d. Add in the longitudinal rebar to both concrete deck elements by using the 

Line Bar from the Draw Reinforcing Shape tool. From the design 

drawings it can be determined that there are 10 #4 top bars and 7 #5 

bottom bars in the outer concrete deck element and 11 #4 top bars and 9 
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#5 bottom bars in the inner concrete element. At the pier supports 10 

additional #5 top bars are added to the top of the outer concrete deck and 

10 additional #5 top bars are added to the inner concrete deck. With a 2 

inch top cover and transvers reinforcement the top bars are located at 

5.0625 inches and with a 1.25 inch bottom cover and transverse 

reinforcement are located at 2.1875.  

e. Click Done (Below is an example of the 1st cross section).

f. Repeat this process for the remaining longitudinal elements.

g. Repeat the process for the transverse elements.

i. At the SD Section Designer Window select Modifiers and set

Mass and Weight to 0, as to not double count the dead weight.

ii. The interior transverse members are 84 inches wide (end members

are 90 in. wide and pier members are 126 in.) with #5 rebar at 5

inch spacing at 5.6875 in. and 1.5625 in.
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h. To generate and exterior longitudinal member and an interior longitudinal 

member. Make two copies of the B10Long1.1 section. Label one 

Long1Out and on Long1Int.  

i. For the L1.1Out delete every element right of the centerline.  

 

ii. For the L1.1Int delete every element left of the centerline.  



 

411 

 

 

iii. Repeat this process for all cross sections. 

i. To generate a simulated fracture section make copies of Long1Out and 

Long1Int. 

i. The reason Long1Out and Long1Int are chosen for the fractured 

section is because the fracture occurs at 0.4*L or 710 inches. 

Which from the radial spacing table L1.1 is the section used at 

710 in.  

ii. Name the copy of L1.1Out FracInt1.1.  

1. Delete the bottom flange, web, and top flange of the steel 

tub. 

 

iii. Name the copy of L1.1Int to FracInt1.1.  

1. Delete the bottom flange, web, and top flange of the steel 

tub.  
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8. Generating plastic hinges for frame elements in SAP2000.  

a. Define->Section Properties->Frame Sections  

b. Select the desired cross section. Hinges will need to be made for all of the 

necessary cross sections.  

c. Once selected, click Modify/Show Property->Section Designer 

d. Once in the section designer select the Moment Curvature Curve tool. 

e. In the Moment Curvature Curve window select Details. 

i. Copy the moment curvature data to an Excel file.  

ii. Select OK. 

f.  In the Moment Curvature Curve window change the Angle (deg) to 180 

then select Details  

i. Copy the moment curvature data to the same Excel file as 

previous. 

ii. Select OK. 

g. Generate a Normalized Moment Curvature Diagram 

i. Normalize the Moments by dividing each of the positive moments 

by the maximum positive moment and the negative moment by 

the maximum negative moment. And divide the curvatures by the 

curvatures corresponding to the maximum and negative moments.  

ii. Plot the normalized positive and negative moment curvatures on a 

chart.  

iii. Create a hinge moment curvature plot on the same chart with 4 

positive moment points and 4 negative moment points without 

generating a negative slope.   
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h. Define Hinge Length  

i. The hinge length is one half of the section depth.  

1. 𝐻𝑖𝑛𝑔𝑒𝑙𝑜𝑛𝑔 = 0.5 ∗ (𝐷𝑒𝑐𝑘 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠 + ℎ𝑎𝑢𝑛𝑐ℎ ℎ𝑒𝑖𝑔ℎ𝑡 +

𝑡𝑜𝑝 𝑓𝑙𝑎𝑛𝑔𝑒 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠 + 𝑤𝑒𝑏 ℎ𝑒𝑖𝑔ℎ𝑡 +
𝑏𝑜𝑡𝑡𝑜𝑚 𝑓𝑙𝑎𝑛𝑔𝑒 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠) 

a. 𝐻𝑖𝑛𝑔𝑒𝑙𝑜𝑛𝑔 = 45 𝑖𝑛. 

2. 𝐻𝑖𝑛𝑔𝑒𝐹𝑟𝑎𝑐 = 0.5 ∗ (𝐷𝑒𝑐𝑘 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠 + ℎ𝑎𝑢𝑛𝑐ℎ ℎ𝑒𝑖𝑔ℎ𝑡) 

a. 𝐻𝑖𝑛𝑔𝑒𝐹𝑟𝑎𝑐 = 7 𝑖𝑛. 
3. 𝐻𝑖𝑛𝑔𝑒𝑇𝑟𝑎𝑛𝑠 = 0.5 ∗ (𝐷𝑒𝑐𝑘 𝑡ℎ𝑖𝑐𝑘𝑛𝑒𝑠𝑠) 

a. 𝐻𝑖𝑛𝑔𝑒𝑇𝑟𝑎𝑛𝑠 = 4 𝑖𝑛. 
i. Making the plastic hinge in SAP200. 

i. Select Define->Section Properties-> Hinge Properties->Add New 

Properties  

ii. In the Type window select moment curvature and input the 

corresponding correct Hinge Length. 

iii. In the Moment Curvature table insert the 4 positive and 4 negative 

normalized moment curvatures and the zero point.  

iv. Uncheck the symmetric box and select the Is Extrapolated option 

in the “Load Carrying Capacity beyond Point E” window. 

v. In the “Scaling for Moment and Curvature” window insert the 

maximum positive moment and corresponding curvature as well 

as the maximum negative curvature and corresponding curvature.  

vi. In the Acceptance Criteria use the values 1,2, and 3 for Immediate 

Occupancy, Life Safety, and Collapse Prevention in the positive 

column and -1, -2, and -3 for the negative column.  

vii. Repeat for all remaining Frame Sections. 
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9. Assign Frame Members to Grid. 

a. Select the Draw tab->Quick Draw Frame/Cable/Tendon  

b. In the Section drop down menu select the appropriate cross section and 

click on the grid grillage grid member.  
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10. Assign Hinges to Frame Elements  

a. The Longitudinal Hinges are placed at the ends of the longitudinal frame 

elements or at a relative distance of 0 and 1. 

b. The Transvers hinges are placed at a distance of half a top flange width 

away from the node.  

i. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐹 𝑡𝑜 𝐸 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
= 1 −

24/2

39
= 0.6923 

ii. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐸 𝑡𝑜 𝐷 𝑎𝑛𝑑 𝐶 𝑡𝑜 𝐵 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
=

24/2

96
=

0.125 𝑎𝑛𝑑 (1 − 0.125) 𝑜𝑟 0.875 

iii. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐷 𝑡𝑜 𝐶 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
=

24/2

90
= 0.1333 𝑎𝑛𝑑 (1 −

0.1333) 𝑜𝑟 0.8667 

iv. 𝐻𝑖𝑛𝑔𝑒 𝐿𝑜𝑐.𝐵 𝑡𝑜 𝐴 =
ℎ𝑎𝑙𝑓 𝑓𝑙𝑎𝑛𝑔𝑒 𝑤𝑖𝑑𝑡ℎ

𝐸𝑙𝑒𝑚𝑒𝑛𝑡 𝑊𝑖𝑑𝑡ℎ
=

24/2

39
= 0.3077 

c. In SAP2000 assign the hinges to corresponding frame elements.  
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i. Select the desired frame elements you wish to assign hinges to 

such as Long1Out. (The elements will turn from blue to yellow). 

ii. In SAP2000 select the Assign tab->Frame->Hinges 

1. From the drop down menu select Long1Out and set 

relative distance to 0 and click ADD. 

2. From the drop down menu select Long1Out and set 

relative distance to 1 and click ADD.  

3. Then click OK. 

 

iii. Repeat Step ii. for all other frame elements.  
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11. Assigning Loads to the Frame Elements 

a. HS20 Wheel Axel Loads 

i. HS20 Axel Loads will be placed at distances of 36 in., 108 in., 

180 in., and 252 in. from the outside of the curved edge.  

ii. One line of the 16 kip axels will be placed at the 0.4L point of the 

bridge or transverse grid 9 with the second line 14 feet away at 

transverse grid number 7. One line of 4 kip axels will be placed 14 

feet away from the first line of axels at grid line 11.  

iii. In SAP2000 the loads have to be placed at a relative distance so 

this value needs to be calculated.  

1. 𝐻𝑆20𝐴𝑥𝑒𝑙 1 𝐿𝑜𝑐 (𝐵−𝐴) =
𝐿1−36

𝐿1
=

39−36

39
= 0.0792 

2. 𝐻𝑆20𝐴𝑥𝑒𝑙 2 𝐿𝑜𝑐 (𝐶−𝐵) =
𝐿1+𝐿2−108

𝐿2
=

39+96−108

96
= 0.2813 

3. 𝐻𝑆20𝐴𝑥𝑒𝑙 3 𝐿𝑜𝑐 (𝐷−𝐶) =
𝐿1+𝐿2+𝐿3−180

𝐿3
=

39+96+90−180

90
= 0.5 

4. 𝐻𝑆20𝐴𝑥𝑒𝑙 4 𝐿𝑜𝑐 (𝐸−𝐷) =
𝐿1+𝐿2+𝐿3+𝐿4−252

𝐿4
=

39+96+90+96−252

90
= 0.7188 

b. Lane Loads  

i. Lane Loads are line loads of 0.640 kip/ft (0.05333 kip/in.) 

centered at a distance of 96 in. and 240 in. from outside of the 

curved edge. 

ii. These lane loads will be placed on the longitudinal frame 

elements. They will be assigned to elements along the B, C, D, 

and E longitudinal elements according to the appropriate tributary 

distance.  
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1. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐵 = (
𝐿1+𝐿2−96

𝐿2
) ∗ 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 = (

39+96−96

96
) ∗

0.05333 = 0.021667
𝑘𝑖𝑝

𝑖𝑛
.  

2. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐶 = 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 − 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑𝐵 = 0.05333 −

0.021667 = 0.031667
𝑘𝑖𝑝

𝑖𝑛
.  

3. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐷 = (
𝐿1+𝐿2+𝐿3+𝐿4−240

𝐿4
) ∗ 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 =

(
39+96+90+96−240

96
) ∗ 0.05333 = 0.045

𝑘𝑖𝑝

𝑖𝑛
. 

4. 𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑𝐸 = 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑 − 𝑙𝑎𝑛𝑒𝑙𝑜𝑎𝑑𝐷 = 0.05333 −

0.045 = 0.00833
𝑘𝑖𝑝

𝑖𝑛
.  

c. In SAP2000 the load patterns must be first be defined.  

i. Select the Define tab->Load Patterns.  

1. Under the Load Pattern Name ender HS20_1 and change 

the type in the drop down menu to Live. The self-weight 

multiplier should be set to 0. Then click Add New Load 

Pattern.  

2. Under the Load Pattern Name ender LaneLoad1 and 

change the type in the drop down menu to Live. The self-

weight multiplier should be set to 0. Then click Add New 

Load Pattern.  

3. Then click OK. 

 

ii. Assigning the HS20 wheel loads in SAP2000.  

1. Select the exterior transverse element of grid line 9 and 7. 

2. Click Assign->Frame Loads->Point 

3. From the Load Pattern drop down menu select HS20 and 

verify that the Coordinate System is set to Global, the 

Load Direction is Gravity, and the Load Type is Force.  

4. In column 1 enter a Relative Distance of 0 (HS20 Axel 1 

Loc. B-A) and Load of 16 kips. 

5. Click OK. 
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6. Repeat for grid line 11 to assign the 4 kip load.   

7. Repeat Steps 1-6 for HS20 Axel 2,3,4 Loc. C-B, D-C, and 

E-D. 

 

iii. Assigning the Lane Load in SAP2000.   

1. Select all exterior longitudinal frame elements along grid 

line B.  

2. Click Assign->Frame Loads->Distributed 

3. From the Load Pattern drop down menu select Lane Load 

and verify that the Coordinate System is set to Global, the 

Load Direction is Gravity, and the Load Type is Force.  

4. In the Uniform Load box enter 0.021667 (Lane Load B). 

5. Click OK. 

6. Repeat Steps 1-5 for all of the longitudinal elements along 

gridlines C, D, and E.  

 

12. Defining Load Cases 
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a. The Load Case being used to determine redundancy is 1.25𝐷𝐿 +
1.75(𝐿𝐿 + 𝐼𝑀). Where DL=Dead Load, LL= Live Load, and IM= Impact 

Load. When substituting in the HS20 truck load and the Lane Load the 

preceding equation reduces to 1.25𝐷𝐿 + 1.75𝐿𝑎𝑛𝑒𝐿𝑜𝑎𝑑 + 2.33𝐻𝑆20 

b. Generating Load Cases in SAP2000. 

i. Click Define->Load Cases->Add New Load Case 

ii. In the Load Case Name Panel name the load case “LC1_1” 

iii. In the Analysis Type select “Non-Linear” 

iv. For the LC1_1 Load Case in the Stiffness to use panel select 

“Zero Initial Conditions” 

v.  In the Loads Applied panel leave the Load Type “Load Pattern” 

in the drop down Load Name menu select DEAD and change the 

Scale Factor to 1.25. Click Add. Change the Load Name menu 

select HS20 and change the Scale Factor to 2.33. Click ADD. 

Change the Load Name menu select Lane Load and change the 

Scale Factor to 1.75. Click ADD.  

vi.  In the Other Parameters panel in the Results Saved section click 

Modify/Show. 

vii. In the Results Saved for Nonlinear Static Load Cases window 

change the Results Saved to Multiple States and in the For Each 

Stage panel change the Minimum Number of Saved Steps and the 

Maximum Number of Saved Steps to 20. Click OK.  

viii. Then Click the OK on the Load Case Data Window.  

ix. Repeat Steps i.-viii. to create an LC2_1, LC3_1, and LC4_1. 

However, in the Initial Conditions Window select Continue from 

State at End of Nonlinear Case and from the drop down menu 

select the preceding load case. (For LC2_1 the Nonlinear Case 

LC1_1 would be selected). 

x. Repeat Step ix. to create LC(1-4)_2 for Span 2 and LC(1-4)_3 for 

Span 3.  
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13. Defining End Supports 

a. The elastomeric bearing pad for each girder have lateral stiffness of 12 

kip/in. and a vertical stiffness of 6100 kip/in. Since the tub girders are 

divided in half, the lateral stiffness will be 6 kip/in. and the vertical 

stiffness will be 3050 kip/in.  

b. Assigning spring supports in SAP2000. 

i. Select the 16 nodes, 8 at the very end of the longitudinal 

members, 8 at the location of the piers. 

ii. Click Assign->Joint->Springs 

iii. In the Assign Joint Springs window in the Simple Springs 

Stiffness panel enter 6 for Translation 1&2 and 3050 for 

Translation 3.  

iv. Click OK. 
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14. Defining Centerline Data Acquisition Points at Mid-Span of Girder 

a. Select the transverse frame elements between B&C as well as D&E at 

0.4L (Gridline 9).  

b. Click Edit->Edit Lines->Divide Frames 

c. In the Divide into Specified Number of Frames window enter 2 for 

Number of Frames.  

d. Click OK.   
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15. Analyzing the Non-Fracture Structure for Dead Load Only 

a. In SAP2000 click Analyze->Run Analysis  

b. In the Set Load Cases to Run window click the Run/Do Not Run All 

button until every Action is Do Not Run.  

c. Select DEAD then click Run/Do Not Run Case until the Action is Run.  

d. Then click Run Now. Let SAP2000 Run the Load Cases until the scree 

says the Analysis is Complete. 

e. Once the analysis is complete, select the spring reactions. 

f.  Click Display->Show Tables 

g. In the Choose Table for Display window click the + symbol beside Joint 

output and select the square box beside Reactions.  

h. In the Output Options window in the Nonlinear Static Results panel select 

Last Step.  

i. Select and copy the information from the F3 column. 

j. The sum of the F3 values is the dead load.  

k. Then click Done. 

l. Unlock the structure.  

16. Analyzing the Non-Fractured Structure 

a. In SAP2000 click Analyze->Run Analysis 

b. In the Set Load Cases to Run window click the Run/Do Not Run All 

button until every Action is Do Not Run.  

c. Select LC1_1, LC2_1, LC3_1, and LC4_1 then click Run/Do Not Run 

Case until the Action for all 4 is Run.  

d. Then Click Run Now.  

e. Let SAP2000 Run the Load Cases until the scree says the Analysis is 

Complete.  



 

424 

 

f. Once the analysis is complete, select the data collection point on the 

transverse member on the outside girder (C-B).  

g. Click Display->Show Tables 

h. In the Choose Table for Display window click the + symbol beside Joint 

output and select the square box beside Displacements  

 

i. Click the Modify/Show Options button.  

j. In the Output Options window in the Nonlinear Static Results panel select 

Step-by-Step.  

 

k. Click OK. 

l. Select and copy the information from the Output Case, StepNum 

Unitless, and the U3 in. column and paste them into an Excel worksheet. 

These columns represent Load Case, Step Number, and Deflection for the 

Outside Girder respectively.  
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m. Then click Done.  

n.  Select the data collection point on the transverse member on the inside 

girder (E-D) and repeat Steps g-l. However, on Step l there is no need to 

copy Output Case, Step Num Unitless again.    

o. Select the joint on the transverse member on the outside girder at 

transverse element 9 (at longitudinal element B) and repeat Steps g-l. 

This information goes into the Delta 4 column. However, on Step l there 

is no need to copy Output Case, Step Num Unitless again.    

p. Select the joint on the transverse member on the outside girder at 

transverse element 9 (at longitudinal element C) and repeat Steps g-l. 

This information goes into the Delta 3 column. However, on Step l there 

is no need to copy Output Case, Step Num Unitless again.    

q. Select the joint on the transverse member on the inside girder at 

transverse element 9 (at longitudinal element D) and repeat Steps g-l. 

This information goes into the Delta 2 column. However, on Step l there 

is no need to copy Output Case, Step Num Unitless again.    

r. Select the joint on the transverse member on the outside girder at 

transverse element 9 (at longitudinal element E) and repeat Steps g-l. This 

information goes into the Delta 1 column. However, on Step l there is no 

need to copy Output Case, Step Num Unitless again.    

 

20. Once all of the data is collected unlock the model by selecting the Lock tool on 

the left hand side of SAP2000 screen.  

17. Analyzing the Fractured Structure 

a. At Mid-Span along grid line 9, replace the hinges of the outside 

longitudinal element (gridline B) with FracOUT hinges according to Step 

10.  

b. At Mid-Span, along gridline 9, replace the hinges of the first interior 

longitudinal element (gridline C) with FracInt hinges according to Step 

10. 
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c. Repeat Step 15 for the Fractured Case and collect the data accordingly.  

18. Post Processing of the Data 

a. In the Excel Sheet the following values need to be calculated for each 

step. 

i. Omega (Ω) 

1. 𝛺𝑖 = 𝛺𝑖−1 + (
1

# 𝑜𝑓 𝑆𝑡𝑒𝑝𝑠 𝑖𝑛 𝐿𝑜𝑎𝑑 𝑐𝑎𝑠𝑒
) 

ii. Longitudinal Chord Rotation of Interior and Exterior Girder 

1. 𝐶ℎ𝑜𝑟𝑑 𝑅𝑜𝑡.𝑆𝑖𝑛𝑔𝑙𝑒 𝑆𝑝𝑎𝑛 = −1 ∗ (
𝛿𝐶𝐿

0.5∗𝐿
) (rad) 

iii. Transverse Deck Roataion 

1. 𝛼2−3 = (
𝛿3−𝛿2

𝑠
) − (

𝛿2−𝛿1

𝑤
) (rad) 

2. 𝛼2−3 = (
𝛿3−𝛿2

𝑠
) − (

𝛿2−𝛿1

𝑤
) (rad) 

3. Where s=spacing between the interior top flanges of the 

inside and outside girders and w=spacing between the top 

flanges of the same girder. 

iv. Applied Load 

1. Calculate unit applied load or applied load at 1 Ω. 

2. 𝑈𝑛𝑖𝑡 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑𝑠𝑖𝑛𝑔𝑙𝑒 𝑠𝑝𝑎𝑛 = 1.25 ∗

𝑇𝑜𝑡𝑎𝑙 𝑅𝑒𝑎𝑐𝑡𝑖𝑜𝑛𝑠 𝑓𝑟𝑜𝑚 𝐷𝑒𝑎𝑑 𝐿𝑜𝑎𝑑 𝐶𝑎𝑠𝑒 + 2 ∗ (2.33 ∗
𝐻𝑆20 𝑡𝑟𝑢𝑐𝑘 + 1.75 ∗ 𝐿𝑎𝑛𝑒 𝐿𝑜𝑎𝑑) 

3. 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑 = 𝑈𝑛𝑖𝑡 𝐴𝑝𝑝𝑙𝑖𝑒𝑑 𝐿𝑜𝑎𝑑 ∗ 𝛺 

b. Repeat Step A for the Fractured Case.  

c. Calculate the initial stiffness for intact bridge and instantaneous stiffness 

for fractured bridge.  



 

427 

 

i. For the Non-Fractured condition (Intact Bridge) find the absolute 

displacement for the Outside Girder at an Ω value of 0.4. 

1. 𝐼𝑛𝑖𝑡𝑖𝑎𝑙 𝑆𝑡𝑖𝑓𝑓𝑛𝑒𝑠𝑠 =
0.4

𝐴𝑏𝑠𝑜𝑙𝑢𝑡𝑒 𝐷𝑖𝑠𝑝𝑙𝑎𝑐𝑒𝑚𝑒𝑛𝑡 𝑂𝐺 (𝑎𝑡  𝛺=0.4)
 

ii. For the Fractured case add an additional column labeled stiffness  

1. 𝐼𝑛𝑠𝑡𝑎𝑛𝑡𝑎𝑛𝑒𝑜𝑢𝑠 𝑆𝑡𝑖𝑓𝑓𝑛𝑒𝑠𝑠𝑂𝐺−𝐹𝑟𝑎𝑐.  𝑖 =
𝛺𝑖−𝛺𝑖−1

𝛿𝑖−𝛿𝑖−1
  

d. Failure of the structure occurs at the Ω of the Fractured Bridge at the first 

of the following criteria. 

i. The instantaneous stiffness for the fractured outside girder is less 

than 5% of the initial stiffness of the intact outside girder. 

ii. The chord angle of the outside girder for a simple spans or interior 

spans is greater than 2°. The chord angle for exterior spans of 

multi-span bridges is greater than 3°. 

iii. The transverse deck rotation is greater than 5°.    

e. On a chart plot the Non-Fractured Outside and Inside Girder as well as 

the Fractured Outside and Inside Girder with displacement on the primary 

x axis and the Total Force on the primary y axis and Ω on the secondary 

y-axis  

19. Repeat Steps 11-18 for Span 2 and 3. (Span 1 is pictured below) 

 

 

 




